Legal notices

The information contained herein is subject to change without notice.

The only warranties for HP Products and services are set forth in the express warranty statement accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

USB 2.0 high-speed certified.

Trademarks

Adobe®, Acrobat®, Adobe Photoshop® and Adobe® PostScript® 3™ are trademarks of Adobe Systems Incorporated.

Corel® is a trademark or registered trademark of Corel Corporation or Corel Corporation Limited.

ENERGY STAR and the ENERGY STAR mark are registered U.S. trademarks.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

PANTONE® is Pantone, Inc.'s check-standard trademark for color.
# Table of contents

1 Introduction ..................................................................................................................................................... 1  
   Safety precautions .................................................................................................................................................. 2  
   HP Start-Up Kit .................................................................................................................................................. 2  
   Using this guide ................................................................................................................................................... 2  
   Printer models .................................................................................................................................................... 4  
   The printer’s main features ................................................................................................................................. 4  
   The printer’s main components ........................................................................................................................... 5  
   The front panel ................................................................................................................................................... 8  
   Printer software ................................................................................................................................................ 9  
   The printer’s internal prints ................................................................................................................................. 10

2 Installing the software ...................................................................................................................................... 11  
   Choose which connection method to use ........................................................................................................ 12  
   Connect to a network (Windows) ....................................................................................................................... 12  
   Connect directly to a computer (Windows) ....................................................................................................... 12  
   Uninstall the printer software (Windows) ........................................................................................................ 13  
   Connect to a network (Mac OS) ........................................................................................................................ 14  
   Connect directly to a computer (Mac OS) .......................................................................................................... 17  
   Uninstall the printer software (Mac OS) .......................................................................................................... 18

3 Setting up the printer ......................................................................................................................................... 20  
   Introduction ....................................................................................................................................................... 21  
   Paper suitability options (T1200 series only) .................................................................................................... 21  
   Turn nesting on and off (T1200 series only) .................................................................................................... 22  
   Turn usage information on and off .................................................................................................................. 23  
   Turn alerts on and off ....................................................................................................................................... 23  
   Control access to the printer ............................................................................................................................... 24  
   Require account ID (T1200 series only) ............................................................................................................. 24  
   Set Windows driver preferences ......................................................................................................................... 24

4 Personalizing the printer .................................................................................................................................. 25  
   Turn the printer on and off ................................................................................................................................. 26  
   Change the language of the front-panel display ............................................................................................... 27  
   Access the HP Utility .......................................................................................................................................... 27  
   Access the Embedded Web Server .................................................................................................................. 27  
   Change the language of the HP Utility ............................................................................................................... 28  
   Change the language of the Embedded Web Server ........................................................................................ 28
Change the sleep mode setting ................................................................. 28
Turn the buzzer on and off ................................................................. 28
Change the front-panel display contrast ........................................ 29
Change the units of measurement .................................................... 29
Configure network settings ................................................................. 29
Change the graphic language setting ................................................ 30

5 Paper handling ......................................................................................... 31
General advice ................................................................................. 32
Load a roll onto the spindle ............................................................. 33
Load a roll into the printer ............................................................... 34
Unload a roll ..................................................................................... 38
Load a single sheet .......................................................................... 39
Unload a single sheet ..................................................................... 41
View information about the paper ................................................ 42
Paper presets .................................................................................. 43
Printing paper info ........................................................................ 43
Move the paper ............................................................................... 43
Maintain paper ............................................................................... 44
Change the drying time ................................................................... 44
Turn the automatic cutter on and off ............................................. 45
Feed and cut the paper ................................................................... 45

6 Working with two rolls (T1200 series only) ........................................... 46
The uses of a multiroll printer ........................................................ 47
How the printer allocates jobs to paper rolls ................................... 47

7 Printing .................................................................................................. 49
Create a print job ........................................................................... 50
Select print quality ....................................................................... 51
Select paper size .......................................................................... 51
Select margins options .................................................................. 52
Print with shortcuts ....................................................................... 53
Print on loaded paper .................................................................... 54
Rescale a print ............................................................................... 55
Change the treatment of overlapping lines .................................... 55
Preview a print ............................................................................... 56
Print a draft ................................................................................... 56
High-quality printing ..................................................................... 57
Print in gray shades .................................................................... 58
Print with no margins (T1200 series only) .................................... 58
Print with crop lines (T1200 series only) ....................................... 59
Reprint last printed job ................................................................... 60
Use paper economically ................................................................. 60
Nest jobs to save roll paper (T1200 series only) ......................... 60
Use ink economically ..................................................................... 62
13 Maintaining the printer ............................................................................................................................. 123
  Check printer status ................................................................................................................................. 124
  Clean the exterior of the printer ........................................................................................................... 124
  Maintain the ink cartridges ...................................................................................................................... 124
  Move or store the printer ......................................................................................................................... 124
  Update the firmware ............................................................................................................................... 125
  Update the software ................................................................................................................................. 126
  Printer maintenance kits ......................................................................................................................... 126
  Secure Disk Erase ................................................................................................................................. 126

14 Accessories ............................................................................................................................................... 128
  How to order supplies and accessories ............................................................................................ 129
  Introduction to the accessories ............................................................................................................. 133

15 Troubleshooting paper issues ................................................................................................................. 135
  The paper cannot be loaded successfully ...................................................................................... 136
  The paper type is not in the driver ....................................................................................................... 137
  The printer printed on the wrong paper type .................................................................................... 139
  An “on hold for paper” message (T1200 series only) ........................................................................... 139
  The roll paper will not advance .......................................................................................................... 140
  The paper has jammed ......................................................................................................................... 141
  A strip stays on the output tray and generates jams ........................................................................... 143
  The printer displays out of paper when paper is available .............................................................. 144
  Prints do not fall neatly into the basket ................................................................................................. 144
  The sheet stays in the printer when the print has been completed .................................................. 144
  The paper is cut when the print has been completed ....................................................................... 144
  The cutter does not cut well .................................................................................................................. 144
  The roll is loose on the spindle ............................................................................................................ 144
  Recalibrate the paper advance ............................................................................................................ 145

16 Troubleshooting print-quality issues .................................................................................................... 147
  General advice ....................................................................................................................................... 148
  Print quality troubleshooting wizard .................................................................................................. 148
  Horizontal lines across the image (banding) ....................................................................................... 149
  Lines are too thick, too thin or missing ............................................................................................... 150
  Lines appear stepped or jagged ............................................................................................................ 150
  Lines print double or in the wrong colors ........................................................................................... 151
  Lines are discontinuous ......................................................................................................................... 152
  Lines are blurred ................................................................................................................................. 152
  Line lengths are inaccurate .................................................................................................................. 153
  The whole image is blurry or grainy .................................................................................................... 153
  The paper is not flat .............................................................................................................................. 154
  The print is scuffed or scratched .......................................................................................................... 154
  Ink marks on the paper .......................................................................................................................... 155
  Black ink comes off when you touch the print ................................................................................... 156
  Edges of objects are stepped or not sharp ......................................................................................... 156
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>17</td>
<td>Troubleshooting ink cartridge and printhead issues</td>
<td>163</td>
</tr>
<tr>
<td></td>
<td>Cannot insert an ink cartridge</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td>Ink cartridge status messages</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td>Cannot insert a printhead</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td>The front-panel display recommends reseating or replacing a printhead</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td>Clean the printheads</td>
<td>165</td>
</tr>
<tr>
<td></td>
<td>Clean the printhead drop detector</td>
<td>165</td>
</tr>
<tr>
<td></td>
<td>Align the printheads</td>
<td>168</td>
</tr>
<tr>
<td></td>
<td>Printhead status messages</td>
<td>170</td>
</tr>
<tr>
<td>18</td>
<td>Troubleshooting general printer issues</td>
<td>171</td>
</tr>
<tr>
<td></td>
<td>The printer will not start</td>
<td>172</td>
</tr>
<tr>
<td></td>
<td>The printer does not print</td>
<td>172</td>
</tr>
<tr>
<td></td>
<td>The printer seems slow</td>
<td>173</td>
</tr>
<tr>
<td></td>
<td>Communication failures between computer and printer</td>
<td>173</td>
</tr>
<tr>
<td></td>
<td>Cannot access the HP Utility</td>
<td>174</td>
</tr>
<tr>
<td></td>
<td>Cannot access the Embedded Web Server</td>
<td>174</td>
</tr>
<tr>
<td></td>
<td>Automatic file system check</td>
<td>174</td>
</tr>
<tr>
<td></td>
<td>An AutoCAD 2000 memory allocation error</td>
<td>175</td>
</tr>
<tr>
<td></td>
<td>No output when printing from Microsoft Visio 2003</td>
<td>175</td>
</tr>
<tr>
<td></td>
<td>Unavailable driver features when printing from QuarkXpress</td>
<td>175</td>
</tr>
<tr>
<td></td>
<td>Printer alerts</td>
<td>176</td>
</tr>
<tr>
<td>19</td>
<td>Front-panel error messages</td>
<td>177</td>
</tr>
<tr>
<td>20</td>
<td>HP Customer Care</td>
<td>179</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>180</td>
</tr>
<tr>
<td></td>
<td>HP Professional Services</td>
<td>180</td>
</tr>
<tr>
<td></td>
<td>HP Instant Support</td>
<td>181</td>
</tr>
<tr>
<td></td>
<td>HP Proactive Support</td>
<td>181</td>
</tr>
<tr>
<td></td>
<td>Contact HP Support</td>
<td>182</td>
</tr>
</tbody>
</table>
1 Introduction

- Safety precautions
- HP Start-Up Kit
- Using this guide
- Printer models
- The printer's main features
- The printer's main components
- The front panel
- Printer software
- The printer's internal prints
Safety precautions

The following precautions ensure the proper use of the printer and prevent the printer from being damaged. Follow these precautions at all times.

- Use the power supply voltage specified on the nameplate. Avoid overloading the printer's electrical outlet with multiple devices.
- Ensure the printer is well-grounded. Failure to ground the printer may result in electrical shock, fire and susceptibility to electromagnetic interference.
- Do not disassemble or repair the printer yourself. Contact your local HP Service Representative for service, see Contact HP Support on page 182.
- Use only the electrical cord supplied by HP with the printer. Do not damage, cut or repair the power cord. A damaged power cord has risk of fire and electric shock. Replace a damaged power cord with an HP-approved power cord.
- Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the printer. Doing so may cause fire, electric shock or other serious hazards.
- Turn off the printer and unplug the power cable from the power outlet in any of the following cases:
  - When placing your hands inside the printer
  - If there is smoke or an unusual smell coming from the printer
  - If the printer is making an unusual noise not heard during normal operation
  - A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts of the printer
  - During a thunderstorm
  - During a power failure

HP Start-Up Kit

The HP Start-Up Kit is the CD that comes with your printer; it contains the printer's software and documentation.

Using this guide

This guide can be downloaded from the HP Knowledge Center (see Knowledge Center on page 180).

Introduction

This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance

These chapters help you carry out normal printer procedures and include the following topics.

- Installing the software on page 11
- Setting up the printer on page 20
- Personalizing the printer on page 25
Troubleshooting

These chapters help you solve problems that may occur while printing and include the following topics.

- Troubleshooting paper issues on page 135
- Troubleshooting print-quality issues on page 147
- Troubleshooting ink cartridge and printhead issues on page 163
- Troubleshooting general printer issues on page 171
- Front-panel error messages on page 177

Accessories, support and specifications

These chapters, Accessories on page 128, HP Customer Care on page 179 and Printer specifications on page 183, contain reference information, including customer care, the printer specifications and part numbers for paper types, ink supplies and accessories.

Glossary

The Glossary on page 187 contains definitions of printing and HP terms used in this documentation.

Index

In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent the printer from being damaged. Follow the instructions marked with these symbols.

⚠️ WARNING!  Failure to follow the guidelines marked with this symbol could result in serious personal injury or death.

⚠️ CAUTION:  Failure to follow the guidelines marked with this symbol could result in minor personal injury or damage to the product.
Printer models

This guide covers the following printer models, normally referring to them by their short names for brevity.

<table>
<thead>
<tr>
<th>Full name</th>
<th>Short name</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Designjet T770</td>
<td>T770</td>
</tr>
<tr>
<td>HP Designjet T770 with PS Upgrade</td>
<td>T770 PS</td>
</tr>
<tr>
<td>HP Designjet T770 with Hard Disk</td>
<td>T770 HD</td>
</tr>
<tr>
<td>HP Designjet T770 with Hard Disk and PS Upgrade</td>
<td>T770 HD PS</td>
</tr>
<tr>
<td>HP Designjet T1200</td>
<td>T1200</td>
</tr>
<tr>
<td>HP Designjet T1200 PostScript®</td>
<td>T1200 PS</td>
</tr>
</tbody>
</table>

The printer's main features

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 610 mm (24 in) or 1118 mm (44 in) wide. Some major features of the printer are shown below:

- Print resolution of up to 2400 × 1200 optimized dpi, from a 1200 × 1200 dpi input, using the Best print-quality option, the Maximum Detail option and photo paper
- The HP Utility, see Access the HP Utility on page 27, provides an easy-to-use interface including:
  - Job management, see Job queue management on page 103
  - Printer calibration
  - Access to the online HP Knowledge Center (see Knowledge Center on page 180)
- Paper flexibility and automatic easy load, see Paper handling on page 31, with information and presets accessible from the front panel and the HP Utility
- Handles cut-sheet and roll paper
- Six-ink system
- Accurate and consistent color reproduction with automatic color calibration
- Color emulations, see Printer emulation on page 68
- Econemode for printing economically
- Two rolls loaded at once provide fast and easy switching between different rolls, or long runs of unattended printing (T1200 series only)
- High productivity features such as job previewing and nesting using the HP Utility or the printer's Embedded Web Server (T1200 series only)
- Ink and paper usage information available from the Embedded Web Server, see Access the Embedded Web Server on page 27
The printer's main components

The following front and rear views of the 1118mm (44 in) printer illustrate the main components. The 610 mm (24 in) printer (not shown) has the same components in a narrower body.

Front view

1. Ink cartridge
2. Ink cartridge slots
3. Blue lever
4. Window
5. Front panel
6. Printhead carriage
7. Printhead
8. Output tray
9. Paper alignment lines
10. Basket
1. Roll cover
2. Communication ports
3. Power switch
4. Power socket
5. Spindle
6. Spindle stop
7. Paper roll
8. Quick Reference Guide holder
Communication ports

1. USB 2.0 port, to connect a computer
2. Ethernet port, to connect to a network
3. Diagnostic LEDs, to be used by service engineers
4. USB 2.0 host port, to connect an accessory

The wall spacers

If you place the printer with its back against a wall, lower the two wall spacers at the rear of the printer to ensure that the rear of the printer is a minimum distance from the wall. Otherwise, you may experience paper advance problems.
The front panel

Your printer's front panel is located on the front of the printer, in the center. It has the following important functions:

- Assists you in troubleshooting issues
- Is used to perform certain procedures, such as cutting and unloading paper
- Displays helpful animations to guide you through procedures
- Displays up-to-date information about the status of the printer such as, the ink cartridges, the printheads, the paper and the print jobs
- Displays warning and error messages, when appropriate, along with audio alerts to call attention to a warning or message
- Can be used to change the values of printer settings and thus change the operation of the printer. However, settings in the front panel are overridden by settings in the printer drivers, see Installing the software on page 11

HP Designjet T1200 series

1. View ink levels key: see Check the ink cartridges status on page 113.
2. View information key. By pressing this key repeatedly, you can see information about all loaded papers (roll 1, roll 2, sheet) and about the printer's connection to the computer. See View information about the paper on page 42.
3. Pause printing key (T1200 series) pauses printing after finishing the current page. Press the key again to restart printing. This can be useful, for instance, when you want to change or load a roll.
   Unload paper key (T770 series) unloads the currently-loaded paper (roll or sheet).
4. Form feed and cut key: see Feed and cut the paper on page 45.
5. Front-panel display - Displays errors, warnings and information on using your printer.
6. Back key - To go to the previous step in a procedure or interaction. To go to the upper level, or leave the option in the menu, or when given an option.
7. Menu key - Press to return to the main menu of the front-panel display. If you are already on the main menu it will display the status screen.
8. Down key - To go down in a menu or option, or to decrease a value, for example when configuring the front-panel display contrast or the IP address.
9. **Power key** - To turn the printer off or on, it also has a light to indicate the printer's status. If the power key light is off the printer is off. If the power key light is blinking green, the printer is starting up. If the power key light is green on, the printer is on. If the power key light is amber on, the printer is in standby. If the power key light is blinking amber, the printer needs attention.

10. **Cancel key** - To abort a procedure or interaction.

11. **Up key** - To go up in a menu or option, or to increase a value, for example when configuring the front-panel display contrast or the IP address.

12. **OK key** - To confirm an action while in a procedure or interaction. To enter in a submenu in the menu. To select a value when given an option. If the status screen is displayed, this key takes you to the main menu.

13. **Status light** - Indicates the printer's status. If the Status light is solid green, the printer is ready. If it is flashing green, the printer is busy. If it is solid amber, there is a system error. If it is flashing amber, the printer needs attention.

To **highlight** an item in the front-panel display, press the Up or Down key until the item is highlighted.

To **select** an item in the front-panel display, first highlight it and then press the OK key.

When this guide shows a series of front-panel display items like this: Item1 > Item2 > Item3, it means that you should select Item1, then select Item2, then select Item3.

Information about specific uses of the front panel can be found throughout this guide.

**Printer software**

The following software is provided with your printer:

- The HP-GL/2 and HP RTL driver for Windows
- The PCL3 raster driver for Mac OS (T770 and T1200)
- The PostScript drivers for Windows and Mac OS (T770 PS and T1200 PS)
- The HP Utility, see [Access the HP Utility on page 27](#), allows you to:
  - Manage the printer including color with the HP Color Center
  - View the status of the ink cartridges, the printheads and the paper
  - Access the HP Knowledge Center, see [Knowledge Center on page 180](#)
  - Update the printer's firmware, see [Update the firmware on page 125](#)
  - Perform calibrations and troubleshooting
  - Manage the job queue, see [Job queue management on page 103](#)
  - View job accounting information, see [Retrieving printer usage information on page 109](#)
  - Change various printer settings (in the Settings tab) (T1200 series only)
- The Embedded Web Server runs in the printer and enables you to use a Web browser on any computer to check ink levels and printer status, see [Access the Embedded Web Server on page 27](#).
The printer's internal prints

The internal prints give various kinds of information about your printer. They can be requested from the front panel without using a computer.

Before requesting any internal print, check that the printer and the paper are ready for printing.

- The print will be made on the active roll. To change the active roll, select the Paper menu icon \( \text{Select active roll} \).
- The loaded paper should be at least A3 landscape—420 mm (16.53in) wide—otherwise the print may be clipped.
- The front panel should be displaying the Ready message.

To print any internal print, select the Internal Prints menu icon \( \text{Internal Prints} \), then select the internal print you want. The following internal prints are available.

- Demo prints: show some of the capabilities of the printer
  - Print drawing demo
  - Print rendering demo
  - Print GIS map
- Menu map: shows details of all the front-panel display menus
- Configuration: shows all the current front-panel display settings
- Usage report: shows estimates of the total number of prints, number of prints by paper type, number of prints by print-quality option and total amount of ink used per color (the accuracy of these estimates is not guaranteed) (T770 HD and T1200 series only)
- HP-GL/2 palette: shows the color or grayscale definitions in the currently selected color palette
- Service information: provides information needed by service engineers
- PostScript font list: shows PostScript fonts available (PostScript printers only)
2 Installing the software

- Choose which connection method to use
- Connect to a network (Windows)
- Connect directly to a computer (Windows)
- Uninstall the printer software (Windows)
- Connect to a network (Mac OS)
- Connect directly to a computer (Mac OS)
- Uninstall the printer software (Mac OS)
Choose which connection method to use

The following methods can be used to connect your printer.

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Speed</th>
<th>Cable length</th>
<th>Other factors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>Very fast; varies according to network traffic</td>
<td>Long: 100 m (328 ft)</td>
<td>Requires extra equipment (switches)</td>
</tr>
<tr>
<td>Jetdirect print server (optional accessory)</td>
<td>Moderate; varies according to network traffic</td>
<td>Long: 100 m (328 ft)</td>
<td>Requires extra equipment (switches) Provides additional features See <a href="http://www.hp.com/go/jetdirect/">http://www.hp.com/go/jetdirect/</a> for more details</td>
</tr>
<tr>
<td>USB 2.0</td>
<td>Very fast</td>
<td>Short: 5 m (16 ft)</td>
<td>A certified USB 2.0 cable is necessary for reliable communication.</td>
</tr>
</tbody>
</table>

**NOTE:** The speed of any network connection depends on all components used in the network, which can include network interface cards, hubs, routers, switches and cables. If any one of these components cannot operate at high speed, you will have a low-speed connection. The speed of your network connection can also be affected by the total amount of traffic from other devices on the network.

Connect to a network (Windows)

Before you begin, check your equipment:

- The printer should be set up and on.
- The Ethernet hub or router should be on and functioning correctly.
- All computers on the network should be on and connected to the network.
- The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer:

1. Make a note of the printer's IP address from the front panel (see [Access the Embedded Web Server on page 27](#)).
2. Insert the HP Start-Up Kit CD into your computer. If the CD does not start automatically, run the autorun.exe program in the root folder of the CD.
3. Press the **Express Network Install** button, and choose your printer from the list of networked printers that appears, identifying it by its IP address if necessary. The printer drivers and the HP Utility are installed.

If your computer fails to find any printers on the network, the **Printer Not Found** window is displayed, which helps you to try to find your printer. If you have a firewall in operation; you may have to disable it temporarily in order to find the printer. You also have the options of searching for the printer by its URL, IP address or MAC address.

Connect directly to a computer (Windows)

You can connect your printer directly to a computer without going through a network, by using the printer’s built-in USB 2.0 port.
A USB connection may be faster than a network connection, but the cable is limited in length and it is more difficult to share the printer.

The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

1. Do not connect the computer to the printer yet. You must first install the printer driver software on the computer, as follows.

2. Insert the HP Start-Up Kit CD into your CD drive. If the CD does not start automatically, run the autorun.exe program in the root folder of the CD.

3. Press the Custom Install button.

4. In some cases, you may see a message warning you that the installer would need to communicate through the firewall in order to search the network for printers. As you have no need to do this, you can check the box Continue installation without searching the network.

5. If you see a list of networked printers, select Help me find my printer (including network, USB or parallel connected printers).

6. Select USB Cable.

NOTE: You can connect your printer and complete the installation later if you prefer. To do so, check the box marked I want to connect my printer after completing the setup wizard.

7. When prompted to do so, connect your computer to the printer with a certified USB cable. Ensure that the printer is turned on.

8. The printer drivers and the HP Utility are installed.

TIP: If you would like to share the printer with other people connected to your network, press the Printer Properties button in the Ready to Install window, set Printer Name to the name under which the printer will be shared, then set Shared to Yes.

Printer sharing considerations

- The HP Utility must be installed on a computer before it can be used from that computer.
- Any other users sharing your directly connected printer will be able to send print jobs, but will not be able to receive information from the printer—which affects printer alerts, printer status reports, paper management, printer administration and troubleshooting.
- Any other users sharing your directly connected printer will be unable to use the printer's own print preview facility, although the application's print preview will still be available. See Preview a print on page 56.

TIP: The best way to share the printer over a network is to connect the printer not to any computer, but to the network. See Connect to a network (Windows) on page 12.

Uninstall the printer software (Windows)

1. Insert the HP Start-Up Kit CD into your CD drive. If the CD does not start automatically, run the autorun.exe program in the root folder of the CD.

2. Press the Modify Installation button, and follow the instructions on your screen to uninstall the printer software.
Connect to a network (Mac OS)

You can connect your printer to a network under Mac OS X by using the following methods:

- Bonjour/Rendezvous
- TCP/IP

**NOTE:** The printer does not support AppleTalk.

Before you begin, check your equipment:

- The printer should be set up and on.
- The Ethernet hub or router should be on and functioning correctly.
- All computers on the network should be on and connected to the network.
- The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer.

**Bonjour/Rendezvous connection**

1. Go to your printer’s front panel and select the Connectivity menu icon then Fast Ethernet or Gigabit Ethernet > View configuration. Note the mDNS service name of your printer.

2. Insert the HP Start-Up Kit CD into your CD drive.

3. Open the CD icon on your desktop.
4. Open the **Mac OS X HP Designjet Installer**.

![Mac OS X HP Designjet Installer](image)

5. Follow the instructions on your screen.

6. The printer software is installed, including the printer driver and the HP Utility.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your printer. Follow the instructions on your screen.

8. When you reach the Select Printer screen, look for your printer’s mDNS service name (which you noted in step 1) in the Printer Name column.

![Select Printer](image)

- If you find the right printer name, scroll sideways if necessary to see the Connection Type column, and check that it shows **Bonjour/Rendezvous**. Then highlight that line. Otherwise, continue searching further down the list.

- If you cannot find your printer name with a **Bonjour/Rendezvous** connection type, check the box **My printer is not in the list**.

Click **Continue**.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click **Quit** to exit, or **Create New Queue** if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the CD.
TCP/IP connection

1. Go to your printer's front panel and make a note of the printer's URL (see Access the Embedded Web Server on page 27).

2. Insert the HP Start-Up Kit CD into your CD drive.

3. Open the CD icon on your desktop.

4. Open the Mac OS X HP Designjet Installer.

5. Follow the instructions on your screen.

6. The printer software is installed, including the printer driver and the HP Utility.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your printer. Follow the instructions on your screen.

8. When you reach the Select Printer screen, look for your printer's URL (which you noted in step 1) in the Printer Name column.
   - If you find the right printer name, scroll sideways if necessary to see the Connection Type column, and check that it shows IP Printing. Then highlight that line. Otherwise, continue searching further down the list.
   - If you cannot find your printer name with an IP Printing connection type, check the box My printer is not in the list.

Click Continue.
9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click **Quit** to exit, or **Create New Queue** if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive. If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the CD.

**Connect directly to a computer (Mac OS)**

You can connect your printer directly to a computer without going through a network, by using the printer's built-in USB 2.0 port.

1. Make sure the printer is either turned off, or disconnected from the computer.
2. Insert the **HP Start-Up Kit** CD into your CD drive.
3. Open the CD icon on your desktop.
4. Open the **Mac OS X HP Designjet Installer**.
5. Follow the instructions on your screen.
6. The printer software is installed, including the printer driver and the HP Utility.
7. Make sure that the printer is turned on and connected to the computer with a certified USB cable.
NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

8. Shortly afterwards, a print queue is created automatically for your printer.

Sharing the printer

If your computer is connected to a network, you can make your directly connected printer available to other computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.
2. Under Mac OS X 10.4, enable printer sharing by going to Sharing > Services > Printer Sharing.
   Under later versions of Mac OS X, go to Sharing, select Printer Sharing, and then check the printer(s) that you want to share.
3. Your printer now automatically appears in the list of shared printers displayed by any other computer running Mac OS and connected to your local network.

Please bear in mind the following considerations.

● Any other users wishing to share your printer must install the printer software on their own computers.
● Anyone sharing your directly connected printer will be able to send print jobs, but will not be able to receive information from the printer—which affects printer alerts, printer status reports, paper management, printer administration and troubleshooting.
● The PCL3 (raster) driver can drive a shared printer between different versions of Mac OS, but the PostScript driver does not support printer sharing between Mac OS X 10.4 and Mac OS X 10.5 or 10.6. It does support printer sharing between Mac OS X 10.5 and 10.6.
● You may find that sharing your directly connected printer with other users will slow down your computer unacceptably.

TIP: The best way to share the printer over a network is to connect the printer not to any computer, but to the network. See Connect to a network (Mac OS) on page 14.

Uninstall the printer software (Mac OS)

1. Insert the HP Start-Up Kit CD into your CD drive.
2. Open the CD icon on your desktop.

3. Open the Mac OS X HP Designjet Uninstaller, and follow the instructions on your screen to uninstall the printer software.

To delete the print queue:

- Under Mac OS X 10.4 there are two alternative ways of deleting the print queue:
  - From the system preferences, select the Printing pane of the Print & Fax dialog. Select the name of the printer and click the – button.
  - From the Print Setup utility, select the name of the printer and click the Delete icon.
- Under Mac OS X 10.5 or 10.6: from the system preferences, select the Print & Fax dialog. Select the name of the printer and click the – button.
3 Setting up the printer

- Introduction
- Paper suitability options (T1200 series only)
- Turn nesting on and off (T1200 series only)
- Turn usage information on and off
- Turn alerts on and off
- Control access to the printer
- Require account ID (T1200 series only)
- Set Windows driver preferences
Introduction

This chapter describes various printer settings that the printer administrator may wish to control as soon as a new printer is assembled and ready for use.

Paper suitability options (T1200 series only)

Paper mismatch action

If the paper currently loaded in the printer is not suitable for a particular job, the printer can either put the job on hold until some suitable paper is loaded, or it can ignore the problem and print the job on the unsuitable paper. There are several ways in which the loaded paper may be considered unsuitable:

- The paper type is not as specified for the job
- The paper source (roll 1, roll 2 or sheet) is not as specified for the job
- The paper size is smaller than specified for the job

You can set the printer's behavior in such cases from the front panel.

- Select the Setup menu icon, then Job management options > Paper mismatch action > Print anyway if you want such jobs to print on whatever paper is loaded. This is the default option.
- Select the Setup menu icon, then Job management options > Paper mismatch action > Put job on hold if you want such jobs to be put on hold. The printer will send an alert whenever a job is put on hold.

When a job is put on hold for paper, it is kept in the printer queue until some suitable paper is loaded (in which case, all jobs waiting for that paper type can be printed). Meanwhile, other jobs with different requirements can continue printing.

Roll switching options

If two rolls are loaded, both of which are suitable for the job, the roll will be chosen according to your preferences. These can be set from the front panel: select the Setup menu icon, then Printing preferences > Paper options > Roll switching options. There are three available options:

- Minimize paper waste. If this option is chosen, the printer will choose the narrowest roll that meets all the criteria, to avoid wasting paper due to trimming. This is the default option.
- Minimize roll changes. If this option is chosen, the printer will choose the roll that is currently active, to avoid wasting time with a roll switch. To change the active roll, select the Paper menu icon then Select active roll.
- Use roll with less paper. If this option is chosen, the printer will choose the roll that has the least paper.

NOTE: This option is effective only if you have enabled Printing paper info (see Printing paper info on page 43). Otherwise, it has the same effect as Minimize paper waste.
Turn nesting on and off (T1200 series only)

Nesting means automatically printing images or document pages side by side on the paper when feasible, rather than one after the other. This is done to avoid wasting paper. See Nest jobs to save roll paper (T1200 series only) on page 60.

To turn nesting on or off, you must first make sure that the job queue is enabled (see Turn off the job queue (T770 HD and T1200 series only) on page 105) and the start of printing is set to After Processing (see Select when to print a job in the queue (T770 HD and T1200 series only) on page 105). Then:

- In the HP Utility for Windows: select Settings > Job Management > Nest.
- In the HP Utility for Mac OS: select Configuration > Printer Settings > Configure Printer Settings > Job Management > Nest.
- In the Embedded Web Server: select Setup > Printer settings > Job management > Nest.
- Using the front panel: select the Setup menu icon, then Job management > Nest options > Enable nesting.

In each case, you will see the following options:

- **In order**: pages are nested in the order in which they are sent to the printer. The nested pages are printed as soon as one of three conditions is met:
  - The next page will not fit on the same row as the other pages already nested.
  - No page has been sent to the printer during the specified wait time.
  - The next page is incompatible with the pages already nested (see Nest jobs to save roll paper (T1200 series only) on page 60).

- **Optimized order**: pages are not necessarily nested in the order in which they are sent to the printer. When it receives an incompatible page, the printer holds it and waits for compatible pages to complete the nest. The nested pages are printed as soon as one of three conditions is met:
  - The next page will not fit on the same row as the other pages already nested.
  - No page has been sent to the printer during the specified wait time.
  - The incompatible-page queue is full. The printer can queue up to six incompatible pages while nesting compatible pages. If it receives a seventh incompatible page, the nest is printed as it is.

- **Off**: nesting is disabled. This is the default option.

The nesting wait time can be set at the front panel: Setup menu icon, Job management > Nest options > Select wait time.

**TIP**: Optimized order uses the minimum amount of paper; however, it may take longer to print because the printer waits for compatible pages to arrive.
Turn usage information on and off

The printer can send usage information periodically by e-mail. You can request this in the following ways:

- **In the HP Utility for Windows**: select **Settings > Accounting**.
- **In the HP Utility for Mac OS**: select **Configuration > Printer Settings > Configure Printer Settings > Accounting**.
- **In the Embedded Web Server**: select **Setup > Printer settings > Accounting**.

In each case, you must set the following options:

- **Send accounting files**: On (the default is Off)
- **Send accounting files to**: a valid e-mail address
- **Send accounting files every**: choose a number of days (1–60) or a number of prints (1–500)

You must also ensure that the e-mail server has been configured. To configure the e-mail server using the Embedded Web Server, select **Setup > E-mail server**, and fill in the following fields:

- **SMTP server**: the IP address of the outgoing mail server (SMTP) that will process all e-mail messages from the printer. If the mail server requires authentication, e-mail notifications will not work.
- **Printer e-mail address**: each e-mail message sent by the printer must include a return address, which does not need to be a real, functional E-mail address, but it should be unique, so that recipients of the message can identify the printer that sent it.

Turn alerts on and off

Printer alerts warn you when there is a printer problem that you can correct by taking action, or when one of your printing jobs changes its status. The alerts are displayed by the printer’s front panel, by the HP Utility, by the printer driver and by the Embedded Web Server.

You can tell the printer which kinds of alerts you would like to see (if any). To access the alert settings:

- Select **Alert Settings** in the Device List page of the HP Utility.
- Select **Alert Settings** in any alert page displayed by the HP Utility for Windows.
- Right-click the system tray icon of the HP Utility for Windows, and select **Alert Settings**.

You can change the settings in the following ways:

- Turn all alerts on or off.
- Turn job status alerts on or off (T1200 series only).
- Turn on or off printer alerts for problems that stop the printer from printing.
- Turn on or off printer alerts for problems that do not stop the printer from printing.
- Turn on printer alerts in all circumstances, or only when you are trying to print to the printer affected by the problem.
Control access to the printer

From the Embedded Web Server, you can select **Setup > Security** to control access to the printer in various ways:

- Specify separate administrator and guest passwords to control access to the Embedded Web Server
- Enable or disable Ethernet and USB connections to the printer
- Enable or disable various groups of front panel operations

**NOTE:** For more information, see the Embedded Web Server's online help.

If you forget the administrator password, you can delete the current password from the front panel: select the Connectivity menu icon, then **Advanced > Embedded Web Server > Reset EWS access control**.

Access to the Networking page is protected by a different password (the administrator's password). To reset the administrator's password, you need to reset the whole input/output configuration. Using the front panel, select the Connectivity menu icon, then select your connection method (e.g. Gigabit Ethernet), then **Restore factory settings**.

**NOTE:** This will reset the whole input/output configuration, the printer will reset to the DHCP configuration method and its IP address could change.

Require account ID (T1200 series only)

If you want to keep records of printer usage by different user accounts, you can set your printer to require an account ID for each job.

- **In the HP Utility for Windows:** select **Settings > Accounting > Require account ID**.
- **In the HP Utility for Mac OS:** select **Configuration > Printer Settings > Configure Printer Settings > Accounting > Require account ID**.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept "on hold for accounting".

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for accounting" by the printer, you can introduce the account ID in the HP Utility by going to the **Job Center > Job Queue** and clicking the job that is on hold. A window with a text box will be displayed and you can enter the account ID into it.

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for instance to set color emulation or paper-saving options. To do this, press the **Start** button on your computer's screen, then select **Printers and Faxes**. In the Printers and Faxes window, right-click on your printer's icon, and select **Printing Preferences**. Any settings you change in the Printing Preferences window will be saved as default values.
4 Personalizing the printer

- Turn the printer on and off
- Change the language of the front-panel display
- Access the HP Utility
- Access the Embedded Web Server
- Change the language of the HP Utility
- Change the language of the Embedded Web Server
- Change the sleep mode setting
- Turn the buzzer on and off
- Change the front-panel display contrast
- Change the units of measurement
- Configure network settings
- Change the graphic language setting
Turn the printer on and off

**TIP:** The printer can be left powered on without wasting energy. Leaving it on improves response time and overall system reliability. When the printer has not been used for a certain period of time (the default time is determined by Energy Star), it saves power by going into sleep mode. However, any interaction with the printer's front-panel display, or sending a new job to print, returns it to active mode, and it can resume printing immediately. To change the sleep mode time, see Change the sleep mode setting on page 28.

**NOTE:** In sleep mode, the printer performs maintenance service to the printheads from time-to-time. This avoids long preparation times after long idle periods. Therefore, it is strongly recommended to leave the printer powered on or in sleep mode to avoid wasting ink and time.

The printer has three levels of power consumption.

- Plugged in: the power cord is plugged into the back of the printer
- Switched on: the switch at the back of the printer is in the on position
- Powered on: the Power key on the front panel shows a green light

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to use the Power key on the front panel.

However, if you plan to store the printer indefinitely or the Power key does not seem to work, you are recommended to power it off using the Power key, and then also switch off the power switch at the rear.

To turn it back on, use the power switch at the rear.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the printheads. Preparing the printheads takes about one minute and 15 seconds. However, if the printer has been off for six weeks or more, preparing the printheads could take up to 45 minutes.
Change the language of the front-panel display

There are two possible ways to change the language of the front-panel menus and messages.

- If you can understand the current front-panel display language, select the Setup menu icon, then **Front panel options > Select language**.

- If you cannot understand the current front-panel display language, start with the printer powered off. At the front panel, press the OK key and hold it down. While holding the OK key down, press the Power key and hold it down. Continue to hold down both keys until the green light on the right side of the front-panel display starts flashing, and then release both keys. You can expect a delay of about one second. If the green light starts flashing without any delay, you may need to start again.

Whichever method you used, the language selection menu should now appear on the front-panel display. Highlight your preferred language with the Up and Down keys, then press the OK key.

When you have selected your preferred language, turn off the printer with the Power key and then turn it on again. The front panel will appear in the selected language.

Access the HP Utility

The HP Utility enables you to manage your printer from a computer with a USB, TCP/IP or Jetdirect connection.

- **Under Windows**, start the HP Utility from your desktop shortcut or from Start > All Programs > Hewlett-Packard > HP Utility > HP Utility. This launches the HP Utility, showing the printers installed on your computer.

- **Under Mac OS**, launch the HP Utility from your dock shortcut or by selecting STARTUP_DISK > Library > Printers > hp > Utilities > HP Utility. This launches the HP Utility, showing the printers installed on your computer.

  When you select your printer in the left pane, everything that appears in the right pane is specific to that printer.

  If you have followed these instructions but failed to get through to the HP Utility, see **Cannot access the HP Utility on page 174**.

Access the Embedded Web Server

The Embedded Web Server enables you to manage your printer remotely using an ordinary Web browser running on any computer.

To access the Embedded Web Server directly, you must have a TCP/IP connection to your printer. However, you can access the Embedded Web Server indirectly through the HP Utility, if you connect to your printer with a USB connection.

The following browsers are known to be compatible with the Embedded Web Server:

- Internet Explorer 6 and later, for Windows
- Safari 2 and later, for Mac OS X 10.4
- Firefox 1.5 and later

To access the Embedded Web Server on any computer, open your Web browser and give the IP address of your printer.
You can see your printer’s IP address (192.168.1.1 in this example) on the front panel’s status screen.

Change the language of the HP Utility

The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows only), French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.

- **Under Windows**, select **Tools > Set Language** and select a language from the list.
- **Under Mac OS**, the language is changed as for any other application. In **System Preferences**, select **International** and re-launch the application.

Change the language of the Embedded Web Server

The Embedded Web Server can work in the following languages: English, Portuguese, Spanish, Catalan, French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese. It uses whichever language you have specified in your Web browser’s options. If you have specified a language that it cannot support, it works in English.

To change the language, you must change your Web browser’s language setting. For example, in Internet Explorer version 6, go to the **Tools** menu and select **Internet Options**, **Languages**. Then ensure that the language you want is at the top of the list in the dialog box.

Change the sleep mode setting

If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep mode to save power. To change the time the printer waits before it goes into sleep mode, go to the front panel and select the Setup menu icon then **Front panel options > Sleep mode wait time**. Highlight the wait time you want and then press the OK key. You can set the time from 1 to 240 minutes. The default time is 30 minutes.

Turn the buzzer on and off

To turn the printer’s buzzer on or off, go to the front panel and select the Setup menu icon then **Front panel options > Enable buzzer**, and highlight on or off and press the OK key. By default, the buzzer is set to on.
Change the front-panel display contrast

To change the contrast of the front-panel display, select the Setup menu icon, then Front panel options > Select display contrast, and enter a value using the Up or Down key. Press the OK key to set the value. The default contrast is set to 50.

Change the units of measurement

To change the units of measurement in the front-panel display, select the Setup menu icon, then Front panel options > Select units, and select English or Metric. By default the units are set to metric.

Configure network settings

You can view and configure the network settings from the HP Utility (T1200 series only). Under Windows, select the Settings tab, then Network Settings. Under Mac OS, select Configuration > Network Settings. The following settings are available.

- **IP Configuration method:** specify the way to set an IP address, selecting BOOTP, DHCP, Auto IP or Manual.
- **Host name:** specify an IP name for the network device. The name may contain up to 32 ASCII characters.
- **IP address:** specify the IP address on the print server. Duplicate IP addresses on a TCP/IP network are not allowed.

**NOTE:** If you change the current IP address and click Apply, the browser loses the current connection to the print server because it is pointing to the old address. To reconnect, browse to the new IP address.

- **Subnet mask:** specify a subnet mask, which is a 32-bit number applied to an IP address to determine which bits specify the network and subnet and which bits uniquely specify the node.
- **Default gateway:** specify the IP address of a router or computer that is used to connect to other networks or sub-networks. If none exist, use the IP address of the computer or the IP address of the print server.
- **Domain name:** specify the name of the DNS domain in which the print server resides (for example, support.hp.com).

**NOTE:** The domain name does not include the host name: it is not the fully qualified domain name, such as printer1.support.hp.com.

- **Idle timeout:** specify the number of seconds that an idle connection is allowed to remain open; 30 is the default value. If set to zero, the timeout is disabled and TCP/IP connections remain open until closed by the other node (such as a workstation) on the network.
- **Default IP:** specify the IP address to use when the print server is unable to obtain an IP address from the network when powered on or when reconfigured to use BOOTP or DHCP.
- **Send DHCP requests:** specify whether DHCP requests are transmitted when a legacy default IP address or a default Auto IP is assigned.

To configure the same network settings from the front panel, select the Connectivity menu icon, then Fast Ethernet or Gigabit Ethernet > Modify configuration.
You have various other options available from the Connectivity menu icon.

- **USB**: view information about the USB connection
- **Jetdirect EIO**: view information, configure and reset the Jetdirect connection
- **Advanced > Select I/O timeout**: specify the number of seconds that an idle connection is allowed to remain open. 270 is the default value, if set to zero, the timeout is disabled
- **Advanced > Allow SNMP**: specify whether SNMP is permitted
- **Advanced > Embedded Web Server > Allow EWS**: specify whether the Embedded Web Server is enabled
- **Advanced > Web Services > HP Utility software**: view the HP Utility software settings
- **Advanced > Web Services > Color and paper management**: view the color and paper management settings

### Change the graphic language setting

You can change the graphic language setting from the HP Utility with the following steps (T1200 series only).

1. **Under Windows**, select the **Settings** tab then **Printer settings > Printing preferences**.
   Under **Mac OS**, select **Configuration** then **Printer settings > Configure printer settings > Printing preferences**.

2. Select one of the following options.
   - **Select Automatic** to let the printer determine which type of file it is receiving. This is the default setting; it works for most software applications. You should not normally need to change it.
   - **Select HP-GL/2** only if you are sending a file of that type directly to the printer, without going through a printer driver.
   - **Select PDF** only if you are sending a file of that type directly to the printer, without going through a printer driver (PostScript printers only).
   - **Select PostScript** only if you are sending a file of that type directly to the printer, without going through a printer driver (PostScript printers only).
   - **Select TIFF** only if you are sending a file of that type directly to the printer, without going through a printer driver (T1200 PS only).
   - **Select JPEG** only if you are sending a file of that type directly to the printer, without going through a printer driver (T1200 PS only).

You can change the graphic language setting from the front panel. Select the Setup menu icon then **Printing preferences > Select graphic language**. Select the desired option and press the **OK** key to set the value.

**NOTE:** If the graphic language is set from the HP Utility, it overrides the front panel setting.
5 Paper handling

- General advice
- Load a roll onto the spindle
- Load a roll into the printer
- Unload a roll
- Load a single sheet
- Unload a single sheet
- View information about the paper
- Paper presets
- Printing paper info
- Move the paper
- Maintain paper
- Change the drying time
- Turn the automatic cutter on and off
- Feed and cut the paper
General advice

△ **CAUTION:** Before starting a paper loading process, ensure you have enough room around the printer, both in front and behind.

△ **CAUTION:** Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

△ **CAUTION:** All paper must be 280 mm (11 in) or longer. A4 and letter paper cannot be loaded in landscape orientation.

☆ **TIP:** For photo paper wear cotton gloves to avoid transferring oils onto the paper.

△ **CAUTION:** Keep the basket closed throughout the loading process.
Load a roll onto the spindle

1. Open the roll cover.

2. Remove the black end of the spindle from the printer, then the blue end.
   
   △ **CAUTION:** Be sure to remove the black end first. Removing the blue end first could damage the black end.

   △ **WARNING!** Do not insert your fingers into the spindle supports during the removal process.

3. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper stop from the end of the spindle.

4. If the roll is long; rest the spindle horizontally on a table and load the roll on the table.

   ✤ **TIP:** You may need two people to handle a large roll.
5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing the correct orientation.

NOTE: From the back of the printer, the blue stopper is inserted into the right-side holder.

![Image showing the correct orientation of a roll](image)

Ensure both ends of the roll are as close to the spindle stops as possible.

6. Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

![Image showing the blue paper stop being pushed into the roll](image)

7. Ensure the blue paper stop is pushed in as far as it goes; until both ends are against the stoppers.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of different paper types on different spindles. Extra spindles are available for purchase, see Accessories on page 128.

Load a roll into the printer

To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle on page 33.

TIP: If you have a T1200 series printer, do not try to open both roll covers at once; this may cause problems. Always close one cover before opening the other.

NOTE: The first three steps below are optional: you can start with step 4. However, in this case the printer will not keep track of the length of the roll, and will print no barcode on the roll when it is next unloaded. So you are recommended to follow all the steps, starting with step 1, unless you have turned off the Printing paper info option. See Printing paper info on page 43.

1. From the front panel, select the Paper menu icon.

---

| 34 Chapter 5  Paper handling | ENWW |
2. Select **Paper load**.

   Paper
   - Paper load
   - Paper unload
   - Select active roll
     - View paper source
   - Change loaded paper type
   - Paper types list
     - Move paper

3. Select the roll that you want to load.

   Paper load
   - Load roll 1
   - Load roll 2
   - Load sheet

   If the roll you have selected is already loaded, you have to wait while it is automatically unloaded.

4. In the T1200 series only, if you start to load roll 1 while roll 2 is already loaded, roll 2 is withdrawn to the standby position, so that it can be printed on again without reloading whenever required.

   **NOTE:** If at any time you open a roll cover while that roll is in the standby position, the roll will be automatically unloaded, and you will have to reload it the next time you want to print on it.

5. Open the roll cover, if it is not already open.

6. You should stand behind the printer when loading the T1200’s lower roll (roll 2). You may stand behind or in front of the printer when loading the upper roll (roll 1), or when loading a roll into the T770.

   **CAUTION:** If your height is less than 1.6 m (5 ft 3 in), loading a roll while standing in front of the printer may cause back pain or other physical problems.

7. Rest the spindle’s black end on the left side roll holder. Do not put the end completely into the roll holder.
8. Rest the blue end of the spindle on the right side roll holder.

9. With both hands, push the spindle into both roll holders at the same time.

10. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull the paper slightly and cut a straight edge.
11. Insert the edge of the paper into the printer.

⚠️ **WARNING!** Do not push your fingers inside the printer’s paper path.

💡 **TIP:** When loading the upper roll, avoid inserting roll paper into the cut-sheet slot. If you do so, the printer beeps and the front panel asks you to remove the paper.

12. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer detects the paper, it feeds it in automatically.

13. If the leading edge of the paper has a barcode, the printer reads and then cuts off the barcode; you should remove and discard the cut strip of paper.
14. If the leading edge of the paper has no barcode, the front panel prompts you to select the paper category and type.

Select paper category
► Bond and Coated Paper
► Photo Paper
► Film
► Technical Paper
► Backlit material
► Self-Adhesive material

yor Tip: If you have loaded a paper type whose name does not appear in the paper list, see The paper type is not in the driver on page 137.

15. If the Printing paper info option is enabled, the front panel may ask you to specify the length of the roll. See Printing paper info on page 43.

16. The printer checks the alignment and measures the width, then the front panel prompts you to close the roll cover.

If the roll is not correctly aligned, follow the instructions on the front-panel display.

NOTE: If you have an unexpected issue at any stage of the paper loading process, see The paper cannot be loaded successfully on page 136.

Unload a roll

Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow the appropriate procedure as described below.

Quick procedure with paper on the roll (T770 series only)

To unload the roll, press the Unload paper key on the front panel.

Quick procedure with paper on the roll (T1200 series only)

If there is paper on the roll, just open the roll cover, and the roll is unloaded automatically.

NOTE: When the roll is unloaded in this way, no barcode is printed on it, so the printer will not know the length of the roll when it is next loaded. See Printing paper info on page 43.

NOTE: If you open the cover of roll 1 while a sheet is loaded, the sheet is also unloaded.

Paper menu procedure with paper on the roll

If there is paper on the roll, you can unload it from the front panel.

1. Select the Paper menu icon 📒.
2. Select **Unload paper**.

```
Paper
- Paper load
- Paper unload
- Select active roll
  - View paper source
  - Change loaded paper type
  - Paper types list
  - Move paper
```

3. Select the roll that you want to unload.

```
Paper unload
- Unload roll 1
- Unload roll 2
- Unload sheet
```

4. You may need to open the roll cover.

**Roll out of paper procedure**

If the end of the paper is no longer attached to the core, use the following procedure.

1. If you have already started the unload process, press the **Cancel** key on the front panel to cancel that procedure.
2. Lift the blue lever on the left. If the front panel displays a warning about the lever, ignore it.
3. Pull out the paper from the printer. Pull from wherever the paper is accessible; the back of the printer is recommended. You may need to open the roll cover.
4. Lower the blue lever.
5. If the front panel displays a warning message, press the **OK** key to clear it.

**Load a single sheet**

1. When using a T1200 series printer, ensure that the cover of roll 1 is closed. If it is opened while a sheet is loaded, the sheet will be immediately unloaded.
2. At the front panel, select the Paper menu icon 📄.
3. Select **Paper load**.

<table>
<thead>
<tr>
<th>Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper load</td>
</tr>
<tr>
<td>Paper unload</td>
</tr>
<tr>
<td>Select active roll</td>
</tr>
<tr>
<td>View paper source</td>
</tr>
<tr>
<td>Change loaded paper type</td>
</tr>
<tr>
<td>Paper types list</td>
</tr>
<tr>
<td>Move paper</td>
</tr>
</tbody>
</table>

4. Select **Load sheet**.

<table>
<thead>
<tr>
<th>Paper load</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load roll 1</td>
</tr>
<tr>
<td>Load roll 2</td>
</tr>
<tr>
<td>Load sheet</td>
</tr>
</tbody>
</table>

5. If a roll is already loaded, you have to wait while it is automatically unloaded. In the T1200 series only, the roll is not unloaded, but withdrawn to the standby position, so that it can be printed on again without reloading as soon as the sheet paper has been unloaded.

**NOTE:** If at any time you open a roll cover while that roll is in the standby position, the roll will be automatically unloaded, and you will have to reload it the next time you want to print on it (T1200 series only).

6. Select your paper category and type.

<table>
<thead>
<tr>
<th>Select paper category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bond and Coated Paper</td>
</tr>
<tr>
<td>Photo Paper</td>
</tr>
<tr>
<td>Film</td>
</tr>
<tr>
<td>Technical Paper</td>
</tr>
<tr>
<td>Backlit material</td>
</tr>
<tr>
<td>Self-Adhesive material</td>
</tr>
</tbody>
</table>

**TIP:** If you have loaded a paper type whose name does not appear in the paper list, see *The paper type is not in the driver on page 137.*
7. When prompted by the front panel, insert the sheet into the cut-sheet slot on the right side of the printer.

![Inserting a sheet into the printer](image)

Load your sheet aligned with the load line and insert until the paper will not continue; with thicker sheets, you feel resistance.

![Load line and paper resistance](image)

⚠️ **WARNING!** Do not push your fingers inside the printer's paper path.

8. Press the OK key on the front panel to feed the paper into the printer. Guide the sheet into the printer; this is especially important with thicker papers.

9. The printer checks the alignment and measures the sheet.

**NOTE:** Depending on the length of the sheet, it feeds out the front of the printer.

10. If the length of the sheet is more than 600 mm (23 in), the front panel prompts you to check that the rear of the sheet is hanging backwards over the roll cover (and not forwards over the printer window).

11. If the sheet is not correctly aligned, you may be asked to correct the alignment. Please follow the instructions on the front-panel display.

**NOTE:** If you have an unexpected problem at any stage of the paper loading process, see [The paper cannot be loaded successfully on page 136](#).

## Unload a single sheet

To unload a single sheet after printing, you can simply pull the sheet free from the front of the printer.

To unload a sheet without printing, use the **Unload paper** key (T770 series only) or the following Paper menu procedure.

1. At the front panel, select the Paper menu icon  

![Paper menu icon](image)
2. Select **Unload paper**.

   Paper
   - Paper load
   - Paper unload
   - Select active roll
   - View paper source
   - Change loaded paper type
   - Paper types list
   - Move paper

3. Select **Unload sheet**.

   Paper unload
   - Unload roll 1
   - Unload roll 2
   - Unload sheet

The sheet unloads out of the front of the printer, either catch it manually or allow it to fall in the basket.

**View information about the paper**

To view the loaded paper information, press the View information key  or  on the front panel. By pressing this key repeatedly, you can see information about all loaded papers: roll and sheet for the T770 series; roll 1, roll 2 and sheet for the T1200 series.

You can also select the Paper menu icon and then **View loaded paper**. By pressing the Up or Down key, you can see information about all loaded papers.

The following information is displayed on the front panel:

- Roll or sheet status
- Paper type you have selected
- Width of the paper in millimeters (estimated)
- Length of the paper in millimeters (estimated)
- Color calibration status
- Paper advance calibration status

If no paper is loaded, the message **Out of paper** is displayed.

The same information is displayed in the HP Utility for Windows (Overview tab > Supplies Status tab), the HP Utility for Mac OS (Information group > Printer Status > Supplies Details) and the Embedded Web Server (upper-right corner).

**NOTE:** Photo and coated paper requires careful handling, see The print is scuffed or scratched on page 154.
Paper presets

Each supported paper type has its own characteristics. For optimum print-quality, the printer changes the way it prints on each different paper type. For example, some may need more ink and some may require a longer drying time. So the printer must be given a description of the requirements of each paper type. This description is called the “paper” preset. The paper preset contains the ICC profile, which describes the color characteristics of the paper; it also contains information on other characteristics and requirements of the paper that are not directly related to color. Existing paper presets for your printer are already installed in the printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer only contains paper presets for the most commonly used paper types. If you have a paper type for which your printer has no preset, you cannot select that paper type in the front-panel display.

There are two ways to assign a preset for a new paper type.

- Use an HP factory paper preset by selecting the closest category and type in the front panel or the HP Utility, see The paper type is not in the driver on page 137.
  
  **NOTE:** Colors may not be accurate. This method is not recommended for high-quality prints.


  **NOTE:** HP provides presets for HP paper types only. If you do not find the paper preset you want on the Web, you may find that it has been added to the latest firmware for your printer. You can check the firmware release notes for information, see Update the firmware on page 125.

Printing paper info

Enable the **Printing paper info** option to record the printer’s estimate of the remaining roll length, paper width and type. The information is a combination of barcode and text that is printed on the leading edge of the roll when the paper is unloaded from the printer.

![Barcode example]

**NOTE:** The paper-length estimate is available only if the printer registered the amount of paper that was on the roll when you loaded it. To provide this information to the printer, specify the roll length on the front panel when loading the paper, or load a roll that has the paper-data barcode printed on it.

**NOTE:** The barcode and text are printed on the roll only when the loading and unloading processes are started from the front panel's Paper menu.

**NOTE:** This option can be expected to work only with papers that are completely opaque. It may fail with transparent or translucent papers.

To enable the **Printing paper info** option, go to the front panel and select the Setup menu icon  then select **Printing preferences > Paper options > Enable printing paper info**.

**NOTE:** Enabling this option slightly changes the paper loading and unloading procedures.

Move the paper

If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel. You may want to do this in order to have more or less white space between the last print and the next one.
To move the paper, select the Paper menu icon and then **Move paper**.

**Move paper**

Press ▲ to rewind paper.
Press ▼ to advance paper.

Press ‹ to continue.

You can move the paper forwards by pressing the Up key on the front panel, or backwards by pressing the Down key. When the paper is positioned as you want it, press the OK key.

**Maintain paper**

To maintain paper quality, follow the recommendations below.

- Store rolls covered by another piece of paper or cloth
- Store cut sheets covered and clean or brush them before loading them in the printer
- Clean input and output platens
- Always keep the window of your printer closed

**NOTE:** Photo and coated paper requires careful handling, see *The print is scuffed or scratched* on page 154.

**Change the drying time**

You may wish to change the drying time setting to suit special printing conditions such as multiple prints where time is of higher importance or when you need to be sure ink is dry before handling.

Select the Setup menu icon then **Print retrieval > Select drying time**. You can select:

- Extended, to set a longer than recommended time to ensure ink is completely dry
- Optimal, to set the default and recommended time for your selected paper (this is the default setting)
- Reduced, to set a shorter than recommended time when quality is of lower importance
- None, to disable the drying time and remove your print as soon as it finishes printing

**CAUTION:** If the ink is not dry when the print is removed it could leave ink in the output tray and marks on the print.

**NOTE:** If you cancel the drying time during a print, the printer may not feed and cut the paper right away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper and then performs the printhead maintenance. However, if the dry time is greater than zero, the printer does not cut the paper until after the printhead maintenance has completed, even if you press the **Form feed and cut key**.
Turn the automatic cutter on and off

To turn the printer's paper cutter on or off:

- From the HP Utility for Windows, select the **Settings** tab and change the **Cutter** option in **Printer Settings > Advanced**.
- From the HP Utility for Mac OS, select **Configuration > Printer Settings > Advanced** and change the **Cutter** option.
- From the Embedded Web Server, select the **Setup** tab, then **Printer Settings > Advanced**, and change the **Cutter** option.
- From the front panel, select the Setup menu icon 📖 then **Print retrieval > Enable cutter** and change the cutter option.

The default setting is **On**.

**NOTE:** If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper on loading, unloading and switching between rolls.

**TIP:** To cut roll paper while the automatic cutter is disabled, see Feed and cut the paper on page 45.

Feed and cut the paper

If you press the **Form feed and cut** key 📖 on the front panel, the printer advances the paper and makes a straight cut across the front edge. There are several possible reasons why you might want to do this.

- To trim the leading edge of the paper if it is damaged or not straight.
- To feed and cut the paper when the automatic cutter has been disabled.
- To cancel the waiting time and print the available pages immediately, if the printer is waiting to nest more pages (T1200 series only).

**NOTE:** The printheads are serviced after each print, and the paper cannot be cut until the process completes, so you may notice a delay.

**CAUTION:** Remove the cut piece from the output tray. If strips or short prints are left in the output tray the printer could jam.

**NOTE:** Photo and coated paper requires careful handling, see The print is scuffed or scratched on page 154.

**TIP:** To move the paper without cutting it, see Move the paper on page 43.
6 Working with two rolls (T1200 series only)

- The uses of a multiroll printer
- How the printer allocates jobs to paper rolls
The uses of a multiroll printer

A multiroll printer can be useful in several different ways:

- The printer can automatically switch between different paper types according to your needs.
- The printer can automatically switch between different paper widths according to your needs. This enables you to save paper by printing smaller images on narrower paper.
- If you load two identical rolls into the printer, you can leave it printing unattended for a long time, because it can switch from one roll to the other automatically when the first is exhausted. See Unattended printing/overnight printing (T1200 series only) on page 63.

There are two concepts to help you when working with multiple rolls.

- The active roll is the roll that is currently loaded and will be printed on by default unless the printer has some reason to switch rolls. To change the active roll, select the Paper menu icon, then Select active roll.
- A protected roll is protected from use unless the roll number or its paper type are specifically requested. See Roll protection (T1200 series only) on page 62.

The current status of both rolls is shown on the front panel's status screen.

Ready

- Out of paper
- HP Coated Paper

http://XXXXX11
http://192.168.1.1

How the printer allocates jobs to paper rolls

When you submit a print job from the Embedded Web Server or the printer driver, you can specify (using the Paper type or Type is option) that you want it to be printed on a particular paper type; you can even specify (using the Paper source, Source is or Paper Feed option) that you want it to be printed on a particular roll (1 or 2). The printer will try to satisfy these requirements, and it will also look for a paper roll large enough to print the image without clipping.

- If both rolls are suitable for the job, the roll will be chosen according to the roll switching policy. See Roll switching options on page 21.
- If just one of the rolls is suitable for the job, it will be printed on that roll.
- If neither roll is suitable for the job, it will be held in the job queue with the status “On hold for paper”, or printed on an unsuitable roll, depending on the paper mismatch action. See Paper mismatch action on page 21.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the printer, and on which rolls.
Here are some settings that might be used in typical situations:

- With different paper types loaded:
  - **Type is**: select the paper type you require
  - **Source is**: Automatically select / Predetermined
  - **Roll switching policy**: doesn't matter

- With different paper widths loaded:
  - **Type is**: Any
  - **Source is**: Automatically select / Predetermined
  - **Roll switching policy**: Minimize paper waste

**TIP:** You can also save paper in some cases by rotating or nesting your images. See Use paper economically on page 60.

- With identical rolls loaded:
  - **Type is**: Any
  - **Source is**: Automatically select / Predetermined
  - **Roll switching policy**: Minimize roll changes
● Create a print job
● Select print quality
● Select paper size
● Select margins options
● Print with shortcuts
● Print on loaded paper
● Rescale a print
● Change the treatment of overlapping lines
● Preview a print
● Print a draft
● High-quality printing
● Print in gray shades
● Print with no margins (T1200 series only)
● Print with crop lines (T1200 series only)
● Reprint last printed job
● Use paper economically
● Nest jobs to save roll paper (T1200 series only)
● Use ink economically
● Roll protection (T1200 series only)
● Unattended printing/overnight printing (T1200 series only)
Create a print job

In order to print something, you must send it to the printer. This constitutes a print job, which is entered into the printer's print queue. There are two main ways of sending a print job to the printer:

- To print directly from a program, use the program's Print command as usual. When you select your printer, the printer driver is invoked to send your job to the printer.
- If you have a file that is already in a supported graphical format, you can use the Embedded Web Server to send it directly to the printer without going through a printer driver (see below).

Using the Embedded Web Server to print files (T1200 series only)

From the HP Utility, select Job Center > Submit Job. From the Embedded Web Server, select the Main tab and then Submit job. You will see the window below.

Press the Add files button to choose the files from your computer that you want to print. The files must be in one of the following formats:

- PDF (T1200 PS only)
- PostScript (T1200 PS only)
- TIFF (T1200 PS only)
- JPEG (T1200 PS only)
- HP-GL/2
- RTL

**NOTE:** When you print to a file, the file should be in one of the above formats, but its name may have an extension such as .plt or .prn.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and number of copies), you can just press the Print button and they will be sent to the printer.

If you need to specify printing settings, go to the Job settings section and select the options you need. Each option has explanatory text on the right, so that you can understand the behavior of each setting. Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job contains no setting, the setting in the printer will be used.
Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed, while fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and speed. With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you can also select Economode, which uses a lower rendering resolution and consumes less ink. It therefore increases printing speed even further, but reduces print quality. Economode can be selected only from the custom options (not from the slider).

There is also a supplementary custom option that may have an effect on print quality: Maximum detail. See High-quality printing on page 57.

NOTE: In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom Print Quality Options dialog box (select Custom options and then Settings). In the Mac OS Print dialog, it is displayed in the Summary panel.

You can select print-quality options in the following ways:

- In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. If you select Standard Options, you will see a simple slider with which you can select speed or quality. If you select Custom Options, you will see the more specific options described above.

- In the Mac OS Print dialog (T770, T1200): go to the Paper/Quality panel and look at the Quality Options section. If you select Standard quality options, you will see a simple slider with which you can select speed or quality. If you select Custom quality options, you will see the more specific options described above.

- In the Mac OS X 10.5 or 10.6 PostScript Print dialog (PostScript printers): go to the Paper/Quality panel and look at the Quality Options section. If you select Standard quality options, you will see a simple slider with which you can select speed or quality. If you select Custom quality options, you will see the more specific options described above.

- In the Mac OS X 10.4 PostScript Print dialog (PostScript printers): go to the Image Quality panel. If you select Standard quality options, you will see a simple slider with which you can select speed or quality. If you select Custom quality options, you will see the more specific options described above.

- On the Embedded Web Server’s Submit Job page (T1200 series): select Basic settings > Print quality. If you then select Standard options, you can choose between Speed and Quality. If you select Custom options, you will see the more specific options described above.

- Using the front panel: select the Setup menu icon, then Printing preferences > Print quality.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has already received (even if they have not started to print yet).

Select paper size

The paper size can be specified in the following ways.
NOTE: The paper size specified here should be the paper size in which the document was created. It is possible to rescale the document to a different size for printing. See Rescale a print on page 55.

- In the Windows driver dialog: select the Paper/Quality tab, then select your paper size from the Document Size list.
- In the Mac OS Page Setup dialog: select your printer from the Format for list, then select your paper size from the Paper Size list.

NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

- Using the front panel: select the Setup menu icon, then Printing preferences > Paper options > Select paper size.

NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front panel.

Custom paper sizes

To choose a non-standard paper size not shown in the list of paper sizes:

- Under Windows, there are two different ways:
  - In the driver dialog, click the Custom button in the Paper/Quality tab, then specify the name and the dimensions of your new paper size, then click Save to save your new paper size. To see your new custom size in the list of custom sizes, you need to exit the printer properties, then reenter them (and use the More button if necessary).

  NOTE: The driver will not allow you to create a paper size whose width exceeds its length.
  - From the Start menu, select Printers and Faxes, then from the File menu select Server Properties. In the Forms tab, check the Create a new form box, specify the name and dimensions of the new form, then click Save Form.


  NOTE: If your application offers no Page Setup dialog, please use the Print dialog.


Select margins options

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the paper (increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in several ways.

- In the Windows driver dialog: select the Paper/Quality tab and then the Margins/Layout button.
- In the Mac OS Print dialog (T770, T1200): select the Margins/Layout panel.
- In the Mac OS X 10.5 or 10.6 PostScript Print dialog (PostScript printers): select the Margins/Layout panel.
In the Mac OS X 10.4 PostScript Print dialog (PostScript printers): select the **Finishing** panel and then **Layout**.

On the Embedded Web Server’s Submit Job page (T1200 series): select **Advanced settings > Paper > Layout/Margins**.

You will then see at least some of the following options.

**NOTE:** Under Mac OS, the available margins options depend on the paper size selected. For instance, for borderless printing you must select a paper size name that includes the words "no margins".

- **Standard.** Your image will be printed on a page of the size you have selected, with a narrow margin between the edges of the image and the edges of the paper. The image should be small enough to fit between the margins.

- **Oversize.** Your image will be printed on a page slightly larger than the size you have selected. If you cut off the margins, you will be left with a page of the size you selected, with no margins remaining between your image and the edges of the paper.

- **Clip Contents By Margins.** Your image will be printed on a page of the size you have selected, with a narrow margin between the edges of the image and the edges of the paper. In this case, if the image is the same size as the page, the printer assumes that the extreme edges of the image are either white or unimportant, and do not need to be printed. This may be useful when your image already contains a border.

- **Borderless.** Your image will be printed on a page of the size you have selected, with no margins. The image is slightly enlarged to ensure that no margin is left between the edges of the image and the edges of the paper. If you select **Automatically by Printer**, this enlargement is done automatically. If you select **Manually in Application**, you must select a custom page size slightly larger than the page on which you intend to print. See also **Print with no margins (T1200 series only)** on page 58.

## Print with shortcuts

The printer driver provides many options that can be set to different values when printing a particular job. A printing shortcut stores the values of all these options that are appropriate for a particular kind of job, so that you can set them all with a single click. Some settings (such as paper size, paper source and orientation) may be overridden by the values provided by your application.

To use a shortcut, select the **Printing Shortcuts** tab in the Windows driver dialog.

**NOTE:** Shortcuts are available only under Windows.
You can see a list of available shortcuts; select the one that matches the kind of job you want to print.

The driver options are now adjusted to suit your job. You can either print immediately, or examine the settings to check that you agree with them. If you like, you can select a shortcut and then change some of its settings manually.

**TIP:** Check at least the settings that you can see in the **Printing Shortcuts** tab: the document size, orientation, etc.

The Factory Defaults shortcut contains the printer's default settings. When you click on it, it sets all options to their default values.

Printing shortcuts can be customized to your particular needs. To create your own shortcut:

1. Select the shortcut that comes closest to satisfying your requirements.
2. Change any value in the **Printing Shortcuts** tab and/or other tabs.
3. Save the new printing shortcut.

If you decide later that you no longer want a shortcut, you can delete it.

---

### Print on loaded paper

To print a job on whichever paper is loaded in the printer, select **Any** in the Paper Type option of your printer driver.

- **In the Windows driver dialog:** select the Paper/Quality tab, then select **Any** in the Paper Type drop-down list.
- **In the Mac OS Print dialog (T770, T1200):** select the Paper/Quality panel, then select **Any** in the Paper Type drop-down list.
- **In the Mac OS X 10.5 or 10.6 PostScript Print dialog (PostScript printers):** select the Paper/Quality panel, then select **Any** in the Paper Type drop-down list.
- **In the Mac OS X 10.4 PostScript Print dialog (PostScript printers):** select the Image Quality panel, then select **Any** in the Paper Type drop-down list.

**NOTE:** **Any** is the default Paper Type selection.
Rescale a print

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally larger). This may be useful:

- If your software does not support large formats
- If your file is too large for the printer's memory—in this case, you can reduce the paper size in your software and then scale it up again using the front-panel option

You can rescale an image in the following ways:

- **In the Windows driver dialog**: go to the Features tab and look at the Resizing Options section.
  - The Print document on option adjusts the image size to the paper size you have selected. For example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.
  - The % of actual size option enlarges the printable area of the original paper size (the page minus the margins) by the percentage indicated, then adds the margins to create the output paper size.

- **In the Mac OS Print dialog (T770, T1200)**: select the Paper Handling panel, then Scale to fit paper size, and select the paper size to which you want to scale the image. If you want to increase the size of the image, make sure that the Scale down only box is unchecked.

- **In the Mac OS Print dialog (PostScript printers)**: select the Finishing panel, then Print document on, and select the paper size to which you want to scale the image. For example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.

- **On the Embedded Web Server’s Submit Job page (T1200 series)**: select Advanced settings > Resizing.
  - The Standard and Custom options adjust the image size to the standard or custom paper size you have selected. For example, if you have selected ISO A2 as the paper size and you print an A4-size image, it is enlarged to fit the A2 paper. If the ISO A3 paper size is selected, the printer reduces a larger image to fit the A3 size.
  - The % of actual size option enlarges the printable area of the original paper size (the page minus the margins) by the percentage indicated, then adds the margins to create the output paper size.

- **Using the front panel**: select the Setup menu icon, then Printing preferences > Paper options > Resize.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise the image will be clipped.

Change the treatment of overlapping lines

**NOTE:** This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:

- Off: where the lines cross, only the color of the top line is printed. This is the default setting.
- On: where the lines cross, the colors of the two lines merge.
To turn merge on, go to the front panel and select the Setup menu icon, then Printing preferences > HP-GL/2 options > Enable merge. You can set the merge option from your software in some applications. Settings in your software override the front-panel settings.

**Preview a print**

Previewing a print on the screen allows you to check the layout of the print before printing, which may help you to avoid wasting paper and ink on a bad print.

- To preview a print under Windows, you have the following options:
  - Use your application's print preview option.
  - Check the Show preview before printing option, which you can find in the driver's Printing Shortcuts tab, Paper/Quality tab and Features tab. The preview may be provided in different ways, depending on your printer and printer driver.
- To preview a print under Mac OS, you have the following options:
  - Use your application's print preview option.
  - Click the Preview button at the bottom of the Print dialog box. This is the basic print preview provided by Mac OS.
  - If you are using the PostScript driver for the T1200 PS printer, check the Show print preview option, which you can find in the driver's Printing dialog, in the Finishing panel. This preview is provided by the Embedded Web Server and will appear in a Web browser window.
  - If you are using the PCL driver, click the PDF button at the bottom of the Print dialog box, then click HP Print Preview. This provides a preview with more features, such as the ability to change paper size, paper type and print quality, and to rotate the image.

**NOTE:** HP Print Preview may not be available if you are using Adobe InDesign, Adobe Illustrator, Adobe Reader or Apple Aperture. It is available with Adobe InDesign CS4 and Adobe Illustrator CS4.

- To preview a print using the Embedded Web Server, select Basic settings > Hold for preview. This preview is available from the T770 HD printer and the T1200 printer series.

**Print a draft**

You can specify fast draft-quality printing in the following ways:

- **In the Windows driver dialog:** go to the Paper/Quality tab and look at the Print Quality section. Move the print-quality slider to the extreme left (‘Speed’).
- **In the Mac OS Print dialog (T770, T1200):** go to the Paper/Quality panel and move the print-quality slider to the extreme left (‘Speed’).
- **In the Mac OS X 10.5 or 10.6 PostScript Print dialog (PostScript printers):** go to the Paper/Quality panel and move the print-quality slider to the extreme left (‘Speed’).
- **In the Mac OS X 10.4 PostScript Print dialog (PostScript printers):** go to the Image Quality panel and move the print-quality slider to the extreme left (‘Speed’).
On the Embedded Web Server’s Submit Job page (T1200 series): select Basic settings > Print quality > Standard options > Speed.

Using the front panel: select the Setup menu icon , then Printing preferences > Print quality > Select quality level > Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for documents containing only text and line drawings.

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Select Custom Options, then set the quality level to Fast and check the Economode box.

In the Mac OS Print dialog (T770, T1200): go to the Paper/Quality panel and set the quality options to Custom, then set quality to Fast and check the Economode box.

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (PostScript printers): go to the Paper/Quality panel and set the quality options to Custom, then set quality to Fast and check the Economode box.

In the Mac OS X 10.4 PostScript Print dialog (PostScript printers): go to the Image Quality panel and set the quality options to Custom, then set quality to Fast and check the Economode box.

On the Embedded Web Server’s Submit Job page (T1200 series): select Basic settings > Print quality > Custom. Set Quality level to Fast, and Economode to On.

Using the front panel: select the Setup menu icon , then Printing preferences > Print quality > Enable economode.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

High-quality printing

You can specify high-quality printing in the following ways:

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Move the print-quality slider to the extreme right (‘Quality’).

In the Mac OS Print dialog (T770, T1200): go to the Paper/Quality panel and move the print-quality slider to the extreme right (‘Quality’).

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (PostScript printers): go to the Paper/Quality panel and move the print-quality slider to the extreme right (‘Quality’).

In the Mac OS X 10.4 PostScript Print dialog (PostScript printers): go to the Image Quality panel and move the print-quality slider to the extreme right (‘Quality’).


Using the front panel: select the Setup menu icon , then Printing preferences > Print quality > Select quality level > Best.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.
If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print Quality Options box under Windows), print sharpness may be improved by selecting the Maximum Detail option. This option is available only if you are printing on glossy paper and you have selected Best print quality.

- In the driver dialog (Mac OS Print dialog): select Custom instead of Standard print-quality options, then check the Maximum Detail box.
- Using the front panel: select the Setup menu icon then Printing preferences > Print quality > Enable maximum detail.

NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not increase the amount of ink used.

Print in gray shades

You can convert all colors in your image to shades of gray in the following ways:

- In your application program: many programs provide this option.
- In the Windows driver dialog: go to the Color tab and look at the Color Options section. Select Print in Grayscale. You can also select Print in pure black and white if you want only black and white, without gray shades.
- In the Mac OS Print dialog (T770, T1200): go to the Color Options panel and select Grayscale from the Mode drop-down list. You can also select Pure Black and White if you want only black and white, without gray shades.
- In the Mac OS X 10.5 or 10.6 PostScript Print dialog (PostScript printers): go to the Color Options panel and select Grayscale from the Mode drop-down list. You can also select Pure Black and White if you want only black and white, without gray shades.
- In the Mac OS X 10.4 PostScript Print dialog (PostScript printers): go to the Color Options panel and select Print In Grayscale. You can also select Print in Pure Black and White if you want only black and white, without gray shades.
- On the Embedded Web Server's Submit Job page (T1200 series): select Color, then set Color/Grayscale to Print In Grayscale. You can also select Pure Black and White if you want only black and white, without gray shades.

Print with no margins (T1200 series only)

Printing with no margins (to the edges of the paper) is known as borderless printing. This can be done only on rolls of glossy paper.

In order to be sure of leaving no margins, the printer prints slightly past the edges of the paper. Any ink deposited outside the paper is absorbed by the sponge situated in the platen.
You can request printing with no margins in the following ways:

- **In the Windows driver dialog**: select the Paper/Quality tab and press the Margins/Layout button. Then select Borderless.

- **In the Mac OS Page Setup dialog (T1200)**: select a paper size name that includes the words “no margins”. Then, in the Print dialog, select Margins/Layout > Borderless.

  **NOTE:** If your application offers no Page Setup dialog, please use the Print dialog.

- **In the Mac OS X 10.5 or 10.6 PostScript Page Setup dialog (T1200 PS)**: select a paper size name that includes the words “no margins”. Then, in the Print dialog, select Margins/Layout > Borderless.

  **NOTE:** If your application offers no Page Setup dialog, please use the Print dialog.

- **In the Mac OS X 10.4 PostScript Page Setup dialog (T1200 PS)**: select a paper size name that includes the words “no margins”. Then, in the Print dialog, select Finishing > Layout > Borderless.

  **NOTE:** If your application offers no Page Setup dialog, please use the Print dialog.

- **On the Embedded Web Server’s Submit Job page**: select Advanced settings > Paper > Layout/Margins > Borderless.

When you select Borderless, you must also select one of the following Image Enlargement options:

- **Automatically by printer** means that the printer automatically enlarges your image slightly (normally by a few millimeters in each direction) in order to print over the edges of the paper.

- **Manually in application** means that you must enlarge the image yourself in your application, and select a custom paper size that is slightly larger than the actual paper size.

  **NOTE:** If the first print job after loading paper is a borderless job, the printer may trim the leading edge of the paper before printing.

At the end of a borderless print, the printer normally cuts the print slightly inside the image area to ensure that the print is borderless. It then cuts the paper again so that no residual part of the image is included in the next print. However, if the job is cancelled, or if there is white space at the bottom of the image, only a single cut is made.

---

**Print with crop lines (T1200 series only)**

Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print crop lines with individual jobs in the following ways:

- **In the Windows driver dialog**: select the Features tab, then Crop lines.

- **In the Mac OS Print dialog**: select the Finishing panel, then Crop lines.

- **On the Embedded Web Server’s Submit Job page**: select Advanced settings > Roll options > Enable crop lines > Yes.

Alternatively, you can choose to print crop lines with all jobs by default:

- **In the Embedded Web Server**: select Setup > Printer settings > Job management > Use crop lines when printing > On.

- **Using the front panel**: select the Setup menu icon then Printing preferences > Paper > Enable crop lines > On.
To print crop lines with nested jobs (see Nest jobs to save roll paper (T1200 series only) on page 60), you must select a different option:

- **In the Embedded Web Server:** select Setup > Printer settings > Job management > Use crop lines when nest is enabled > On.

- **Using the front panel:** select the Setup menu icon , then Job management > Nest options > Enable crop lines > On.

## Reprint last printed job

You can reprint the last job printed from the front panel. Select the Job management menu icon , then Reprint last job.

**NOTE:** You cannot use this method for PCL3 jobs. To reprint old jobs that are PCL3, you may be able to use your operating system's printer spooler, if you have already set the spooler to save old jobs. This facility depends on your operating system.

## Use paper economically

Here are some recommendations for making economical use of paper:

- If you are printing relatively small images or document pages, you can use nesting to print them side by side instead of one after another. See Nest jobs to save roll paper (T1200 series only) on page 60.

- You may be able to save some roll paper by using the following options:
  - **In the Windows driver dialog:** select the Features tab and then Remove top/bottom blank areas and/or Rotate by 90 degrees.
  - **In the Mac OS Print dialog (T770, T1200):** select the Finishing panel, then Remove Top/Bottom Blank Areas.
  - **In the Mac OS PostScript Print dialog (PostScript printers):** select the Finishing panel, then Remove Top/Bottom Blank Areas and/or Rotate by 90 degrees.
  - **On the Embedded Web Server's Submit Job page (T1200 series):** select Advanced settings > Roll options > Remove top/bottom blank areas and/or Rotate.

- If you check the print preview on your computer before printing, you can sometimes avoid wasting paper on prints containing obvious mistakes. See Preview a print on page 56.

## Nest jobs to save roll paper (T1200 series only)

Nesting means automatically printing images or document pages side by side on the paper, rather than one after the other. This is done to avoid wasting paper.
1. Direction of paper flow
2. Nesting off
3. Nesting on
4. Paper saved by nesting

**When does the printer try to nest pages?**

When both of the following are true:

- The printer is loaded with roll paper, not sheet paper.
- The printer's Nest option is not turned off. See Turn nesting on and off (T1200 series only) on page 22.

**What pages can be nested?**

All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or unless there are too many of them to fit into the remaining length of the roll. A single group of nested pages cannot be split between two rolls.

**Which pages qualify for nesting?**

In order to be in the same nest, the individual pages must be compatible in all of the following ways:

- All pages must have the same print quality setting (**Economode**, **Fast**, **Normal** or **Best**).
- The **Maximum Detail** setting must be the same on all pages.
- The **Layout/Margins** setting must be the same for all pages.
- The **Mirror Image** setting must be the same for all pages.
- The **Rendering Intent** must be the same for all pages.
- The **Cutter** setting must be the same for all pages.
- The color adjustment settings must be the same for all pages. See Color adjustment options on page 69.
- Pages must be all color, or all grayscale: not some in color and some in grayscale.
All pages must be in one or other of the following two groups (the two groups cannot be mixed in the same nest):

- HP-GL/2, RTL
- PostScript, PDF, TIFF, JPEG

JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some cases.

How long does the printer wait for another file?

So that the printer can make the best nest possible, it waits after a file has been received to check whether a subsequent page will nest with it or with pages already in the queue. This waiting period is the nest wait time; the factory default nest wait time is two minutes. This means that the printer waits for up to two minutes after the last file is received before printing the final nest. You can change this waiting time from the printer's front panel: select the Setup menu icon then Job management options > Nest options > Select wait time. The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel. You can print the nest (cancel the nest wait) by pressing the Form feed and cut key.

Use ink economically

Here are some recommendations for making economical use of ink.

- For draft prints, use plain paper and move the print-quality slider to the left end of the scale (‘Speed’). For further economy, select custom print quality options, then select Fast and Economode.

- Clean the printheads only when needed, and clean only those printheads that need cleaning. Cleaning the printheads can be useful, but it uses a small amount of ink.

- Leave the printer permanently turned on so that it can maintain the printheads in good condition automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not done, the printer may need to use much more ink later to restore the health of the printheads.

- Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some ink, and its frequency is related to the number of passes made by the printheads. Therefore, nesting jobs can save ink as well as saving paper (see Nest jobs to save roll paper (T1200 series only) on page 60).

Roll protection (T1200 series only)

If you choose to protect a roll, jobs will be printed on it only if the job explicitly specifies the roll number or the paper type loaded on the roll. This may be useful, for example, in the following cases.

- To stop people from accidentally printing unimportant jobs on expensive paper.

- To avoid printing on a particular roll when printing from AutoCAD without interacting with the HP printer driver.

To protect a roll, go to the front panel and select the Setup menu icon then Printing preferences > Paper options > Roll protection.
NOTE: If you protect a roll, then later unload the current roll and load a new one, the new roll remains protected. You are protecting the roll number, not one specific roll of paper. That roll number will remain protected until you cancel the protection.

TIP: If you print without specifying a roll number or paper type, you will not be able to print on any protected roll.

Unattended printing/overnight printing (T1200 series only)

The HP Designjet T1200 printer series, with multiple rolls, plus robust and consistent image quality, is perfect for long unattended printing jobs.

Here are some recommendations to help you deal with a long queue of printing jobs.

- If feasible, use brand-new long rolls of paper.
- If you want to print on partly-used rolls, you can check the paper type and the remaining length in the Embedded Web Server or in the front panel, to confirm that you have enough paper to print all your jobs.

NOTE: Information on the remaining length is available only if you told the printer the length of the roll when you loaded it, or if the printer read the length of the roll from the barcode printed on it.

- Load two rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically switch to the other.
- Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may be put “on hold for paper” if the paper mismatch action is set to Put job on hold (see Paper mismatch action on page 21).
- Check the ink levels remaining in your ink cartridges.
- When you have submitted your print jobs, you can use the Embedded Web Server from a remote location to monitor their status.
- Drying time should be set to Optimal.
- Select the Setup menu icon, then Printing preferences > Paper options > Roll switching options > Minimize roll changes or Use roll with less paper.

We recommend the following settings, depending on the paper type and what kind of prints you are making.

Table 7-1 Recommended settings for unattended printing

<table>
<thead>
<tr>
<th>Print type</th>
<th>Print mode</th>
<th>MaxDetail</th>
<th>Optimized for</th>
<th>Drying time</th>
<th>Paper types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines</td>
<td>Normal</td>
<td>Off</td>
<td>Lines</td>
<td>Optimal</td>
<td>Coated, Bond, Heavyweight</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Coated, Glossy</td>
</tr>
<tr>
<td>Lines and fills</td>
<td>Normal</td>
<td>On</td>
<td>Lines</td>
<td>Optimal</td>
<td>Coated, Bond, Heavyweight</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Coated, Glossy</td>
</tr>
<tr>
<td>Print type</td>
<td>Print mode</td>
<td>MaxDetail</td>
<td>Optimized for</td>
<td>Drying time</td>
<td>Paper types</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Maps</td>
<td>Best</td>
<td>On</td>
<td>Images</td>
<td>Optimal</td>
<td>Coated, Heavyweight Coated, Glossy</td>
</tr>
<tr>
<td>Renderings, photographs</td>
<td>Best</td>
<td>On</td>
<td>Images</td>
<td>Optimal</td>
<td>Coated, Heavyweight Coated, Glossy</td>
</tr>
</tbody>
</table>
8 Color management

- Introduction
- How colors are represented
- A summary of the color management process
- Color calibration
- Color management from printer drivers
- Color management from printer drivers (PostScript printers)
- Color management from the Embedded Web Server (T1200 series only)
- Color management from the front panel
Introduction

Your printer has been engineered with advanced hardware and software features to ensure predictable and dependable results.

- Color calibration for consistent colors.
- One gray and two black inks provide neutral grays on all paper types.
- The Photo Black ink provides pure blacks when printing on photo papers.
- Color emulation of other HP Designjet printers.

How colors are represented

All devices that display color use a color model to represent color in numerical terms. Most monitors use the RGB (Red-Green-Blue) color model, while most printers use the CMYK (Cyan-Magenta-Yellow-Black) color model.

An image can be converted from one color model to another, but in general the conversion is not perfect. Your printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents colors a little differently from another device, even if they use the same color model. However, software can adjust the colors in an image according to the characteristics of the particular device, using a color profile of the device, in order to achieve correct colors.

A summary of the color management process

To get the accurate and consistent colors that you want, you should follow these steps for each paper type that you use.

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and then (see Color calibration on page 66). In addition, you may wish to calibrate immediately before a particularly important print job for which color consistency is vital.

2. When printing, select the correct color preset for the paper type you are using.

Color calibration

Color calibration enables your printer to produce consistent colors with the particular printheads, inks and paper type that you are using, and under your particular environmental conditions. After color calibration, you can expect to get similar prints from any two different printers situated in different geographical locations.

Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of the following circumstances:

- Whenever a printhead is replaced
- Whenever a new paper type is introduced that has not yet been calibrated with the current set of printheads
- Whenever the environmental conditions (temperature and humidity) change significantly
You can check the color calibration status of the currently loaded paper at any time by pressing the View information key on the front panel. The status may be one of the following:

- **PENDING:** the paper has not been calibrated.

  **NOTE:** Whenever you update the printer’s firmware, the color calibration status of all papers is reset to **PENDING**.

- **OBSOLETE:** the paper has been calibrated, but the calibration is now out of date because a printhead has been replaced, and should be repeated.

- **DONE:** the paper has been calibrated, and the calibration is up to date.

- **DISABLED:** this paper cannot be calibrated.

  **NOTE:** Color calibration cannot be performed on plain paper, nor on any kind of transparent material.

You can also check the color calibration status by using the HP Utility.

You can start color calibration in the following ways:

- From the HP Utility for Windows: select **Color Center > Calibrate paper**, and choose the paper to be calibrated.

- From the HP Utility for Mac OS: select **Paper Preset Management** from the HP Color Center group, choose the paper to be calibrated, press the **button** and select **Calibrate Paper**.

- From the front panel: select the Image Quality Maintenance menu icon then **Calibrate color**.

The calibration process is fully automatic and can be performed unattended after you have loaded paper of the type you wish to calibrate—which should be A4 or any larger size. The paper on the active roll will be calibrated; you should ensure that the roll you want to calibrate is active. To change the active roll, select the Paper menu icon then **Select active roll**.

The process takes about 3–5 minutes and consists of the following steps.

1. A calibration chart is printed, which contains patches of each ink used in your printer.

2. The chart is allowed to dry for a period of time that depends on the paper type, so that the colors have time to stabilize.

3. The chart is scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for consistent color printing on that paper type. It also calculates the maximum amount of each ink that can be applied to the paper.
Color management from printer drivers

Color management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when you print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:

- **Application-Managed Colors**: in this case your application program must convert the colors of your image to the color space of your printer and paper type, using the ICC profile embedded in the image and the ICC profile of your printer and paper type.

- **Printer-Managed Colors**: in this case your application program sends your image to the printer without any color conversion, and the printer converts the colors to its own color space. The details of this process depend on the graphics language that you are using.
  
  - **PostScript (PostScript printers)**: the PostScript interpreter module inside the printer performs the color conversion using the profiles stored in the printer and any additional profiles sent with the PostScript job. This kind of color management is done when you are using the PostScript driver and you specify printer color management or when you send a PostScript, PDF, TIFF or JPEG file directly to the printer through the Embedded Web Server. In either case you have to select the profiles to use as default (in case the job doesn’t specify any) and the rendering intent to apply.

  - **Non-PostScript (PCL, RTL, HP-GL/2)**: the color management is done using a set of stored color tables. ICC profiles are not used. This method is somewhat less versatile than the alternatives, but is a little simpler and faster, and can produce good results with standard HP paper types. This kind of color management is done when you are using a non-PostScript driver and you specify printer color management, or when you send a PCL, RTL or HP-GL/2 file directly to the printer through the Embedded Web Server.

  **NOTE:** There are only two color spaces that the printer can convert to its own color space using the stored color tables: Adobe RGB and sRGB if you are using Windows, Adobe RGB and ColorSync if you are using Mac OS.

  ColorSync is the Mac OS built-in Color Management System; so, when you select ColorSync, color management is performed by Mac OS, and it is done based on the ICC profiles of the specified paper type. ColorSync is available with the PCL3 driver only.

  ColorSync can be selected under Mac OS X 10.4 from the **Color Options** panel: select **Use Embedded (ICC/ColorSync)** from the **Source Profile** drop-down list. Under Mac OS X 10.5 and 10.6, ColorSync can be selected from the **Color Matching** panel.

You are recommended to consult the Knowledge Center (see Knowledge Center on page 180) to see how to use the color management options of your particular application.

To choose between **Application-Managed Colors** and **Printer-Managed Colors**:

- **In the Windows driver dialog**: select the **Color** tab.

- **In the Mac OS Print dialog**: select the **Color Options** panel.

- **In some applications**: you can make this choice in the application.

**Printer emulation**

If you want to print a particular job and to see approximately the same colors that you would get from printing the same job on a different HP Designjet printer, you can use the emulation mode provided by your printer.
NOTE: This option is available only when printing an HP-GL/2, PostScript or PDF job. It will work correctly only when printing on plain, coated or heavyweight coated paper.

- In the Windows HP-GL/2 or PostScript driver dialog: select the Color tab, then Printer Managed Colors, then select Printer Emulation from the Source Profile list. You can then select from the Emulated Printer list.

- In the Mac OS Print dialog (T770, T1200): select the Color Options panel, then Color Management > Printer, then select Printer Emulation from the Source Profile list.

- In the Mac OS Print dialog (PostScript printers): select the Color Options panel, then select from the Printer Emulation list.

**Color adjustment options**

The aim of color management is to print accurate colors. If you perform color management correctly, then you should be able to print accurate colors with no need of any manual color adjustments.

However, manual adjustments may be useful in the following situations:

- If your color management is not working correctly for some reason
- If you want colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color or in grayscale. If you are printing in pure black and white, there are no color adjustment options.

**Printing in color**

You can adjust the colors of your print in similar ways under Windows and Mac OS:

- In the Windows driver dialog: select the Color tab, ensure that the Advanced color adjustments box is checked, then press the Settings button beside it.

- In the Mac OS Print dialog (T770, T1200): select the Color Options panel, select Color from the Mode list, then press the Adjust button.

- In the Mac OS X 10.5 or 10.6 PostScript Print dialog (PostScript printers): select the Color Options panel, select Color from the Mode list, then press the Adjust button.

- In the Mac OS X 10.4 PostScript Print dialog (PostScript printers): select the Color Options panel, then Lightness and Hue.

Under either operating system, you will then be able to make adjustments using a lightness slider and three color sliders.
● The lightness slider simply makes the whole print lighter or darker.

● The color sliders can be used to fade or emphasize each of the primary colors in the print. The primary colors may be red, green and blue; or cyan, magenta and yellow; depending on the color model used in the image.

The Reset button restores each slider to its default central position.

Printing in grayscale

You can adjust the gray balance of your print in similar ways under Windows and Mac OS:

● In the Windows driver dialog: select the Color tab, ensure that the Advanced color adjustments box is checked, then press the Settings button beside it.

● In the Mac OS Print dialog (T770, T1200): select the Color Options panel, select Grayscale from the Mode list, then press the Adjust button.

● In the Mac OS X 10.5 and 10.6 PostScript Print dialog (PostScript printers): select the Color Options panel, select Grayscale from the Mode list, then press the Adjust button.

● In the Mac OS X 10.4 PostScript Print dialog (PostScript printers): select the Color Options panel, then Print in Grayscale, then the Gray balance tab.

Under either operating system, you will then be able to make adjustments using separate controls for highlights, midtones and shadows.
The lightness slider simply makes the whole print lighter or darker. This slider is available in the same window as the other grayscale controls, except under Mac OS X 10.4, where it is available by selecting **Lightness and Hue**.

The zone definition sliders can be used to define what you mean by highlight, midtone and shadow.

The other controls for highlight, midtone and shadow can be used to adjust the gray balance of highlights, midtones and shadows respectively.

The **Reset** button restores each control to its default setting.

---

**Color management from printer drivers (PostScript printers)**

This facility is available when printing with the PostScript driver.

**HP Professional PANTONE Emulation**

When you use a named PANTONE color in an image, your application will normally send to the printer a CMYK or RGB approximation to that color. But the application does not take the printer or the paper type into account, it merely produces a generic approximation of the PANTONE color, which will look different on different printers and on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the characteristics of the printer and the paper type. The results look as similar to the original PANTONE colors as is possible on a given printer using a given paper type. This technology is designed to produce emulations similar to those set up manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally on by default.

- **In the Windows PostScript driver dialog**: go to the **Color** tab and select **HP Professional PANTONE Emulation**.
- **In the Mac OS Print dialog**: go to the **Color Options** panel and select **HP Professional PANTONE Emulation**.

You can also use the Embedded Web Server to print a swatch book showing emulations of PANTONE colors as made by your printer, together with a measure of the color difference ($\Delta E$) between each emulation and the original PANTONE spot color. So HP Professional PANTONE...
Emulation not only provides the closest match that can be achieved on your printer; it also gives clear information on how close the emulation is to the original spot color. See Printing PANTONE swatch books on page 74.

**Color emulation**

Your printer can emulate the color behavior of other devices: RGB devices such as monitors, and CMYK devices such as presses and printers.

You can set color emulation in the following ways:

- **In the Windows PostScript driver dialog:** select the **Color** tab, and **Printer Managed Colors**.
- **In the Mac OS Print dialog:** select the **Color Options** panel, then select **Printer** from the Color Management list.

For a good emulation, the printer needs a specification of the colors these devices can reproduce. The standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide the most common standards for the different devices.

The options are as follows.

**CMYK color emulation**

A traditional workflow defines color in the CMYK space. For best results, the colors must be adjusted to the printer, because different printers will produce different colors from the same CMYK data. If the image file you are printing was not created specifically for your printer, it will require some readjustment, which can be done using one of the following options provided with your printer.

- **None (Native):** no emulation. The printer will use its default internal conversion from CMYK to RGB, without following any color standard. This does not imply that results will be bad.
- **U.S. Web Coated (SWOP) 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 300% total area of ink coverage, negative plate, coated publication-grade stock.
- **U.S. Web Uncoated 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white offset stock.
- **U.S. Sheetfed Coated 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 350% total area of ink coverage, negative plate, bright white offset stock.
- **U.S. Sheetfed Uncoated 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white offset stock.
- **Europe ISO Coated FOGRA27** is designed to produce quality separations for standard ISO 12647 printing under the following printing conditions: 350% total ink coverage, positive film, coated paper.
- **Euroscale Uncoated 2** uses specifications designed to produce quality separations using Euroscale inks under the following printing conditions: 260% total area of ink coverage, positive plate, uncoated white offset stock.
- **Japan Web Coated (Ad)** uses specifications developed by the Japan Magazine Publisher Association for digital proofing of images in the Japanese magazine/advertising market.
- **Japan Color 2001 Coated** uses the Japan Color 2001 specification for type 3 (coated) paper. It is designed to produce quality separations using 350% total ink coverage, positive film and coated paper.
• **Japan Color 2001 Uncoated** uses the Japan Color 2001 specification for type 4 (uncoated) paper. It is designed to produce quality separations using 310% total ink coverage, positive film and uncoated paper.

• **Japan Color 2002 Newspaper** uses the Japan Color 2002 for Newspapers specification. It is designed to produce quality separations using 240% total ink coverage, positive film and standard newsprint paper.

• **JMPA**: Japanese standard for offset press.

• **Toyo** is designed to produce quality separations for Toyo printing presses.

• **DIC** is designed to produce quality separations for Dainippon Ink Company printing presses.

**NOTE:** These options have no effect if the application is defining its own CMYK space, known as calibrated CMYK or CIEXYZ in PostScript terminology.

### RGB color emulation

Your printer is provided with the following color profiles:

• **None (Native)**: no emulation, for use when the color conversion is done by the application or operating system, and therefore the data arrive at the printer already color-managed.

• **sRGB IEC61966-2.1** emulates the characteristics of the average PC monitor. This standard space is endorsed by many hardware and software manufacturers, and is becoming the default color space for many scanners, printers and software applications.

• **ColorMatch RGB** emulates the native color space of Radius Pressview monitors. This space provides a smaller gamut alternative to Adobe RGB (1998) for print production work.

• **Apple RGB** emulates the characteristics of the average Apple monitor, and is used by a variety of desktop publishing applications. Use this space for files that you plan to display on Apple monitors, or for working with old desktop publishing files.

• **Adobe RGB (1998)** provides a fairly large gamut of RGB colors. Use this space if you need to do print production work with a broad range of colors.

### Color management from the Embedded Web Server (T1200 series only)

#### Submit Job options

When you send jobs to the printer using the Embedded Web Server's **Submit Job** page, you have the following color management options.

If you leave an option set to **Default**, the setting saved in the job will be used. If the job contains no setting, the front-panel setting in the printer will be used.

#### T1200 and T1200 PS options

• **Color/Grayscale**: you can choose to print in color, in shades of gray or in pure black and white.

• **Default RGB source profile**: you can choose from a selection of RGB source profiles recognized by the printer.

• **Printer emulation**: you can choose to emulate a different HP Designjet printer. Default: **Off** (no printer emulation).
T1200 PS options (with PostScript or PDF jobs)

- **Default CMYK source profile:** you can choose from a selection of CMYK source profiles recognized by the printer. Default: *Europe ISO Coated FOGRA27*.
- **Rendering intent:** you can select the rendering intent.
- **Black point compensation:** you can turn black point compensation on or off.
- **HP Professional PANTONE Emulation:** you can turn HP Professional PANTONE Emulation on or off.

**Rendering intent**

Rendering intent is one of the settings used when doing a color transformation. As you probably know, some of the colors you want to print may not be reproducible by the printer. The rendering intent allows you to select one of four different ways of handling these so-called out-of-gamut colors.

- **Saturation (graphics):** best used for presentation graphics, charts or images made up of bright, saturated colors.
- **Perceptual (images):** best used for photographs or images in which colors blend together. It tries to preserve the overall color appearance.
- **Relative colorimetric (proofing):** best used when you want to match a particular color. This method is mainly used for proofing. It guarantees that, if a color can be printed accurately, it will be printed accurately. The other methods will probably provide a more pleasing range of colors but do not guarantee that any particular color will be printed accurately. It maps the white of the input space to the white of the paper on which you are printing.
- **Absolute colorimetric (proofing):** the same as relative colorimetric, but without mapping the white. This rendering is also used mainly for proofing, where the goal is to simulate the output of one printer (including its white point).

**Perform black point compensation**

The black point compensation option controls whether to adjust for differences in black points when converting colors between color spaces. When this option is selected, the full dynamic range of the source space is mapped into the full dynamic range of the destination space. It can be very useful in preserving shadows when the black point of the source space is darker than that of the destination space. This option is allowed only when the Relative colorimetric rendering intent is selected (see Rendering intent on page 74).

**Printing PANTONE swatch books**

You can use the Embedded Web Server to print a swatch book showing emulations of PANTONE colors as made by your printer, together with a measure of the color difference (ΔE) between each emulation and the original PANTONE spot color.

To print a swatch book, select the Embedded Web Server’s Main tab, then HP Professional PANTONE Emulation. Select the PANTONE stock to emulate, and one or more strips of PANTONE colors that you want to print. You can select color strips from more than one PANTONE stock. When you have selected all the colors you want, press the Next button. The next window displays your selection; you can press Print to print that selection, or Back to change the selection.
Color management from the front panel

You can color-calibrate the loaded paper type from the front panel by selecting the Image Quality Maintenance menu icon \[\text{Calibrate color}\]. See Color calibration on page 66.

The other color options in the front panel can all be found by selecting the Setup menu icon \[\text{Printing preferences} \rightarrow \text{Color options}\].

NOTE: These front panel settings can all be overridden by the printer driver or (with the T1200 series) Embedded Web Server job submission settings.

T770 series and T1200 series options

- **Color/Grayscale**: you can choose to print in color or in shades of gray. Default: **Print in color**.
- **Select RGB source profile**: you can choose from a selection of RGB source profiles recognized by the printer. Default: **sRGB (HP)**.
- **Emulate printer**: you can choose to emulate a different HP Designjet printer. Default: **Off** (no printer emulation).

TIP: If you have old HP-GL/2 or PostScript files made for a different HP Designjet printer, you can send them to the printer and use the front panel to turn on the appropriate emulation mode.
T1200 PS options (with PostScript or PDF jobs)

- **Select CMYK source profile**: you can choose from a selection of CMYK source profiles recognized by the printer. Default: *Europe ISO Coated FOGRA27*.

- **Select rendering intent**: you can select the rendering intent. Default: *Perceptual*.

- **Black point compensation**: you can turn black point compensation on or off. Default: *On*.

- **HP Professional PANTONE Emulation**: you can turn HP Professional PANTONE Emulation on or off. Default: *On*.
9 Practical printing examples

- Print a draft for revision with the correct scale
- Print a project
- Print a presentation
- Print and scale from Microsoft Office
Print a draft for revision with the correct scale

This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat

1. In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to check the plot size.

2. Select File > Print and ensure that Page Scaling is set to None.

NOTE: The page size will not be automatically selected according to the drawing size.
3. Press the **Properties** button and then select the **Paper/Quality** tab.

![Image: HP Deskjet T1200 Print Properties](image1)

4. Choose whatever **Document Size** and **Print Quality** you want to use. If you want to define a new custom paper size, press the **Custom** button.

![Image: Custom Paper Size](image2)

5. Select the **Features** tab, and then **Autorotate**.

![Image: Autorotate](image3)
6. Click **OK**, and check that the print preview in the Print dialog box seems correct.

---

**Print a project**

This section demonstrates how to print a project from Autodesk Design Review, AutoCAD and the printer’s Embedded Web Server.

**Using Autodesk Design Review**

Autodesk Design Review offers the **Use HP Instant Printing** option. This needs to be enabled once, after which it is taken as the default printing option until it is disabled.

**Enabling HP Instant Printing from Autodesk Design Review**

1. Start Autodesk Design Review and select **File > Print.**

   Alternatively, click the Print icon on the toolbar.
2. In the Print dialog box, check the Use HP Instant Printing box. You can select your printer and paper size here, or in the next window.

![Print dialog box with HP Instant Printing option](image)

3. Ensure that the printer and paper size are correct, then click OK to start printing.

![HP Instant Printing dialog box](image)

**Enabling HP Instant Printing from the Batch Print Wizard**


![Batch Print Wizard](image)
2. In the **Welcome** box, click **Next**.

3. Select the DWF files to print, then click **Next**.

4. Use the **Shift** key if you want to select multiple files to configure. Then click **Print Setup**, and the printing configuration will be applied to all the files you have selected.
5. In the Print dialog box, check the **Use HP Instant Printing** box. You can select your printer and paper size here, or in the next window.

6. Ensure that the printer and paper size are correct, then click **OK**. The paper size is automatically preselected.

7. Back in the **Choose print settings** box, click **Next**.
8. Save or start the batch print job.

### Using HP Instant Printing

- Make sure **Use HP Instant Printing** has been selected. To print, click the Print icon in the toolbar or select **File > Print**. Choose your preferred printing settings and click **OK**.

- Alternatively, Use HP Instant Printing can be launched directly from its own toolbar icon. In this case, it starts immediately, using the settings you defined previously.
Using AutoCAD

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.

2. Click the Plot icon at the top of the window.

3. The Plot window opens.
4. You can see further options by pressing the circular button in the lower right corner of the window.

NOTE: The Quality option here does not refer to the final print quality but to the quality of AutoCAD viewport objects that are sent for printing.

5. Press the Properties button.
6. Select the **Device and Document Settings** tab, and press the **Custom Properties** button.

7. In the **Paper/Quality** tab, check the **Show preview before printing** box, and select the paper type that you intend to use.

**NOTE:** If you select neither the paper source nor the paper type, the printer will not print on any protected roll (see **Roll protection (T1200 series only)** on page 62).

8. Select the print quality (your own choice between speed and quality of printing).
9. If you intend to print on roll paper, you must decide where the printer should cut the paper. Press the **Margins/Layout** button and select **Clip contents by margins**.

10. Select the **Features** tab, then select the **Autorotate** option. If you have a T1200 series printer, select the **Crop lines** option also. Autorotation can help to avoid wasting paper, and the crop lines will show you where to cut the paper after printing.

11. Press the **OK** button and save your configuration changes to a PC3 file.
12. When you have pressed the **OK** button in the Plot window, the printer will construct a print preview (T1200 series only).

![Print preview image](image)

**Using the Embedded Web Server to submit files (T1200 series only)**

From the HP Utility or the Embedded Web Server, select **Job Center > Submit Job**. With some Web browsers, you will see the window below; with other Web browsers, the mechanism for adding files is slightly different.

![Web Server screenshot](image)

Press the **Add files** button (or **Choose File, Add another file**) to choose the files from your computer that you want to print. The files must be in one of the following formats:

- PDF (T1200 PS only)
- PostScript (T1200 PS only)
• TIFF (T1200 PS only)
• JPEG (T1200 PS only)
• HP-GL/2
• RTL

**NOTE:** When you print to a file, the file should be in one of the above formats, but its name may have an extension such as .plt or .prn.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and number of copies), you can just press the **Print** button and the project will be sent to the printer.

If you need to specify printing settings, go to the **Job settings** section and select the options you need. Each option has explanatory text on the right, so that you can understand the behavior of each setting. Remember that, if you leave the setting as **Default**, the setting saved in the job will be used. If the job contains no setting, the setting in the printer will be used.

### Using printer emulation

Printer emulation can be requested by selecting **Advanced settings** > **Color** > **Color management** > **Printer emulation**.

You can select **Off** (no printer emulation) or the name of the printer model that you want to emulate.

This setting will apply to jobs that do not contain any printer emulation setting saved in the job.

### Using clip contents by margins

You can select this margins option from **Advanced settings** > **Paper** > **Layout/Margins** > **Print with margins** > **Layout** > **Clip contents by margins**.

Use this option when the contents to be printed have white borders and a size equal to that of the paper you have selected. The printer will use the white border for its margins and you will get a page of size equal to that which is selected in the driver.

### Print a presentation

This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

#### Using AutoCAD

1. Open the AutoCAD file and select a layout.
2. Click the Plot icon at the top of the window.

3. Ensure that the correct printer is selected, then press the **Properties** button.

4. Select the **Device and Document Settings** tab, and press the **Custom Properties** button.
5. In the **Paper/Quality** tab, check the **Show preview before printing** box, and select the paper type that you intend to use.

![Paper/Quality tab screenshot]

**NOTE:** If you select neither the paper source nor the paper type, the printer will not print on any protected roll (see **Roll protection (T1200 series only)** on page 62).

6. Select the print quality (your own choice between speed and quality of printing).

7. If you intend to print on roll paper, you must decide where the printer should cut the paper. Press the **Margins/Layout** button and select **Clip contents by margins**.

![Margins/Layout button screenshot]

8. If you are using photo or glossy paper, you can select **Borderless** printing (T1200 series only).
9. Select the **Features** tab, then select the **Autorotate** option. If you have a T1200 series printer, select the **Crop lines** option also. Autorotation can help to avoid wasting paper, and the crop lines will show you where to cut the paper after printing.

![Features tab with Autorotate and Crop lines options selected]

10. Press the **OK** button and save your configuration changes to a PC3 file.

![Save as window with PC3 file type selected]
11. When you have pressed the **OK** button in the Plot window, the printer will construct a print preview (T1200 series only).

Using Adobe Photoshop

1. Select **File > Page Setup > Printer**, select your printer and click **OK**.
2. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, select Printer > Properties > Paper/Quality > Custom > Paper Size. Enter the width, the length and the name of your custom paper size. Press the Save and OK buttons.

4. Select **Print > Properties**. In the Document Properties window, select **Paper Source**, **Paper Type** and **Print Quality**.

5. Press the **Margins/Layout** button. In this example you can select **Borderless** because you have already selected a photo paper (this option is only enabled with photo and glossy papers). The default image enlargement method is **Automatically by printer**. The option **Manually in application** can be used when you want to control the amount of enlargement precisely.
6. In the **Color** tab, the default color management option is **Printer Managed Colors**, and this is the correct option because you have already selected **Let Printer Determine Colors** in Photoshop.

![Color tab in printer properties](image)

Print and scale from Microsoft Office

This section demonstrates how to print and scale from Microsoft Office.

**Using PowerPoint**

1. Select the Office Button, then **Print**, and select the name of your printer.

![Print dialog box in PowerPoint](image)
2. Select Properties > Features > Print document on to scale the document to a particular size.

3. Select the Paper/Quality tab, then select Paper Source and Paper Type.

4. Select Margins/Layout, then select Clip contents by margins to keep the size.
Using Project


2. Select your printer's name, then Close.

3. Select Page Setup, and choose the Paper Size you want.
4. Select **Options** to go to the printer driver. The default options in the **Paper/Quality** tab are probably suitable: **Paper source**: Printer auto select and **Paper Type**: Any.

5. Select **Features** > **Print document on** to scale the document to a particular size. Alternatively, you can scale the document in Project.

**Using Excel**

1. Select the Office Button, then **Print**. Select your printer's name, then click **Close**.
2. Select the **Page Layout** tab, then **Size**, and choose the paper size you want.

3. Select the Office Button, then **Print > Properties** to go to the printer driver. In the **Paper/Quality** tab, select **Paper source, Paper Type** and **Print Quality**.
4. Select **Features > Print document on** to scale the document to a particular size. Alternatively, you can scale the document in Excel.
10 Job queue management

- Introduction
- Job queue page (T1200 series only)
- Job preview (T1200 series only)
- Turn off the job queue (T770 HD and T1200 series only)
- Select when to print a job in the queue (T770 HD and T1200 series only)
- Identify a job in the queue (T770 HD and T1200 series only)
- Prioritize a job in the queue (T770 HD and T1200 series only)
- Delete a job from the queue (T770 HD and T1200 series only)
- Reprint or copy a job in the queue (T770 HD and T1200 series only)
- Job status messages (T770 HD and T1200 series only)
Introduction

The job queue management options described in this chapter are available for the following printers.

- T1200 series: all options in this chapter
- T770 HD: front panel options only
- T770 and T770 PS: no job queue management

Job queue page (T1200 series only)

You can manage your printer’s job queue from the HP Utility, see Access the HP Utility on page 27, or the printer’s Embedded Web Server, see Access the Embedded Web Server on page 27.

By default, the access to the job queue is open to all users. An administrator can set a password so that users are required to enter a password for:

- Seeing job previews
- Canceling or deleting jobs

The job queue page shows all jobs that are available in the printer job queue. It includes jobs that are being received, parsed, rendered, printed and already printed.

The following information displayed for each job:

- **Preview:** Click the icon to see the job preview. The job preview is available once the job is processed.
- **File name:** Click the file name to see the properties of the job.
- **Status:** Gives the current job status.
- **Pages:** Number of pages in the job.
- **Copies:** Number of copies printed.
- **Date:** Date and time the printer received the job.
- **User:** The user’s name.

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title of the corresponding column. You can perform the following operations on one or all jobs in the queue:

- **Cancel:** Cancels the selected jobs. You are asked to confirm before the job is canceled. The job remains stored in the printer, but will not be printed unless you click Reprint.
- **Hold:** Holds the select jobs until you click Continue to print.
- **Continue:** All selected jobs, which are on hold, continue printing.
- **Reprint:** Prints more copies of a job. Type the number of copies (default 1, maximum 99) and click Print.
- **Move to front:** Sends all selected jobs to the top of the job queue.
- **Delete:** Deletes selected jobs from the job queue. You are asked to confirm before the job is deleted.
- **Refresh:** Refreshes the page, ensuring the information is updated.
**NOTE:** The job queue page does not automatically update.

### Job preview (T1200 series only)

The printer samples all incoming jobs and generates a JPEG file that can be served as a preview of the job. This preview is available for all languages supported by the printer: the T1200 PS supports PDF, PostScript, HPGL/2, RTL, TIFF and JPEG.

**NOTE:** Do not send a job for preview with more than 64 pages, this may cause the driver software to crash.

Job preview is available once the job is processed. To access the preview page, click the magnifying glass icon, which appears in the Preview column on the job queue page. The preview page shows the following job details along with a thumbnail preview of the job:

- **File name:** The file name of the job.
- **Loaded paper:** The type of paper loaded in the printer.
- **Job dimensions:** The dimensions of the job.

To see a larger preview of the job, click either the job thumbnail or the magnifying glass icon, which appears on the right hand side of the printer image.

**NOTE:** Browsers without the Macromedia plug-in show the job image as yellow shaded. Browsers that have the Macromedia flash plug-in version 7 and above shows an enhanced preview of the job image inside the paper loaded in the printer.

### Turn off the job queue (T770 HD and T1200 series only)

You can turn off the job queue in the following ways.

- Using the Embedded Web Server (T1200 series only): Select the **Setup** tab, then **Printer settings > Job management > Queue** and select **Off**.

- Using the front panel: Select the Setup menu icon ![Setup icon](image), then **Job management options > Enable queue > Off**.

### Select when to print a job in the queue (T770 HD and T1200 series only)

**NOTE:** The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue.

- Using the Embedded Web Server (T1200 series only): Select the **Setup** tab, then **Printer settings > Start printing**.

- Using the front panel: Select the Job management menu icon ![Job management icon](image), then **Job queue**.
There are three options you can select:

- When **After Processing** is selected, the printer waits until the whole page has been processed and then it starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.
- When **Immediately** is selected, the printer prints the page as it is processed. This is the quickest setting, but the printer may stop halfway through a print to process data. This setting is not recommended for complex images with dense color.
- When **Optimized** is selected (this is the default setting), the printer calculates the best time to begin printing the page. It is usually the best compromise between the **After Processing** and **Immediately** settings.

### Identify a job in the queue (T770 HD and T1200 series only)

The best way to look at the queue is in the Embedded Web Server (Main tab > **Job queue**), where you can manage the queue and get full information on every job (by clicking the name of the file). However, this method is available for the T1200 series only.

You can also manage the queue from the front panel. To do so, select the Job management menu icon 📋, then **Job queue**, where you can see a list of the jobs in the queue.

Each has an identifier, comprising:

<position in queue>: <image name>

The job currently being printed has a check mark, canceled jobs have crosses, processing jobs have a clock and jobs on hold have a warning.

### Prioritize a job in the queue (T770 HD and T1200 series only)

You can select any job in the queue and make it the next one to be printed.

- Using the Embedded Web Server (T1200 series only): After selecting the job, select **Reprint**.
- Using the front panel: After selecting the job, select **Move to front**.

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be printed next, and on its own on the roll, first turn nesting off and then move it to the front of the queue as described above.

### Delete a job from the queue (T770 HD and T1200 series only)

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid printing it, you can simply delete it.

- Using the Embedded Web Server (T1200 series only): Select the job and then select **Delete**.
- Using the front panel: Select the job and then select **Delete**.

In the same way, you can delete a job that has not been printed yet.
If the job is currently being printed (its status is **printing** in the Web server), you may want to cancel it and then delete it.

- Using the Embedded Web Server (T1200 series only): After selecting the job, select **Cancel** and then **Delete**.
- Using the front panel: After selecting the job, press the **Cancel** key and then select **Delete**.

**Reprint or copy a job in the queue (T770 HD and T1200 series only)**

To reprint or make extra copies of any job in the queue, select the job in the Embedded Web Server (T1200 series only) and click the **Reprint** icon, then specify the number of copies you want. The job will be moved to the top of the queue. To make more than one print of a non-printed job in the queue from the front panel, select the job and choose **Copies**, then specify the number of copies required and press the **Select** key. This overrides any value set by your software.

**NOTE:** If **Rotate** was **On** when you sent the file, every copy will be rotated.

You can reprint an already-printed job from the front panel. Select the Job management menu icon, then select the job from the queue, then select **Reprint**.

**NOTE:** You cannot use this method for PCL3 jobs. To reprint old jobs that are PCL3, you may be able to use your operating system's printer spooler, if you have already set the spooler to save old jobs. This facility depends on your operating system.

**Job status messages (T770 HD and T1200 series only)**

These are the possible job status messages, approximately in the order in which they may be seen:

- **Receiving**: the printer is receiving the job from the computer
- **Waiting to process**: the job has been received by the printer and is waiting to be rendered (for jobs submitted through the Embedded Web Server only)
- **Processing**: the printer is parsing and rendering the job
- **Preparing to print**: the printer is performing writing system checks before printing the job
- **Waiting to print**: the job is waiting for the print engine to become free to proceed with printing
- **Waiting for nest**: the printer is set up with Nesting=On and is waiting for other jobs in order to complete the nest and proceed with printing
- **On hold**: the job was sent with the **on hold for preview** option and is on hold

**NOTE:** Do not send a job for preview with more than 64 pages, this may cause the driver software to crash.

**NOTE:** If the printer hangs up while printing a job, and the queue facility is turned on, the partially printed job will appear in the queue as **on hold** when the printer is next turned on. When you resume the job, it will start printing at the page at which it was interrupted.

- **On hold for paper**: the job can't be printed because the right paper is not loaded in the printer. Load the required paper, see **Paper handling on page 31**, and click **Continue** to resume the job
- **On hold for accounting**: the job can't be printed because the printer requires all jobs to have an account ID: enter the account ID and then click **Continue** to resume the job
TIP: To set an account ID, see Require account ID (T1200 series only) on page 24.

- Printing
- Drying
- Cutting paper
- Ejecting page
- Canceling: the job is being canceled, but will remain in the printer job queue
- Deleting: the job is being deleted from the printer
- Printed
- Canceled: the job has been canceled by the printer
- Canceled by user
- Empty job: the job does not contain anything to print

Reactivate a job on hold (T1200 series only)

When the printer puts a job on hold you receive an alert, see Printer alerts on page 176, which explains why the job is on hold. Follow the instructions on the screen to remove the hold and continue printing.
11 Retrieving printer usage information

- Get printer accounting information
- Check printer usage statistics
- Check ink and paper usage for a job
Get printer accounting information

There are various different ways of getting accounting information from your printer.

- View printer usage statistics for the whole lifetime of the printer, see Check printer usage statistics on page 110.
- View ink and paper usage for each of your recent jobs by using the HP Utility, see Check ink and paper usage for a job on page 110. If the HP Utility is not available, see Access the HP Utility on page 27.
- Use a third-party application to request printer status, printer usage or job accounting data from the printer through the Internet. The printer provides data in XML to the application whenever requested. HP provides a Software Development Kit to facilitate the development of such applications.

Check printer usage statistics

There are two ways to check your printer's usage statistics.

NOTE: The accuracy of the usage statistics is not guaranteed.

Printer statistics with the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 27.
2. Under Windows, go to the Overview tab and click on the Printer usage link.
   Under Mac OS, select Information > Printer Usage and click on the Lookup button.

Printer statistics with the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 27.
2. Go to the Main tab.
3. Select History > Usage.

Check ink and paper usage for a job

There are two ways to check ink and paper usage for a job.

NOTE: The accuracy of the usage statistics is not guaranteed.

Ink and paper statistics with the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 27.
2. Select Job center to view information regarding the most recent jobs.
3. Under Windows, click on the Accounting link.
   Under Mac OS, select Job Accounting and click on the Look Up button.
Ink and paper statistics with the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 27.
2. Go to the Main tab.
3. Select History > Accounting.
12 Handling ink cartridges and printheads

- About the ink cartridges
- Check the ink cartridges status
- Remove an ink cartridge
- Insert an ink cartridge
- About the printheads
- Check the printhead status
- Remove a printhead
- Insert a printhead
About the ink cartridges

Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper. To purchase additional cartridges, see Accessories on page 128.

⚠️ CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see the Glossary on page 187). Avoid touching pins, leads and circuitry.

Check the ink cartridges status

To view the ink levels of your ink cartridges, press the View ink level key on the front panel.

To get more information on your ink cartridges, you can use the front panel ink menu or the HP Utility.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 164.

Ink menu procedure

1. From the front panel, select the Ink menu icon, then Ink cartridge information.

2. Select the cartridge on which you want information.

3. The front panel displays:
   - Color
   - Product name
   - Product number
   - Serial number
   - Status
   - Ink level, if known
   - Total ink capacity in milliliters
   - Expiration date
   - Warranty status
   - Manufacturer

HP Utility procedures

- In the HP Utility for Windows, go to the Overview tab, each cartridge's status is under Supplies Status > Cartridges.
- In the HP Utility for Mac OS, select Printer Status in the Information group.

Remove an ink cartridge

There are two occasions when you need to remove an ink cartridge.

- The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you can use up the remaining ink in the first cartridge at a more convenient time).
- The ink cartridge is empty or faulty, and you must replace it to continue printing.
\[\textbf{CAUTION:}\] Do not try to remove an ink cartridge while printing.

\[\textbf{CAUTION:}\] Remove an ink cartridge only if you are ready to insert another one.

\[\textbf{CAUTION:}\] Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

\[\textbf{NOTE:}\] When a cartridge runs out of ink, the current job is not automatically cancelled: unless you cancel it manually, it will resume printing when the empty cartridge has been replaced. If there is a delay in replacing the cartridge, you may see some banding on the print.

1. From the front panel, select the Ink menu icon \(\text{ink} \) then Replace ink cartridges.

2. Open the ink cartridge cover on the left-hand side of the printer.

3. Grip the cartridge you wish to remove.
4. Pull the cartridge straight up.

**NOTE:** Avoid touching the end of the cartridge that is inserted into the printer, as there may be ink on the connection.

**NOTE:** Avoid storing partially used ink cartridges.

5. The front-panel display identifies the missing ink cartridge.

**Insert an ink cartridge**

1. Before removing the cartridge from its wrapping, shake it vigorously.

2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters (in these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the cartridge label.

3. Insert the ink cartridge into its slot.
4. Push the cartridge into the slot until it snaps into position. You should hear a beep and see confirmation that the cartridge has been inserted.

If you have difficulty, see Cannot insert an ink cartridge on page 164.

5. When all cartridges have been inserted, close the cover.

6. The front-panel display confirms that all cartridges have been correctly inserted, press the OK key on the front panel.

About the printheads

The printheads are connected to the ink cartridges and jet ink onto the paper.

⚠️ CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices (see the Glossary on page 187). Avoid touching pins, leads and circuitry.

Check the printhead status

The printer automatically checks and services the printheads after each print. Follow the steps below to get more information on your printheads.

1. From the front panel, select the Ink menu icon then Printhead information.

2. Select the printhead on which you want information.

3. The front panel displays:
   - Colors
   - Product name
   - Product number
● Serial number
● Status, see Front-panel error messages on page 177
● Volume of ink it has used
● Warranty status

You can also get most of this information without leaving your computer by using the HP Utility.

For an explanation of the printhead status messages, see Printhead status messages on page 170.

If the warranty status is See warranty note, this indicates that non-HP ink is being used. See the HP Legal Information document provided with your printer for details of the warranty implications.

Remove a printhead

△ CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

△ CAUTION: Printhead replacement must be performed with the printer powered on.

1. From the front panel, select the Ink menu icon, then Replace prinheads.

Ink
► View ink levels
► Replace ink cartridges
► Replace printheads
☑ Ink cartridge information
☑ Printhead information

2. The printer moves the carriage into the correct position.

△ CAUTION: If the carriage is left in the removal position for more than three minutes without inserting or removing any printheads, it tries to move back to its normal position in the right-hand end.
3. When the carriage has stopped moving, the front-panel display asks you to open the window.

4. Locate the carriage on the right side of the printer.

5. Pull the handle up and toward you to release the wire loop.

6. Push the handle back to raise the lid.
7. This gives you access to the printheads.

8. To remove a printhead, lift up the blue handle.

9. Using the blue handle, use steady force to disengage the printhead.
10. Pull the blue handle upward until the printhead is released from the carriage.

⚠️ CAUTION: Do not pull abruptly because this can damage the printhead.

11. The front-panel display identifies the missing printhead.

**Insert a printhead**

1. Remove the orange protective caps by pulling them down.

2. The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check that the colored label on the printhead matches the colored label of the carriage slot into which the printhead is to be inserted.
3. Insert the new printhead into its correct slot in the carriage.

⚠️ **CAUTION:** Insert the printhead slowly and vertically, straight down. It may be damaged if you insert it too fast, or at an angle, or if you rotate it as you insert it.

4. Push down as indicated by the arrow shown below.

⚠️ **CAUTION:** When installing the new printhead there may be some resistance, so you need to press it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel display that the printhead has been inserted. If you have difficulty, see Cannot insert a printhead on page 164.

5. Insert all other printheads that need to be installed, and close the carriage lid.
6. Ensure the end of the blue handle catches the wire loop on the near side of the carriage.

![Image 1]

7. Lower the handle to rest on the carriage cover.

![Image 2]

When all the printheads have been inserted correctly and are accepted by the printer, the printer beeps.

**NOTE:** If the printer does not beep when you insert the printhead and the Replace message appears on the front-panel display, the printhead may need to be reinserted.

8. Close the window.

![Image 3]

9. The front-panel display confirms that all printheads are correctly inserted. The printer starts checking and preparing the printheads. The default routine process, when all printheads are changed, takes 10 minutes. If the printer finds problems in preparing the printheads, it takes longer, up to 45 minutes. For a single printhead insertion, the times vary between 2 and 40 minutes. After all printheads are checked and prepared, the printhead realignment procedure runs automatically if paper is loaded, see Align the printheads on page 168.

10. You are recommended to perform a color calibration after inserting a new printhead. See Color calibration on page 66.
13 Maintaining the printer

- Check printer status
- Clean the exterior of the printer
- Maintain the ink cartridges
- Move or store the printer
- Update the firmware
- Update the software
- Printer maintenance kits
- Secure Disk Erase
Check printer status

You can check the current status of the printer in various ways:

- If you start the HP Utility and select your printer, you see a page of information describing the status of the printer and its paper and ink supplies.
- If you access the Embedded Web Server, you see information about the general status of the printer. The Supplies page in the Main tab describes the status of the paper and ink supplies.
- The status screen of the printer's front panel notifies you of any current problems affecting the printer as a whole. You can also request information about:
  - The currently loaded paper, with the View information key or
  - The ink levels, with the View ink levels key or
  - The ink cartridges, by selecting the Ink menu icon and then Ink cartridge information
  - The printheads, by selecting the Ink menu icon and then Printhead information

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

⚠️ WARNING! ⚠️ To avoid an electric shock, make sure that the printer is turned off and unplugged before you clean it. Do not let water get inside the printer.

⚠️ CAUTION: ⚠️ Do not use abrasive cleaners on the printer.

Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to maintain the best print quality, replace a cartridge when it reaches its expiration date. The printer's front panel notifies you when any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Check printer status on page 124.

See also Handling ink cartridges and printheads on page 112.

Move or store the printer

If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare the printer, follow the instructions below.

1. Do not remove the ink cartridges or printheads.
2. Make sure that no paper is loaded.
3. Make sure that the printer is idle.
4. Disconnect any cables connecting the printer to a network or a computer.
If you need to leave the printer turned off for a long time, follow the additional steps below.

1. Turn off the power using the **Power** key on the front panel.
2. Also turn off the power switch at the rear of the printer.
3. Disconnect the printer's power cable.

⚠️ **CAUTION:** If you turn the printer upside down, ink could escape into the printer and cause serious damage.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and prepare the printheads. Preparing the printheads normally takes just over a minute. However, if the printer has been off for a six weeks or more, preparing the printheads could take up to 45 minutes.

⚠️ **CAUTION:** If the printer remains off for a long period of time, the printheads may become unusable. In this case, you need to replace the printheads with new ones.

💡 **TIP:** Because preparing and purging the printheads uses both time and ink, you are strongly recommended to leave the printer always on or in sleep mode, whenever possible, to maintain the health of the printheads. In both cases, the printer wakes up from time to time to maintain the printheads. Thus you can avoid going through lengthy preparation processes before using your printer.

---

**Update the firmware**

The printer's various functions are controlled by software that resides in the printer, otherwise known as firmware.

From time to time firmware updates will be available from Hewlett-Packard. These updates increase the printer's functionality and enhance its features.

Firmware updates can be downloaded from the Internet and installed in your printer in the following ways; you can choose whichever you find most convenient.

- Using the HP Utility under Windows, select your printer, the **Support** tab and then **Firmware Update**.
- Using the HP Utility under Mac OS, select **Firmware Update** in the Support group.
- Using your printer's Embedded Web Server, select the **Main** tab and then **Firmware update**.

In each case, follow the instructions on your screen to download the firmware file and store it on your hard disk. Then select the downloaded file and click **Update**.

⚠️ **NOTE:** Firmware upgrades are digitally signed by HP. You are not recommended to use unsigned firmware upgrades. If you attempt to do so, the front panel will ask you to confirm.

If you experience very slow progress while uploading the firmware file to the printer, the reason could be that you are using a proxy server. In that case, try bypassing the proxy server and accessing the Embedded Web Server directly.

- In Internet Explorer 6 for Windows, go to **Tools > Internet Options > Connections > LAN Settings**, and check the **Bypass proxy server for local addresses** box. Alternatively, for more precise control, click the **Advanced** button and add the printer's IP address to the list of exceptions, for which the proxy server is not used.
- In Safari for Mac OS, go to **Safari > Preferences > Advanced** and click the **Proxies: Change Settings** button. Add the printer's IP address or its domain name to the list of exceptions, for which the proxy server is not used.
The firmware includes a set of the most commonly used paper presets. Extra paper presets can be downloaded separately; see Paper presets on page 43.

**Update the software**


If your operating system is Windows, HP Software Update regularly offers to update your software automatically.

**Printer maintenance kits**

Four maintenance kits are available for your printer, containing components that may need to be replaced after long use. When one of them is needed, a message is displayed on the front panel and by the HP Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 182) and request the maintenance kit. The kits are installed by service engineers only.

**Secure Disk Erase**

The printer's hard disk is used as a temporary storage area for print jobs. The Secure Disk Erase facility can completely erase your information from the hard disk to protect it from unauthorized access. You can choose to erase particular files, or the whole hard disk.

Secure Disk Erase provides three different levels of security:

- **Non-Secure Fast Erase:** all pointers to the information are erased. The information itself remains on the hard disk until the disk space it occupies is needed for other purposes, and it is then overwritten. While it remains on the disk, it is difficult for most people to access, but may be accessed using software designed for the purpose. This is the normal method in which files are erased on most computer systems; it is the fastest method but the least secure.

- **Secure Fast Erase:** all pointers to the information are erased, and the information itself is also overwritten with a fixed character pattern. This method is slower than Non-Secure Fast Erase, but more secure. It may still be possible to access fragments of the erased information by using special tools to detect residual magnetic traces.
- **Secure Sanitizing Erase**: all pointers to the information are erased, and the information itself is repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense 5220-22.m requirements for clearing and sanitization of disk media. This is the default security level when using Secure Disk Erase.

Secure Disk Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based print management software: see [http://www.hp.com/go/webjetadmin/](http://www.hp.com/go/webjetadmin/).

If you have difficulty in using Secure Disk Erase from Web JetAdmin, please contact HP Support: see [Contact HP Support on page 182](#).

**NOTE:** If you choose to erase the whole hard disk, you may be asked to restart the printer several times during the process, which will take about 6 hours with Secure Disk Erase or 24 hours with Secure Sanitizing Erase.
14 Accessories

- How to order supplies and accessories
- Introduction to the accessories
How to order supplies and accessories

There are two alternative ways to order supplies or accessories for your printer:

- Contact HP Support (see Contact HP Support on page 182).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies

The following ink supplies can be ordered for your printer.

<table>
<thead>
<tr>
<th>Table 14-1 Ink cartridges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cartridge</td>
</tr>
<tr>
<td>HP 72 69 ml Photo Black Ink Cartridge</td>
</tr>
<tr>
<td>HP 72 69 ml Cyan Ink Cartridge</td>
</tr>
<tr>
<td>HP 72 69 ml Magenta Ink Cartridge</td>
</tr>
<tr>
<td>HP 72 69 ml Yellow Ink Cartridge</td>
</tr>
<tr>
<td>HP 72 69 ml Gray Ink Cartridge</td>
</tr>
<tr>
<td>HP 72 130 ml Matte Black Ink Cartridge</td>
</tr>
<tr>
<td>HP 72 130 ml Photo Black Ink Cartridge</td>
</tr>
<tr>
<td>HP 72 130 ml Cyan Ink Cartridge</td>
</tr>
<tr>
<td>HP 72 130 ml Magenta Ink Cartridge</td>
</tr>
<tr>
<td>HP 72 130 ml Yellow Ink Cartridge</td>
</tr>
<tr>
<td>HP 72 130 ml Gray Ink Cartridge</td>
</tr>
<tr>
<td>HP 726 300 ml Matte Black Ink Cartridge (T1200 series only)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 14-2 Printheads</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printhead</td>
</tr>
<tr>
<td>HP 72 Gray &amp; Photo Black Printhead</td>
</tr>
<tr>
<td>HP 72 Magenta &amp; Cyan Printhead</td>
</tr>
<tr>
<td>HP 72 Matte Black &amp; Yellow Printhead</td>
</tr>
</tbody>
</table>

Order paper

The following paper types are currently provided for use with your printer.

**NOTE:** This list is likely to change over the course of time. For the latest information, see http://www.hp.com/go/T770/accessories/ or http://www.hp.com/go/T1200/accessories/.

**NOTE:** Paper types that HP does not support may nevertheless be compatible with your printer.
Key to availability:

- (A) indicates papers available in Asia (excluding Japan)
- (C) indicates papers available in China
- (E) indicates papers available in Europe, the Middle East and Africa
- (J) indicates papers available in Japan
- (L) indicates papers available in Latin America
- (N) indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Bond and Coated Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Universal Inkjet Bond Paper</td>
<td>80</td>
<td>45.7 m</td>
<td>594 mm (A1)</td>
<td>Q8003A (AJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(150 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1396A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1397A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1398A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>91.4 m</td>
<td>594 mm (A1)</td>
<td>Q8004A (EAJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(300 ft)</td>
<td>841 mm (A0)</td>
<td>Q8005A (EAJ)</td>
</tr>
<tr>
<td>HP Bright White Inkjet Bond Paper</td>
<td>90</td>
<td>45.7 m</td>
<td>420 mm (A2)</td>
<td>Q1446A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(150 ft)</td>
<td>594 mm (A1)</td>
<td>Q1445A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C1860A (LN), C6035A (AEJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in)</td>
<td>Q1444A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C1861A (LN), C6036A (AEJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>91.4 m</td>
<td>914 mm (36 in)</td>
<td>C6810A</td>
</tr>
<tr>
<td>HP Recycled Bond Paper</td>
<td>80</td>
<td>45.7 m</td>
<td>420 mm (A2)</td>
<td>QG892A (E)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(150 ft)</td>
<td>610 mm (24 in)</td>
<td>QG899A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>QG890A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>QG891A (EN)</td>
</tr>
<tr>
<td>HP Cockle-free Coated Paper</td>
<td>100</td>
<td>45.7 m</td>
<td>610 mm (24 in)</td>
<td>QG883A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(150 ft)</td>
<td>914 mm (36 in)</td>
<td>QG884A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>QG885A (EN)</td>
</tr>
<tr>
<td>HP Cockle-free Heavyweight</td>
<td>170</td>
<td>30.5 m</td>
<td>610 mm (24 in)</td>
<td>QG886A (EN)</td>
</tr>
<tr>
<td>Coated Paper</td>
<td></td>
<td>(100 ft)</td>
<td>914 mm (36 in)</td>
<td>QG887A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>QG888A (EN)</td>
</tr>
<tr>
<td>HP Universal Coated Paper</td>
<td>95</td>
<td>45.7 m</td>
<td>610 mm (24 in)</td>
<td>Q1404A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(150 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1405A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1406A</td>
</tr>
<tr>
<td>Paper type</td>
<td>g/m²</td>
<td>Length</td>
<td>Width</td>
<td>Part numbers</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------</td>
<td>---------</td>
<td>---------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>HP Coated Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in) (A2)</td>
<td>Q1443A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>457 mm (18 in)</td>
<td>Q7897A (EJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q1442A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C6019B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in) (A0)</td>
<td>Q1441A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C6020B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>C6567B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>91.4 m (300 ft)</td>
<td>914 mm (36 in)</td>
<td>C6980A</td>
</tr>
<tr>
<td>HP Universal Heavyweight Coated Paper</td>
<td>120</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1412A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1413A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1414A (AEJN)</td>
</tr>
<tr>
<td>HP Heavyweight Coated Paper</td>
<td>131</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>C6029C (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C6030C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>C6569C</td>
</tr>
<tr>
<td></td>
<td></td>
<td>67.5 m (225 ft)</td>
<td>1067 mm (42 in)</td>
<td>Q1956A (EN)</td>
</tr>
<tr>
<td>HP Super Heavyweight Plus Matte Paper</td>
<td>210</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6626A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6627A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q6628A (AEJN)</td>
</tr>
<tr>
<td>HP Colored Paper Fluorescent Yellow</td>
<td>100</td>
<td>45.7 m (150 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1757A (E)</td>
</tr>
<tr>
<td>HP Colored Paper Yellow</td>
<td>92</td>
<td>45.7 m (150 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1760A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>90 m (295.3 ft)</td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q6596A (E)</td>
</tr>
<tr>
<td>HP Technical Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Natural Tracing Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in) (A2)</td>
<td>Q1440A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q1439A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C3869A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in) (A0)</td>
<td>Q1438A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3868A</td>
</tr>
<tr>
<td>HP Translucent Bond</td>
<td>67</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3860A (AJS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3859A (LN)</td>
</tr>
<tr>
<td>HP Vellum</td>
<td>75</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3862A (N)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3861A (LN)</td>
</tr>
<tr>
<td>HP Film (Technical and Graphic)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Clear Film</td>
<td>174</td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>C3876A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3875A</td>
</tr>
<tr>
<td>HP Matte Film</td>
<td>160</td>
<td>38.1 m (125 ft)</td>
<td>610 mm (24 in)</td>
<td>51642A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>51642B</td>
</tr>
<tr>
<td>Paper type</td>
<td>g/m²</td>
<td>Length</td>
<td>Width</td>
<td>Part numbers</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------</td>
<td>---------------</td>
<td>----------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>HP Polyester Film White Matte</td>
<td>167</td>
<td>15.2 m (50 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1736A (AEN)</td>
</tr>
<tr>
<td>HP Vivid White Glossy Polyester Film</td>
<td>230</td>
<td>20.1 m (66 ft)</td>
<td>610 mm (24 in)</td>
<td>CG827A (EJN)</td>
</tr>
<tr>
<td>HP Vivid White Glossy Polyester Film</td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG828A (EJN)</td>
</tr>
<tr>
<td><strong>HP Photographic Paper</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Universal Instant-Dry Photo Gloss</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6574A</td>
</tr>
<tr>
<td>HP Universal Instant-Dry Photo Gloss</td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6575A</td>
</tr>
<tr>
<td>HP Universal Instant-Dry Photo Gloss</td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q6576A</td>
</tr>
<tr>
<td>HP Universal Instant-Dry Photo Semi-Gloss</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6579A</td>
</tr>
<tr>
<td>HP Universal Instant-Dry Photo Semi-Gloss</td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6580A</td>
</tr>
<tr>
<td>HP Universal Instant-Dry Photo Semi-Gloss</td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q6581A</td>
</tr>
<tr>
<td><strong>TIP:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TIP:</strong> The dye inks used by your printer will fade very quickly on instant-dry photo papers. If you plan to display the prints for more than two weeks, you should laminate them to achieve longer life.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Universal High-Gloss Photo Paper</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1426A (AEJN)</td>
</tr>
<tr>
<td>HP Universal High-Gloss Photo Paper</td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1427A (AEJN)</td>
</tr>
<tr>
<td>HP Universal High-Gloss Photo Paper</td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1428A (AEJN)</td>
</tr>
<tr>
<td>HP Universal Semi-Gloss Photo Paper</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1420A (AEJN)</td>
</tr>
<tr>
<td>HP Universal Semi-Gloss Photo Paper</td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1421A (AEJN)</td>
</tr>
<tr>
<td>HP Universal Semi-Gloss Photo Paper</td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1422A (AEJN)</td>
</tr>
<tr>
<td>HP Photo Paper RC Matte</td>
<td>200</td>
<td>30.5 m (100 ft)</td>
<td>914 mm (36 in)</td>
<td>C7946A (AEN)</td>
</tr>
<tr>
<td><strong>HP Backlit Material</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Backlit Film Reverse Print Matte</td>
<td>160</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>C7960A (AEJN)</td>
</tr>
<tr>
<td><strong>HP Self-Adhesive Material and Laminate</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Two-View Cling</td>
<td>240</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1914A (AEN)</td>
</tr>
<tr>
<td>HP Indoor Paper Self-Adhesive</td>
<td>170</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1915A (AEN)</td>
</tr>
<tr>
<td>HP Indoor Paper Self-Adhesive</td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1915A (AEN)</td>
</tr>
<tr>
<td>HP Matte Adhesive-back Polypropylene</td>
<td>225</td>
<td>21.3 m (70 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1908A (AEN)</td>
</tr>
<tr>
<td>HP Colorfast Adhesive Vinyl</td>
<td>328</td>
<td>12.2 m (40 ft)</td>
<td>914 mm (36 in)</td>
<td>C6775A</td>
</tr>
<tr>
<td>HP Adhesive-backed Polypropylene</td>
<td>128</td>
<td>50 m (164 ft)</td>
<td>914 mm (36 in)</td>
<td>Q8044A (C)</td>
</tr>
<tr>
<td>HP Adhesive-backed Polypropylene</td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q8884A (C)</td>
</tr>
<tr>
<td>HP Everyday Adhesive Matte Polypropylene</td>
<td>180</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>CG843A</td>
</tr>
<tr>
<td>HP Everyday Adhesive Matte Polypropylene</td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG824A</td>
</tr>
</tbody>
</table>
### Table 14-3 Roll paper (continued)

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Self-adhesive Gloss Polypropylene</td>
<td>180</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q8834A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q8835A</td>
</tr>
</tbody>
</table>

### Table 14-4 Sheet paper

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Bond and Coated Paper</td>
<td>90</td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>Q1961A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1962A (AEN)</td>
</tr>
<tr>
<td>HP Photographic Paper</td>
<td>280</td>
<td>483 mm (19 in)</td>
<td>330 mm (13 in)</td>
<td>Q5486A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>Q5487A</td>
</tr>
<tr>
<td>HP Premium Plus Photo Satin</td>
<td>280</td>
<td>483 mm (19 in)</td>
<td>330 mm (13 in)</td>
<td>Q5489A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>Q5490A</td>
</tr>
</tbody>
</table>

### Introduction to the accessories

#### Order accessories

The following accessories can be ordered for your printer.

<table>
<thead>
<tr>
<th>Name</th>
<th>Product number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Designjet T770 Memory Upgrade</td>
<td>CN499A</td>
</tr>
<tr>
<td>HP Designjet T770 PostScript Upgrade</td>
<td>CN500A</td>
</tr>
<tr>
<td>HP Designjet External Hard Disk</td>
<td>CN501A</td>
</tr>
<tr>
<td>HP Designjet T770 24-in Spindle</td>
<td>CQ783A</td>
</tr>
<tr>
<td>HP Designjet T770 &amp; T1200 44-in Spindle</td>
<td>Q6709A</td>
</tr>
<tr>
<td>HP Designjet T770 24-in Stand</td>
<td>Q6663A</td>
</tr>
<tr>
<td>HP Jetdirect 635n IPv6/IPsec Print Server</td>
<td>J7961A</td>
</tr>
</tbody>
</table>

#### Memory upgrade (T770 only)

The memory upgrade may be useful if you sometimes experience “Out of memory” errors when printing. It can be plugged into the printer's USB host, providing 6 GB of extra memory.

**NOTE:** This upgrade does not apply to the T770 HD.

#### PostScript upgrade (T770 series only)

The PostScript upgrade provides a PostScript interpreter, enabling you to send PostScript and PDF files to the printer. It includes the 6 GB memory upgrade as above, so you do not need both. The PostScript upgrade can be plugged into the printer's USB host.
NOTE: The included 6 GB memory upgrade applies to the T770 only, and not to the T770 HD.

External hard disk (T1200 series only)

The external hard disk enables you to remove the hard disk for security reasons. It can be plugged into the printer's USB host.

Spindle

With extra spindles, you can change rapidly from one paper type to another.

Jetdirect print server

Jetdirect print servers support extra connectivity and security options beyond those provided in the standard Gigabit Ethernet interface built into the printer.

15 Troubleshooting paper issues

- The paper cannot be loaded successfully
- The paper type is not in the driver
- The printer printed on the wrong paper type
- An “on hold for paper” message (T1200 series only)
- The roll paper will not advance
- The paper has jammed
- A strip stays on the output tray and generates jams
- The printer displays out of paper when paper is available
- Prints do not fall neatly into the basket
- The sheet stays in the printer when the print has been completed
- The paper is cut when the print has been completed
- The cutter does not cut well
- The roll is loose on the spindle
- Recalibrate the paper advance
The paper cannot be loaded successfully

- Ensure no paper is loaded.
- Ensure the paper is far enough inside the printer, you should feel the printer grab the paper.
- Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the front-panel display. The printer automatically attempts to straighten the paper.
- The paper may be crumpled, or warped, or may have irregular edges.

General unsuccessful roll load issues

- If the paper does not load, the leading edge of the paper may not be straight or clean and needs to be trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary even with a new roll of paper.
- Ensure the roll ends are tight against the spindle ends.
- Check that the spindle is correctly inserted.
- Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.
- Check that all roll end plugs have been removed.
- Check that the paper is wound tightly on the roll.
- Do not touch the roll or paper at during the alignment process.
- When loading a roll on the T1200 series, the roll cover must remain open until the front panel prompts you to close it.
- When loading the upper roll (the only roll on the T770), avoid inserting the paper into the cut sheet slot.

Unsuccessful roll load

If the paper has not been inserted straight, the front panel displays the following instructions.

1. When prompted by the front-panel display, lift the blue lever on the left. The printer attempts to straighten the roll.
2. When prompted by the front-panel display, lower the blue lever. The printer checks the alignment. If the roll is aligned, the T1200 printer series prompts you to close the roll cover, and you are now ready to print.

If the roll is still not aligned, the front panel displays an error and instructions to start again.
If you would like to start the load process again, cancel the process on the front panel and rewind the roll from the end of the spindle until the edge is removed from the printer.

**NOTE:** If the roll has become loose around the core, the printer cannot load the paper.

### Unsuccessful sheet load

- Guide the sheet, especially thick papers, when the printer initially feeds the sheet.
- Ensure that the sheet is aligned with the reference line on the roll cover.
- Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-panel display.
- Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, please follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects the sheet from the front of the printer.

### Paper loading error messages

Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

<table>
<thead>
<tr>
<th>Front-panel message</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close the roll cover when the paper load is finished</td>
<td>Close the roll cover when the paper load is finished.</td>
</tr>
<tr>
<td>Lever lifted</td>
<td>During the load process the blue lever was lifted. This prevents the printer from loading the paper. Follow the instructions on the front-panel display.</td>
</tr>
<tr>
<td>Paper incorrectly loaded</td>
<td>The paper has not been loaded correctly. Lift the blue lever, remove the paper and lower the lever.</td>
</tr>
<tr>
<td>Paper loaded with too much skew</td>
<td>During the paper load process the printer detected that the paper had too much skew. Follow the instructions on the front-panel display.</td>
</tr>
<tr>
<td>Paper loose around core</td>
<td>The end of the roll has become loose around the core. Tighten the paper to the core or insert a new roll.</td>
</tr>
<tr>
<td>Paper not detected</td>
<td>During the paper load process the printer did not detect any paper. Ensure the paper is inserted fully and is not transparent.</td>
</tr>
<tr>
<td>Paper too big</td>
<td>During the load process the printer has detected that the paper is either too wide or too long (sheet only) to be loaded correctly. Press the Cancel key to stop the load process. See Functional specifications on page 184.</td>
</tr>
<tr>
<td>Paper too small</td>
<td>During the load process the printer detected that the paper is too narrow or too short to be loaded in the printer. Press the Cancel key to stop the load process. See Functional specifications on page 184.</td>
</tr>
<tr>
<td>Roll cover closed during paper load process</td>
<td>Do not close the roll cover until you are prompted to do so by the front panel.</td>
</tr>
<tr>
<td>Upper roll load and paper is inserted through the single sheet path</td>
<td>Avoid inserting roll paper into the cut sheet slot.</td>
</tr>
</tbody>
</table>

### The paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver, however, you must identify whether your paper is transparent or translucent, glossy or matte.
NOTE: For glossy paper, it is important to use a glossy paper type, as matte black ink does not print well on glossy paper.

Transparent or translucent paper

If your paper is a transparent film (for example, a transparency), select paper type Film > Transparent/Clear film.

If your paper is a translucent paper (for example, technical paper), select paper type Technical paper > Natural Tracing Paper, Vellum or Translucent bond.

Glossy paper

If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select paper type Photo Gloss Paper. For Semi-gloss, Satin, Pearl or Luster finishes, select paper type Semi-gloss/Satin Paper.

To increase gamut on photo paper, select paper type HP Universal High-Gloss Photo Paper or HP Universal Semi-Gloss Photo Paper, depending on the finish.

Matte Paper

Your paper type selection for matte paper depends on the paper’s ink absorption capacity. To select a paper category and type, first identify if your paper is general purpose or photographic. Then select the recommended paper types.

General-purpose paper

- For natural tracing papers, select paper type Natural Tracing Paper < 65 g/m² or Natural Tracing Paper > 65 g/m², depending on the weight of the paper.
- For thin papers (< 90 g/m²) uncoated papers (for example plain paper or bright white paper) select paper type Bond and Coated Paper > Plain Paper.
- For light coated papers (< 110 g/m²), select paper type Bond and Coated Paper > HP Coated Paper.
- For heavyweight coated papers (< 200 g/m²), select paper type Bond and Coated Paper > Heavyweight Coated Paper.
- For cockle-free very thick coated papers (> 200 g/m²), select paper type Bond and Coated Paper > Super Heavyweight Coated Paper.

Photographic paper

For photographic paper, select paper type Photo Paper > Photo Matte Paper.

Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink. To use non-matte black ink, select paper type Photo Paper > Photo Gloss Paper.

After printing, the paper has wrinkles or there is too much ink

This happens when too much ink is used. To use less ink, select a thinner category. Matte paper categories from thinnest to thickest are:

- Plain Paper
- Coated Paper
The printer printed on the wrong paper type

If the printer prints your job before you were able to load your desired paper, you may have Any selected for the Paper Type in the printer driver. When Any is selected the printer will print immediately on whichever paper is loaded. Load your desired paper, see Paper handling on page 31, and select your paper type specifically in the driver.

- In the Windows driver dialog: select the Paper/Quality tab, then select your paper type from the Paper Type list.
- In the Mac OS Print dialog (T770, T1200): select the Paper/Quality panel, then select your paper type from the Paper Type list.
- In the Mac OS X 10.5 or 10.6 PostScript Print dialog (PostScript printers): select the Paper/Quality panel, then select your paper type from the Paper Type list.
- In the Mac OS X 10.4 PostScript Print dialog (PostScript printers): select the Image Quality panel, then select your paper type from the Paper Type list.

**NOTE:** Any is the driver default.

An “on hold for paper” message (T1200 series only)

Based on a set of conditions that you can set when sending a job (see Paper mismatch action on page 21), the printer will decide which of the loaded rolls of paper is more suitable to print the job. If there is no roll of paper available that meets all the conditions, the printer will put the job on hold for paper. You can manually resume the job, forcing it to print on a paper other than the one originally specified, otherwise it will stay on hold.

Which criteria are used to decide on which roll a job will be printed?

When a user sends a job, the desired paper type can be set (in the driver or in the Embedded Web Server). The printer will print the job on a roll of paper of the chosen paper type that is large enough to print the drawing without clipping. If there is more than one roll on which the job could be printed meeting all the criteria, the roll will be chosen according to your preferences. These can be set from the printer’s front panel: see Roll switching options on page 21.

When is a job put on hold for paper?

If the paper mismatch action is set to Put job on hold (see Paper mismatch action on page 21), a job is put on hold for paper in the following cases:

- The paper type that has been selected by the user is not currently loaded on the specified roll—or on either of the rolls, if no roll has been specified.
- The paper type that has been selected by the user is loaded on the specified roll, but the drawing is too large to fit on the roll—or on either of the rolls, if no roll has been specified.

If I load a new roll of paper, will jobs that were on hold for paper be automatically printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper that could be printed on the loaded roll.
I don’t like jobs being put on hold for paper. Can I prevent it?

Yes, this can be done from the front panel: see Paper mismatch action on page 21.

I set the option “Paper mismatch action” to Print anyway, but some jobs are still put on hold

If the Show print preview option is selected in the driver or the Embedded Web Server, jobs are put on hold until you have checked the preview and resumed the job. Check that the Show print preview option is not checked in the driver, and that there are no pending preview windows waiting for confirmation to continue printing.

My job is exactly as wide as the roll of paper that is loaded on the printer, but is put on hold for paper

Margins are managed in different ways depending on the file type:

- For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 914 mm (36 in) HP-GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be put on hold for paper.

- For other file formats, such as PostScript, PDF, TIFF or JPEG, the printer assumes that margins need to be added outside the drawing (as, in many cases, these formats are used for photographs and other images that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the printer needs to add margins, and the drawing needs 925 mm (36.4 in) of paper to be printed; this would cause the job to be put on hold if the paper that is loaded on the printer is only 914 mm (36 in) wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip contents by margins option can be used. This option will force the margins to be set inside of the drawing, so a 914 mm (36 in) TIFF can be printed on a 914 mm (36 in) roll of paper without being put on hold. However, if there is no white space already included in the drawing’s borders, some contents could be clipped because of the margins.

The roll paper will not advance

If you have pushed the printer up against a wall, the roll may be touching the wall at the rear of the printer. Use the wall spacers to ensure a minimum distance between printer and wall. See The wall spacers on page 7.
The paper has jammed

When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display.

1. Power off the printer at the front panel and also switch it off at the rear.

2. Open the window.

3. Try to move the printhead carriage out of the way.
4. Lift the blue lever as far up as it will go.

5. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

⚠️ **CAUTION:** Do not move the paper sideways, as it could damage the printer.

6. Rewind the roll. If the paper is stuck and cannot be rewound further, cut it from the roll.

7. Remove all pieces of paper from the rear of the printer.
8. Lower the blue lever.

9. Close the window.

10. Switch on the printer.

11. Reload the roll, or load a new sheet see Paper handling on page 31.

NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the procedure and carefully remove all pieces of paper.

A strip stays on the output tray and generates jams

If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a full-bleed print or after the Form feed and cut key \( \text{has been pressed, the cut strip remains in the output tray. Only when the printer is not working, reach in the tray and remove the strip.} \)
The printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket

- Ensure the basket is correctly installed.
- Ensure the basket is open.
- Ensure the basket not full.
- Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or remove prints manually as they are completed.

The sheet stays in the printer when the print has been completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time on page 44. If the paper is only partially ejected after the drying time, gently pull the sheet out of the printer. If the automatic cutter is disabled, use the Form feed and cut key on the front panel, see Feed and cut the paper on page 45.

The paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed, see Change the drying time on page 44. You can disable the cutter, see Turn the automatic cutter on and off on page 45.

The cutter does not cut well

By default the printer is set to automatically cut the paper after the drying time has been completed.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any obstacles.

The roll is loose on the spindle

The roll may need to be replaced or reloaded.
Recalibrate the paper advance

Accurate paper advance is important to image quality because it is part of controlling the proper placement of dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate the rate at which the paper advances. See Troubleshooting print-quality issues on page 147 for steps to determine if paper advance calibration will solve your issue.

You can check the paper advance calibration status of the currently loaded paper at any time by pressing the View information key on the front panel. The status may be one of the following.

- **DEFAULT**: This status appears when loading any paper that has not been calibrated. HP papers in the Front Panel have been optimized by default and unless you experience image quality problems in your printed image such as banding or graininess it is not recommended to recalibrate the paper advance.

- **OK**: This status indicates that the loaded paper has been calibrated before. However you may need to repeat the calibration if you experience image quality problems such as banding or graininess in your printed image.

**NOTE:** Whenever you update the printer’s firmware, the paper advance calibration values are reset to factory default, see Update the firmware on page 125.

**CAUTION:** Transparent papers and films must be calibrated using Image Quality Maintenance menu icon, then Paper advance calibration > Adjust paper advance, from step four in Recalibrating the paper advance procedure.

Recalibrating the paper advance procedure

1. From the front panel, select the Image Quality Maintenance menu icon, then Paper advance calibration > Calibrate paper advance. The printer automatically recalibrates the paper advance and prints a paper advance calibration image.

2. Wait until the front panel displays the status screen and re-print your print.

**NOTE:** The recalibration procedure takes approximately three minutes. Do not worry about the paper advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see improvement in your print, continue with step three. If you are dissatisfied with the recalibration, return to the default calibration, see Return to default calibration on page 146.

3. If you would like to fine-tune the calibration or are using a transparent paper, select the Image Quality Maintenance menu icon, then Paper advance calibration > Adjust paper advance.
4. Select the percentage of change from –100% to +100%. To correct light banding, decrease the percentage.

To correct dark banding, increase the percentage.

5. Press the OK key on the front panel, to save the value.

6. Wait until the front panel displays the status screen and re-print your print.

**Return to default calibration**

Returning to the default calibration sets all the corrections made by the paper advance calibration to zero. To return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, select the Image Quality Maintenance menu icon then **Paper advance calibration > Reset paper advance**.

2. Wait until the front panel displays the operation has completed successfully.
16 Troubleshooting print-quality issues

- General advice
- Print quality troubleshooting wizard
- Horizontal lines across the image (banding)
- Lines are too thick, too thin or missing
- Lines appear stepped or jagged
- Lines print double or in the wrong colors
- Lines are discontinuous
- Lines are blurred
- Line lengths are inaccurate
- The whole image is blurry or grainy
- The paper is not flat
- The print is scuffed or scratched
- Ink marks on the paper
- Black ink comes off when you touch the print
- Edges of objects are stepped or not sharp
- Edges of objects are darker than expected
- Horizontal lines at the end of a cut sheet print
- Vertical lines of different colors
- White spots on the print
- Colors are inaccurate
- Colors are fading
- The image is incomplete (clipped at the bottom)
- The image is clipped
- Some objects are missing from the printed image
- A PDF file is clipped or objects are missing
- The Image Diagnostics Print
- If you still have a problem
General advice

When you have any print-quality problem:

- To achieve the best performance from your printer, use only genuine manufacturer's supplies and accessories, whose reliability and performance have been thoroughly tested to give trouble-free performance and best-quality prints. For details of recommended papers, see Order paper on page 129.

- Make sure that the paper type selected in the front panel is the same as the paper type loaded into the printer. To check this, use the View information key on the front panel. At the same time, check that the paper type has been calibrated. Also make sure that the paper type selected in your software is the same as the paper type loaded into the printer.

⚠️ CAUTION: If you have the wrong paper type selected, you could experience poor print quality and incorrect colors, and perhaps even damage to the printheads.

- Check that you are using the most appropriate print-quality settings for your purposes (see Printing on page 49). You are likely to see lower print quality if you have moved the print-quality slider to the 'Speed' end of the scale, or set the custom quality level to Fast.

- Check that your environmental conditions (temperature, humidity) are in the recommended range. See Environmental specifications on page 186.

- Check that your ink cartridges and printheads have not passed their expiration dates: see Maintain the ink cartridges on page 124.

Print quality troubleshooting wizard

The Print Quality Troubleshooting Wizard can help with the following problems:

- Horizontal lines across the image (banding)
- The whole image is blurry or grainy
- Lines are too thick, too thin or missing
- Colors are inaccurate

To start the wizard:

- From the HP Utility for Windows: go to the Support tab, and select Print quality troubleshooting.

- From the HP Utility for Mac OS: select Print quality troubleshooting in the Support group.

- From the Mac OS Print dialog: go to the Services panel, select Device Maintenance, then select Print quality troubleshooting from the list of maintenance tasks.

- From the Embedded Web Server: go to the Support tab, select Troubleshooting, then select Print quality troubleshooting.
Alternatively, or if you have other print quality problems, you can continue reading this chapter.

**Horizontal lines across the image (banding)**

If your printed image suffers from added horizontal lines as shown (the color may vary):

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. To check on the front panel, use the View information key.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 49). In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-quality settings, you may wish to reprint your job at this point in case the problem has been solved.

3. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 160.

4. If the printheads are working correctly, go to the front panel and press the View information key to see the paper advance calibration status. If the status is DEFAULT, try performing paper advance calibration: see Recalibrate the paper advance on page 145.

If the problem persists despite all the above actions, contact your customer service representative for further support.
Lines are too thick, too thin or missing

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. To check on the front panel, use the View information key.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 49). Select the custom print-quality options in the driver dialog, and try turning on the Maximum detail option (if available). You may wish to reprint your job at this point in case the problem has been solved.

3. If the resolution of your image is greater than the printing resolution, you may notice a loss of line quality. If you are using the PCL or the HP-GL/2 and HP RTL driver for Windows, you can find the Max. Application Resolution option in the driver dialog’s Advanced tab, under Document Options > Printer Features. If you change this option, you may wish to reprint your job at this point in case the problem has been solved.

4. If lines are too thin or missing, print the Image Diagnostics Print. See The Image Diagnostics Print on page 160.

5. If the problem remains, go to the front panel and select the Ink menu icon then Printhead information to see the printhead alignment status. If the status is PENDING, you should align the printheads. See Align the printheads on page 168. After alignment, you may wish to reprint your job in case the problem has been solved.

6. Go to the front panel and press the View information key to see the paper advance calibration status. If the status is DEFAULT, you should perform paper advance calibration: see Recalibrate the paper advance on page 145.

If the problem persists despite all the above actions, contact your customer service representative for further support.

Lines appear stepped or jagged

If lines in your image appear stepped or jagged when printed:
1. The problem may be inherent in the image. Try to improve the image with the application you are using to edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 49.

3. Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option (if available).

### Lines print double or in the wrong colors

This problem can have various visible symptoms:

- Colored lines are printed double, in different colors.

- The borders of colored blocks are wrongly colored.
To correct this kind of problem:

1. Reseat the printheads by removing them and then reinserting them. See Remove a printhead on page 117 and Insert a printhead on page 120.
2. Align the printheads. See Align the printheads on page 168.

**Lines are discontinuous**

If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings. See Printing on page 49.
2. Reseat the printheads by removing them and then reinserting them. See Remove a printhead on page 117 and Insert a printhead on page 120.
3. Align the printheads. See Align the printheads on page 168.

**Lines are blurred**

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing. See Environmental specifications on page 186.
2. Check that the paper type selected in the front panel is the same as the paper type you are using. To check on the front panel, use the View information key ⬇️.
3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight Plus Matte Paper.
4. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.
5. If you are using glossy paper, try changing to a different type of glossy paper.

6. Align the printheads. See Align the printheads on page 168.

**Line lengths are inaccurate**

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your purposes, you can try to improve line length accuracy in the following ways.

1. Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional specifications on page 184.
   
   Polyester film is about ten times more dimensionally stable than paper. However, using film that is thinner or thicker than HP Matte Film will reduce line length accuracy.

2. Set the Print Quality slider to Quality.

3. Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).

4. Load the roll of film and let it rest for five minutes before printing.

5. If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance on page 145.

**The whole image is blurry or grainy**

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. To check on the front panel, use the View information key.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 49). In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-quality settings, you may wish to reprint your job at this point in case the problem has been solved.

4. Go to the front panel and select the Ink menu icon, then Printhead information to see the printhead alignment status. If the status is PENDING, you should align the printheads. See Align.
After alignment, you may wish to reprint your job in case the problem has been solved.

5. Go to the front panel and press the View information key to see the paper advance calibration status. If the status is DEFAULT, you should perform paper advance calibration: see Recalibrate the paper advance on page 145.

If the problem persists despite all the above actions, contact your customer service representative for further support.

The paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes saturated with ink.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. To check on the front panel, use the View information key.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight Plus Matte Paper.

3. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

The print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This is particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after printing, depending on the amount of ink used and the environmental conditions at the time of printing.
To reduce the risk of scuffs and scratches:

- Handle prints carefully.
- Avoid stacking prints on top of each other.
- Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively, leave a sheet of paper in the basket so that freshly printed sheets do not make direct contact with the basket.

**Ink marks on the paper**

This problem can occur for several different reasons.

**Horizontal smears on the front of coated paper**

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the printheads move over the paper, the printheads may come into contact with the paper and smear the printed image. This problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Press the **Cancel** key and also cancel the job from your computer application. Soaked paper can damage the printheads.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. To check on the front panel, use the **View information** key.
2. Use a recommended paper type (see Order paper on page 129) and the correct print settings.
3. If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect performance.
4. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper and HP Super Heavyweight Plus Matte Paper.
5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.
6. Try to increase the margins by relocating the image to the center of the page using your software application.

**Ink marks on the back of the paper**

This can happen after a lot of borderless printing, especially with non-standard paper sizes. Ink residues on the platen are likely to mark the back of the paper.
Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.

**Black ink comes off when you touch the print**

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select Photo Glossy Paper as the paper type (in the Photo Paper category).

**Edges of objects are stepped or not sharp**

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the print-quality slider to **Quality** in the driver dialog, select the custom print-quality options, and try setting the quality level to **Normal**. See [Printing on page 49](#).

**Edges of objects are darker than expected**

If edges of objects seem darker than expected, and you have already set the print-quality slider to **Quality** in the driver dialog, select the custom print-quality options, and try setting the quality level to **Normal**. See [Printing on page 49](#).

**Horizontal lines at the end of a cut sheet print**

This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the paper. You may see some very thin horizontal lines across the print.

To avoid this problem:

1. Print the Image Diagnostics Print. See [The Image Diagnostics Print on page 160](#).
2. Consider printing with roll paper.
3. Consider using larger margins around your image.
**Vertical lines of different colors**

If your print has vertical bands of different colors along it:

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated Paper and HP Super Heavyweight Paper. See Order paper on page 129.

2. Try using higher print-quality settings (see Printing on page 49). For instance, if you have set the Print Quality slider to Speed, try setting it to Quality.

**White spots on the print**

You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating material. To avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.

2. Always keep the cover of your printer closed.

3. Protect your paper rolls and sheets by storing them in bags or boxes.

**Colors are inaccurate**

If the colors of your print do not match your expectations, try the following:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. To check on the front panel, use the View information key. At the same time, check the color calibration status. If the status is PENDING or OBSOLETE, you should perform color calibration: see Color calibration on page 66. If you have made any changes, you may wish to reprint your job in case the problem has been solved.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 49). If you have selected the Speed or Fast options, you may not get the most accurate colors. If you change the print-quality settings, you may wish to reprint your job at this point in case the problem has been solved.

4. If you are using Application Color Management, check that the color profile you are using corresponds to the selected paper type and print-quality settings. If you have doubts about which color settings to use, see Color management on page 65.

5. If the problem consists of color differences between your print and your monitor, please follow the instructions in the “How to calibrate your monitor” section of the HP Color Center. At this point, you may wish to reprint your job in case the problem has been solved.
6. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 160.

7. Try using the color adjustment options to produce the colors you want. See Color adjustment options on page 69.

If the problem persists despite all the above actions, contact your customer service representative for further support.

Color accuracy using EPS or PDF images in page layout applications

Page layout applications such as Adobe InDesign and QuarkXPress do not support color management of EPS, PDF or grayscale files.

If you have to use such files, try to ensure that the EPS, PDF or grayscale images are already in the same color space that you intend to use later on in Adobe InDesign or QuarkXPress. For instance, if your final goal is to print the job in a press that follows the SWOP standard, convert the image into SWOP when you create it.

Colors are fading

If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more than two weeks, you should laminate them to achieve longer life.

Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life of prints (depending on the type of lamination) with all paper types. For more information, consult your laminate provider.

The image is incomplete (clipped at the bottom)

- Did you press Cancel before all the data were received by the printer? If so, you have ended the data transmission and will have to print the page again.
- The I/O timeout setting may be too short. This setting determines how long the printer waits for the computer to send more data, before deciding that the job is finished. From the front panel, increase the I/O timeout setting to a longer period and then send the print again. From the Connectivity menu, select Advanced > Select I/O timeout.
- There may be a communications problem between your computer and the printer. Check your USB or network cable.
- Check to make sure that your software settings are correct for your current page size (for example, long-axis prints).
- If you are using network software, make sure it has not timed out.

The image is clipped

Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the printable area as understood by your software. You can often identify this kind of problem before printing by previewing your print (see Preview a print on page 56).

- Check the actual printable area for the paper size you have loaded.
  
  printable area = paper size – margins

- Check what your software understands to be the printable area (which it may call "printing area" or "imageable area"). For example, some software applications assume standard printable areas that are larger than those used in this printer.
• If you have defined a custom page size with very narrow margins, the printer may impose its own minimal margins, clipping your image slightly. You may want to consider using a larger paper size, or borderless printing (see Select margins options on page 52).

• If your image contains its own margins, you may be able to print it successfully by using the Clip Contents by Margins option (see Select margins options on page 52).

• If you are trying to print a very long image on a roll, check that your software is capable of printing an image of that size.

• You may have asked to rotate the page from portrait to landscape on a paper size that is not wide enough.

• If necessary, reduce the size of the image or document in your software application, so it fits between the margins.

There is another possible explanation for a clipped image. Some applications, such as Adobe Photoshop, Adobe Illustrator and CorelDRAW, use an internal 16-bit coordinate system which means that they cannot handle an image of more than 32,768 pixels.

NOTE: An image 32,768 pixels long would print at a length of 1.39 m (54.61 in) if you select Best or Quality in the driver, 2.78 m (109.23 in) if you select Fast, Normal or Speed in the driver.

• If you try to print an image larger than this from these applications, the bottom of the image may be clipped. To print the whole image, try these suggestions:

  ● Try using the PostScript printer driver to print your job, if you have not already tried it.

  ● The Windows HP-GL/2 and HP RTL driver dialog includes an option called Max. application resolution, which enables you to print successfully in this situation. You will not normally need to change the default setting, which is Auto. However, you can find the option in the Advanced tab, under Document Options > Printer Features.

  ● Save the file in another format, such as TIFF or EPS, and open it with another application.

  ● Use a RIP to print the file.

Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific workflows there may be issues that can lead to some objects missing from the output. Here are some suggestions to help you to avoid this problem.

• Try using the PostScript printer driver to print your job, if you have not already tried it.

• Select a smaller page size and scale to the desired final page size in the driver or in the front panel.

• Save the file in another format, such as TIFF or EPS, and open it with another application.

• Use a RIP to print the file.

• Reduce the resolution of bitmap images in your application software.

• Select a lower print quality in order to reduce the resolution of the printed image.

NOTE: If you are working under Mac OS, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality or the time necessary to generate the print job. Therefore, they should be cancelled if they do not help to solve the problem.
A PDF file is clipped or objects are missing

In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some objects when printing with the HP-GL/2 and HP RTL driver at high resolution. In order to avoid such problems, upgrade your Adobe Acrobat or Adobe Reader software to the latest version. From version 7 onwards, these problems should be solved.

The Image Diagnostics Print

The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It helps you to check the performance of the printheads that are currently installed in your printer, and whether any printhead suffers from clogging or other problems.

To print the Image Diagnostics Print:

1. Use the same paper type that you were using when you detected a problem.
2. Use the View information key on the front panel to check that the selected paper type is the same as the paper type loaded into the printer.
3. At the printer’s front panel, select the Image Quality Maintenance menu icon, then Print diagnostic image.

It takes about two minutes to print the Image Diagnostics Print.

The print is divided into two parts, both of which test printhead performance.

- Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the print quality that you will get from each color.
- Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part complements the first, and aims more specifically to detect how many faulty nozzles each printhead has.

Please look carefully at the print. The names of the colors are shown above the rectangles and in the center of the patterns of dashes.
First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without any horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of the dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing dashes in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a gray printhead in a good state:

And here is an example of the same printhead in a bad state:

**Corrective action**

1. Clean any faulty printheads (see Clean the printheads on page 165). Then reprint the Image Diagnostics Print to see whether the problem has been solved.

2. If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see whether the problem has been solved.

3. If the problem remains, consider cleaning your printheads manually (see Clean the printheads on page 165). You could also try reprinting your current print job, in case it now prints satisfactorily.
4. If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you when this is necessary, but it may be worth trying even if the printer has not suggested it. See Clean the printhead drop detector on page 165.

5. If the problem still remains, replace any persistently faulty printheads (see Handling ink cartridges and printheads on page 112), or contact HP Support (see Contact HP Support on page 182).

If you still have a problem

If you still experience print-quality problems after applying the advice in this chapter, here are some further things that you can do:

- Try using a higher print-quality option. See Printing on page 49.
- Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be downloaded from http://www.hp.com/go/T770/drivers/ or http://www.hp.com/go/T1200/drivers/.
- If you are using a non-HP RIP, its settings may be incorrect. See the documentation that came with the RIP.
- Check that your printer's firmware is up to date. See Update the firmware on page 125.
- Check that you have the right settings in your software application.
17 Troubleshooting ink cartridge and printhead issues

- Cannot insert an ink cartridge
- Ink cartridge status messages
- Cannot insert a printhead
- The front-panel display recommends reseating or replacing a printhead
- Clean the printheads
- Clean the printhead drop detector
- Align the printheads
- Printhead status messages
Cannot insert an ink cartridge

1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the slot.
3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side up and readable.

⚠️ CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:

- **OK**: the cartridge is working normally, with no known problems.
- **Missing**: there is no cartridge present, or it is not correctly connected to the printer.
- **Low**: the ink level is low.
- **Very low**: the ink level is very low.
- **Empty**: the cartridge is empty.
- **Reseat**: you are recommended to remove the cartridge and then reinsert it.
- **Replace**: you are recommended to replace the cartridge with a new cartridge.
- **Altered**: there is something unexpected about the cartridge's status.
- **Expired**: it is past the cartridge's expiration date.

Cannot insert a printhead

1. Check that you have the correct type of printhead (model number).
2. Check that you have removed the two orange protective caps from the printhead.
3. Check that the colored label on the printhead is the same color as the label on the slot.
4. Check that the printhead is correctly oriented (compare with the others).
5. Check that you have correctly closed and latched the printhead cover, see Insert a printhead on page 120.

The front-panel display recommends reseating or replacing a printhead

1. From the front panel, turn the power off then on.
2. Check the front-panel display message, if it shows the ready message, the printer is ready to print. If the problem remains continue with the next step.
3. Remove the printhead, see Remove a printhead on page 117.
4. Clean the electrical connections on the backside of the printhead with a lint free cloth. You can carefully use a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

⚠️ **CAUTION:** This is a delicate process and may damage the printhead. Do not touch the nozzles on the bottom side of the printhead, especially not with any alcohol.

5. Reinsert the printhead, see [Insert a printhead on page 120](#).

6. Check the front-panel display message. If the problem remains, try a new printhead.

---

### Clean the printheads

As long as the printer is kept turned on, an automatic cleaning is performed periodically. This ensures there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If you have not already done so, please see [The Image Diagnostics Print on page 160](#) before proceeding.

To clean the printheads, go to the front panel and select the Image Quality Maintenance menu icon 📊, then **Clean printheads**. If you have gone through the Image Quality Diagnostic print process, you know which colors are failing. Select the pair of printheads which contain the failing colors. If you are not sure which colors to clean, you can also select to clean all printheads. Cleaning all printheads takes about nine minutes. Cleaning a single pair of printheads takes about six minutes.

💡 **NOTE:** Cleaning all printheads uses more ink than cleaning a single pair.

### Clean the printhead drop detector

The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in order to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block the sensor print-quality is affected.

When the front panel displays a warning message that the clean process is needed, you are recommended to clean the printhead drop detector. If you do not clean the printhead drop detector immediately, the printer continues working normally, however, the front panel display continues to show the warning.

⚠️ **CAUTION:** Wear gloves to avoid getting ink on your hands.
1. Turn off the printer at the front panel.

2. To avoid an electric shock, switch the printer off and unplug it.

3. Open the window.
4. Find the printhead drop detector beside the stored printhead carriage.

5. Remove any debris blocking the printhead drop detector.

6. With a dry lint free cloth, wipe the surface of the drop detector to remove any non-visible debris.

7. Close the window.
8. Plug in and switch on the printer.

9. Power the printer on at the front panel.

**Align the printheads**

Precise alignment between printheads is essential for accurate colors, smooth color transitions and sharp edges in graphical elements. Your printer has an automatic printhead alignment process which runs whenever a printhead has been accessed or replaced.

In cases where the paper has jammed or you are experiencing problems with color accuracy, see **Color management on page 65**; you may need to align the printheads.

**NOTE:** If the paper has jammed, it is recommended that you reinsert the printheads and initiate the realignment procedure with the Image Quality Maintenance menu.

**CAUTION:** Do not use transparent or semi-transparent paper to align the printheads.

**Reinsert printheads procedure**

1. If the realignment process is running and the wrong paper is loaded, press the Cancel key on the front panel.

   **CAUTION:** Do not print if the realignment process has been canceled. You can restart the alignment with the Image Quality Maintenance menu procedure.

2. Load the paper you wish to use, see **Paper handling on page 31**. You can use a roll or cut sheet, however, it must be A3 landscape or larger.

   **CAUTION:** Do not use transparent or semi-transparent paper to align the printheads.

3. Remove and re-insert all the printheads, see **Remove a printhead on page 117** and **Insert a printhead on page 120**. This starts the printhead alignment procedure.
4. Ensure the window is closed, as a strong light source near the printer during printhead realignment can affect alignment.

5. The process takes about six minutes. Wait until the front-panel display shows the process complete before using the printer.

**NOTE:** The printer prints a calibration image. Do not worry about the image. The front-panel display shows any errors in the process.

### Image Quality Maintenance menu procedure

1. Load the paper you wish to use, see Paper handling on page 31. You can use a roll or cut sheet, however, it must be A3 landscape or larger (420 by 297 mm).

   △ **CAUTION:** Do not use transparent or semi-transparent paper to align the printheads.

2. From the front panel, select the Image Quality Maintenance menu icon then **Align printheads**. The printer checks to see if it has enough paper to run the realignment.

3. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern. Ensure the window is closed, as a strong light source near the printer during printhead realignment can affect alignment.

4. The process takes about five minutes. Wait until the front-panel display shows the process complete before using the printer.
Scanning errors during alignment

If the alignment process fails, a Scanning problems message appears on the front panel. This means that the alignment has not completed successfully. Therefore the printer is not aligned and the alignment should be repeated before printing with good image quality. The problem may be due to:

- The paper used was not valid, repeat the alignment with valid paper
- Printhead health problems, clean printheads, see Clean the printheads on page 165
- The alignment was done with the window open, repeat the alignment with the window closed

If the problem persists after using valid paper, cleaning the printheads and keeping the window closed, there may be a failure in the scanning system needing reparation or the printheads, although clean, may not work and need to be replaced.

Printhead status messages

These are the possible printhead status messages:

- **OK**: the printhead is working normally, with no known problems
- **Missing**: there is no printhead present, or it is not correctly installed in the printer.
- **Test printhead separately**: you are recommended to test the prinheads individually to find the failing printhead. Remove all the prinheads and insert them alone one by one, closing the latch and the carriage cover after every insertion. The front-panel display indicates the failing one showing the reseat or replace message.
- **Reseat**: you are recommended to remove the printhead and then reinsert it. If that fails, clean the electrical connections, see The front-panel display recommends reseating or replacing a printhead on page 164. If that fails, replace the printhead with a new printhead, see Remove a printhead on page 117 and Insert a printhead on page 120.
- **Replace**: the printhead is failing. Replace the printhead with a working printhead, see Remove a printhead on page 117 and Insert a printhead on page 120.
- **Replacement incomplete**: a printhead replacement process has not completed successfully, re-launch the replacement process and let it finish completely (it is not needed to change the printheads).
- **Remove**: the printhead is not a suitable type for use in printing.
18 Troubleshooting general printer issues

- The printer will not start
- The printer does not print
- The printer seems slow
- Communication failures between computer and printer
- Cannot access the HP Utility
- Cannot access the Embedded Web Server
- Automatic file system check
- An AutoCAD 2000 memory allocation error
- No output when printing from Microsoft Visio 2003
- Unavailable driver features when printing from QuarkXpress
- Printer alerts
The printer will not start

If the printer will not start (the front panel is blank or the diagnostic LEDs are all off), you are recommended to replace the firmware, in the following way.

1. Go to the Knowledge Center (see Knowledge Center on page 180) and download the firmware.
2. Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted with the FAT filesystem.
3. Ensure that the printer is turned off. Connect the USB flash drive to the printer’s USB port, then turn the printer on.
4. When prompted by the front panel, press the OK key.
5. The printer takes about a minute to read the firmware file, then asks you to remove the USB flash drive.
6. The printer automatically installs the new firmware and restarts the printer.

The printer does not print

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why a file you have sent from your computer may not start printing when expected:

- You may have an electrical power problem. If there is no activity at all from the printer, and the front panel does not respond, check that the power cable is connected correctly and that there is power available at the socket.
- You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this case, turn off the printer using the Power key on the front panel and unplug the power cord, wait until the electromagnetic environment has returned to normal, then turn it on again. If you still experience problems, please contact your customer service representative.
- Nesting may be on (T1200 series only) and the printer is waiting for the specified nest wait time before calculating the appropriate nests. In this case, the front panel shows the remaining time needed for nesting.
- You may have the wrong graphic language setting, see Change the graphic language setting on page 30.
- You may not have installed in your computer the correct driver for your printer, see the Assembly instructions.
- If you are printing on a sheet, you must specify Manual Feed as the paper source in your printer driver.
- The printer may be holding the job for paper or (T1200 series only) accounting information, see Job status messages (T770 HD and T1200 series only) on page 107.
- You may have requested a print preview (T1200 series only) from your printer driver. This is a function you can use to check that the image is the one you want. In this case, the preview is displayed on your screen, and you must click the Print button to start printing.
- If you are using Mac OS with a USB connection, you may find that you need to change the data encoding (PostScript printers only). Select the Setup menu icon ☰, then Printing preferences > PS > Select encoding > ASCII. Then configure your application to send ASCII data.
The printer seems slow

Here are some possible explanations.

- Did you set the print-quality to Best or Max Detail? Best-quality and maximum detail prints take longer.
- Did you specify the correct paper type when loading the paper? Some paper types require more time for printing; for example, photo and coated papers require more drying time between passes. To find out the printer’s current paper type setting, see View information about the paper on page 42.
- If your printer is connected by network, check that all components used in the network (network interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of traffic from other devices on the network?
- If your printer is connected by USB, make sure that the USB host controller and the USB hubs used (if any) are USB 2.0; and check that the USB cables are USB 2.0 certified.
- Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.

Communication failures between computer and printer

Some symptoms are:

- The front-panel display does not show the Receiving message when you have sent an image to the printer.
- Your computer displays an error message when you are trying to print.
- Your computer or printer hangs (stays idle), while communication is taking place.
- Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

- Ensure that you have selected the correct printer in your application, see Printing on page 49.
- Ensure that the printer works correctly when printing from other applications.
- Remember that very large prints may take some time to receive, process and print.
- If the printer is connected to a network, try using it when connected directly to your computer through a USB cable.
- If your printer is connected to your computer through any other intermediate devices, such as switch boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to your computer.
- Try another interface cable.
- Ensure that the graphic language setting is correct, see Change the graphic language setting on page 30.
- If the printer is connected with a USB, try to disconnect and reconnect the USB cable with the computer. Also try using a different USB port on the computer.
Cannot access the HP Utility

If you have not done so already, please read Access the HP Utility on page 27.

1. From the front panel, select the Connectivity menu icon.

2. Select Advanced > Web Services > HP Utility Software > Enable.

3. If you have a TCP/IP connection to your printer, press the Menu key to return to the main menu and select the Connectivity menu icon again.

4. Select the type of connection you are using.

5. Select View Information.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Cannot access the Embedded Web Server

If you have not done so already, please read Access the Embedded Web Server on page 27.

NOTE: If you connect directly to your printer with a USB cable, use the HP Utility.

1. From the front panel, select the Connectivity menu icon.

2. Select Advanced > Embedded Web Server > Allow EWS > On.

3. If you have a TCP/IP connection to your printer, press the Menu key to return to the main menu and select the Connectivity menu icon again.

4. Select the type of connection you are using.

5. Select View Information.

6. Ensure that you see IP enabled. If not, you may need to use a different connection.

If you are using a proxy server, try bypassing the server and accessing the Web server directly.

- In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more precise control, click the Advanced button and add the printer's IP address to the list of exceptions, for which the proxy server is not used.

- In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change Settings button. Add the printer's IP address or its domain name to the list of exceptions, for which the proxy server is not used.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Automatic file system check

When you turn on the printer, you will occasionally see a front panel display similar to the one shown below.
A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

⚠️ CAUTION: If you turn the printer off before the file system check has finished, the file system could be seriously damaged, making the printer's hard disk unusable. In any case, the file system check will restart from the beginning whenever you turn the printer on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk's file system integrity.

⚠️ NOTE: When the printer is powered back on, it takes about three minutes to initialize and check and prepare the printheads. However, it can take up to 40 under some conditions, for example, when the printer has not been used for a long period of time and requires more time to prepare the printheads.

An AutoCAD 2000 memory allocation error

After installing the printer driver, when you try to print for the first time from AutoCAD 2000, you may see a message saying Memory allocation error, after which your image is not printed.

This is due to a problem in AutoCAD 2000, and it can be fixed by downloading the Plotting Update Patch (plotupdate.exe) from the Autodesk Web site, http://www.autodesk.com/.

This patch is also worth trying if you have any other strange problems when printing from AutoCAD 2000.

No output when printing from Microsoft Visio 2003

For more information about problems when printing large images—more than 3.27 m (129 in) long—from Microsoft Visio 2003, see Microsoft's online knowledge base: http://support.microsoft.com/search/.

To avoid these problems, it is possible to scale the image down in Visio to a size shorter than 3.27 m (129 in) and then to scale the drawing up in the driver by using the Resizing Options in the Features tab of the Windows driver. If the down-scaling in the application and the up-scaling in the driver match, the result is as originally intended.

Unavailable driver features when printing from QuarkXpress

When you print from QuarkXPress, the following driver features are not available.

- Print Preview
- Rotation
- Resizing
- Microsoft Office features or paper saving options
- Back to front printing

If you are using the HP-GL/2 and HP RTL driver, the following features are not available.
- Print Preview
- Back to front printing

To get the same results, use the equivalent features available in QuarkXPress.

**Printer alerts**

Your printer can communicate two types of alerts:

- **Errors:** Mainly alerting you to the fact that the printer is unable to print. However, in the driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is able to print.

- **Warnings:** Alert you when the printer needs attention either for an adjustment, such as a calibration or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer's system.

- **Front-panel display:** The front panel shows only the most relevant alert at a time. It generally requires the user to press the OK key for confirmation, but in the case of a warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear when the printer becomes idle and there is not another more severe alert.

  **TIP:** From the front panel display you can configure paper mismatch alerts, see Paper suitability options (T1200 series only) on page 21.

- **Embedded Web Server:** The upper-right corner of the Embedded Web Server window shows the printer status. If there is an alert in the printer, the status shows the alert text.

- **Driver:** The driver shows alerts. The driver warns about job configuration settings that may produce a problem in the final output. If the printer is not ready to print, it displays a warning.

- **HP Utility:** To see alerts, go to the Overview tab and review the Items needing attention list on the right-hand side.

By default, alerts are only displayed when you are printing and there are printing problems, for example: cartridge low or out of ink or printer out of paper. If alerts are enabled and there is a problem that prevents printing, you see a pop-up window, which explains why the printer is not going to print. Follow the instructions to achieve your required result.

**NOTE:** There are environments that do not support bidirectional communication, for example: a Windows computer connected to the printer with USB. In those cases, alerts do not reach the job owner.
Occasionally you may see one of the following messages appear on the front-panel display. If so, please follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, contact HP Support. See Contact HP Support on page 182.

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Color] cartridge has expired</td>
<td>Replace the cartridge. See Handling ink cartridges and printheads on page 112.</td>
</tr>
<tr>
<td>[Color] cartridge is missing</td>
<td>Insert a cartridge of the correct color. See Handling ink cartridges and printheads on page 112.</td>
</tr>
<tr>
<td>[Color] cartridge is out of ink</td>
<td>Replace the cartridge. See Handling ink cartridges and printheads on page 112.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: not present</td>
<td>Insert the correct printhead. See Handling ink cartridges and printheads on page 112.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: please remove</td>
<td>Remove the incorrect printhead and insert a new printhead of the correct type (color and number). See Handling ink cartridges and printheads on page 112.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: reseat</td>
<td>Remove and reinset the same printhead, or try cleaning the electrical connections. If necessary, insert a new printhead. See The front-panel display recommends reseating or replacing a printhead on page 164.</td>
</tr>
<tr>
<td>[Color] printhead #[n] out of warranty</td>
<td>The printhead's warranty has expired, because of the length of time it has been in operation or because of the volume of ink used.</td>
</tr>
<tr>
<td>[Color] printhead #[n] warranty warning</td>
<td>The printhead's warranty may be invalidated by the use of the wrong kind of ink.</td>
</tr>
<tr>
<td>IO error</td>
<td>Restart the printer. If the problem persists, contact HP Support. See Contact HP Support on page 182.</td>
</tr>
<tr>
<td>IO warning</td>
<td>Try again; if the problem persists, contact HP Support. See Contact HP Support on page 182.</td>
</tr>
<tr>
<td>Paper advance calibration pending</td>
<td>Perform paper advance calibration. See Recalibrate the paper advance on page 145.</td>
</tr>
<tr>
<td>Paper too small to print paper advance calibration</td>
<td>Unload paper and load larger paper.</td>
</tr>
<tr>
<td>Paper too small to scan paper advance calibration</td>
<td>Unload paper and load larger paper.</td>
</tr>
<tr>
<td>PDL Error: Ink system not ready</td>
<td>Clean the printheads. See Clean the printheads on page 165.</td>
</tr>
<tr>
<td>Message</td>
<td>Recommendation</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PDL Error: Job clipped</td>
<td>The image is too large for the paper or for the printer. Load larger paper if possible, or reduce the image size.</td>
</tr>
<tr>
<td>PDL Error: memory full</td>
<td>Restart the printer and try resending the job; if necessary, reduce the complexity of the job.</td>
</tr>
<tr>
<td>PDL Error: out of paper</td>
<td>Load more paper.</td>
</tr>
<tr>
<td>PDL Error: parsing error</td>
<td>The print job is unintelligible to the printer. Try to recreate and resend it. Check your cable connections.</td>
</tr>
<tr>
<td>PDL Error: print mode error</td>
<td>The paper type or print quality specified for the job are incorrect. Change the loaded paper type or the print settings.</td>
</tr>
<tr>
<td>PDL Error: printing error</td>
<td>Try sending the job again.</td>
</tr>
<tr>
<td>PDL Error: virtual memory full</td>
<td>Restart the printer and try resending the job; if necessary, reduce the complexity of the job.</td>
</tr>
<tr>
<td>Printhead alignment error: paper too small</td>
<td>Unload paper and load larger paper.</td>
</tr>
<tr>
<td>Replace [color] cartridge</td>
<td>Replace the cartridge. See Handling ink cartridges and printheads on page 112.</td>
</tr>
<tr>
<td>Reseat [color] cartridge</td>
<td>Remove and reinsert the same cartridge. See Handling ink cartridges and printheads on page 112.</td>
</tr>
<tr>
<td>Update: failed. Invalid file</td>
<td>Make sure that you have selected the correct firmware update file. Then try again to perform the update.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 19-2 Numerical error codes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Error code</td>
<td>Recommendation</td>
</tr>
<tr>
<td>01.0, 01.1, 01.2</td>
<td>Restart the printer. If the problem persists, contact HP Support. See Contact HP Support on page 182.</td>
</tr>
<tr>
<td>21, 21.1, 22.0, 22.1, 22.2, 22.3, 24</td>
<td>Restart the printer. If the problem persists, contact HP Support. See Contact HP Support on page 182.</td>
</tr>
<tr>
<td>61:01</td>
<td>The file format is wrong and the printer cannot process the job. Check the graphic language setting of your printer (see Change the graphic language setting on page 20). If you are sending PostScript from Mac OS over a USB connection, select ASCII encoding in both the driver and the application. Check for the latest firmware and driver releases.</td>
</tr>
<tr>
<td>62, 63, 64, 65, 67</td>
<td>Update your printer’s firmware. See Update the firmware on page 125.</td>
</tr>
<tr>
<td>71.04</td>
<td>Out of memory. To avoid this, in the HP-GL/2 and HP RTL driver select the Advanced tab and then Send job as a bitmap.</td>
</tr>
<tr>
<td>74.1</td>
<td>Try the firmware update again. Do not try to use your computer while the update is in progress. If the problem persists, contact HP Support. See Contact HP Support on page 182.</td>
</tr>
<tr>
<td>79:03</td>
<td>Restart the printer. If the problem persists, contact HP Support. See Contact HP Support on page 182.</td>
</tr>
<tr>
<td>79:04</td>
<td>Update your printer’s firmware. See Update the firmware on page 125.</td>
</tr>
<tr>
<td>81:01, 86:01</td>
<td>Please follow the instructions on the front panel. You may be asked to run a test procedure and write down a numeric code before contacting HP Support. See Contact HP Support on page 182.</td>
</tr>
<tr>
<td>94, 94.1</td>
<td>Restart color calibration. See Color calibration on page 66.</td>
</tr>
</tbody>
</table>
20 HP Customer Care

- Introduction
- HP Professional Services
- HP Instant Support
- HP Proactive Support
- Contact HP Support
Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP Designjet, providing comprehensive, proven support expertise and new technologies to give you unique end-to-end support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, phone and Web support, software updates and self-maintenance services. To find out more about HP Customer Care, please visit us at:

http://www.hp.com/go/graphic-arts/

or call us on the telephone (see Contact HP Support on page 182). To register your warranty:

http://register.hp.com/

HP Professional Services

Knowledge Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your HP Designjet products and solutions.

Join the HP community at the Knowledge Center, your large-format printing community, for 24×7 access to:

- Multimedia tutorials
- Step-by-step how-to guides
- Downloads — the latest printer firmware, drivers, software, paper presets, etc.
- Technical support — online troubleshooting, customer care contacts and more
- Workflows and detailed advice for completing various printing tasks from particular software applications
- Forums for direct contact with the experts, both HP and your colleagues
- Warranty tracking online, for your peace of mind
- Latest product information — printers, supplies, accessories, software, etc.
- Supplies Center for all you need to know about ink and paper

The Knowledge Center can be found at the following locations, depending on your printer:


By customizing your registration for the products you have purchased and your type of business, and by setting your communication preferences, you decide the information you need.

HP Start-Up Kit

The HP Start-Up Kit is the CD that comes with your printer; it contains the printer's software and documentation.
HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard period.

They include remote support. On-site service is also provided if necessary, with two alternative response-time options.

- Next business day
- Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit [http://www.hp.com/go/printservices/](http://www.hp.com/go/printservices/).

HP Installation

The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, please visit [http://www.hp.com/go/printservices/](http://www.hp.com/go/printservices/).

HP Instant Support

HP Instant Support Professional Edition is HP's suite of troubleshooting tools that collect diagnostic information from your printer and match it with intelligent solutions from HP's knowledge bases, allowing you to resolve problems as quickly as possible.

You can start an HP Instant Support session by clicking on the link provided on the Troubleshooting page of your printer's Embedded Web Server. See [Access the Embedded Web Server on page 27](#).

To be able to use HP Instant Support:

- You must have a TCP/IP connection to your printer, because HP Instant Support is accessible only through the Embedded Web Server.
- You must have access to the World Wide Web, because HP Instant Support is a Web-based service.

HP Instant Support is currently available in English, Korean, Simplified Chinese and Traditional Chinese.


HP Proactive Support

HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and resolving printer issues before they become problems for you. HP's Proactive Support tool is designed to help businesses of all sizes reduce support costs and maximize productivity—all with the click of a mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control of your printing environment—with a clear focus on maximizing the value of your investment, increasing printer uptime and reducing printer management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems before they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for software and firmware updates.

You can enable Proactive Support in the HP Utility for Windows or the HP Printer Monitor for Mac OS, where you can specify the frequency of connections between your computer and HP's Web
server, and the frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time. To change these settings:

- In the HP Utility for Windows, select the **Tools** menu, then **HP Proactive Support**.
- In the HP Printer Monitor for Mac OS, select **Preferences > Monitoring > HP Proactive Support**.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the problem and recommend a solution. In some cases, the solution may be applied automatically; in other cases, you may be asked to perform some procedure to solve the problem.

### Contact HP Support

HP Support is available to you by telephone. What to do before you call:

- Review the troubleshooting suggestions in this guide.
- Review the relevant driver documentation.
- If you have installed third-party software drivers and RIPv, see their documentation.
- If you call one of the Hewlett-Packard offices, please have the following information available to help us answer your questions more quickly:
  - The printer you are using (the product number and the serial number, found on the label at the back of the printer)
  - If there is an error code on the front panel, note it down; see [Front-panel error messages](#) on page 177
  - The printer’s Service ID: at the front panel, select the Information menu icon, then **View printer information**
  - The computer you are using
  - Any special equipment or software you are using (for example, spoolers, networks, switchboxes, modems or special software drivers)
  - The cable you are using (by part number) and where you purchased it
  - The type of interface used on your printer (USB or network)
  - The software name and version you are currently using
  - If possible, print out the following reports; you may be asked to fax them to the support center helping you: Configuration, Usage Report and “all pages above” from Service Information (see [The printer’s internal prints](#) on page 10)

### Telephone number

21 Printer specifications

- Functional specifications
- Physical specifications
- Memory specifications
- Power specifications
- Ecological specifications
- Environmental specifications
- Acoustic specifications
Functional specifications

Table 21-1  HP 72 ink supplies

<table>
<thead>
<tr>
<th>Printheads</th>
<th>Two inks in each printhead: gray and photo black, matte black and yellow, and magenta and cyan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink cartridges</td>
<td>Cartridges containing 69 ml of ink: gray, photo black, yellow, magenta and cyan</td>
</tr>
<tr>
<td></td>
<td>Cartridges containing 130 ml of ink: gray, photo black, matte black, yellow, magenta and cyan</td>
</tr>
<tr>
<td></td>
<td>Cartridges containing 300 ml of ink (T1200 series only): matte black only</td>
</tr>
</tbody>
</table>

Table 21-2  Paper sizes

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roll width</td>
<td>279 mm (11 in)</td>
<td>610 mm (24 in) or 1118 mm (44 in)</td>
</tr>
<tr>
<td>Roll length</td>
<td></td>
<td>91.4 m (300 feet)</td>
</tr>
<tr>
<td>Sheet width</td>
<td>210 mm (8.3 in)</td>
<td>610 mm (24 in) or 1118 mm (44 in)</td>
</tr>
<tr>
<td>Sheet length</td>
<td>279 mm (11 in)</td>
<td>1676 mm (66 in)</td>
</tr>
</tbody>
</table>

Table 21-3  Printing resolutions

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Maximum detail</th>
<th>Driver</th>
<th>Rendering resolution (ppi)</th>
<th>Printing resolution (dpi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best (glossy paper*)</td>
<td>On</td>
<td>HP-GL/2, HP PCL3</td>
<td>1200 × 1200</td>
<td>2400 × 1200</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>PostScript</td>
<td>600 × 600</td>
<td>2400 × 1200</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Any</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Best (other papers)</td>
<td>Off</td>
<td>Any</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Normal</td>
<td>Off</td>
<td>HP-GL/2</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PostScript, HP PCL3</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Fast</td>
<td>Off</td>
<td>HP-GL/2</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PostScript, HP PCL3</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Economode (heavyweight coated and glossy paper*)</td>
<td>Off</td>
<td>Any</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Economode (other papers)</td>
<td>Off</td>
<td>Any</td>
<td>300 × 300</td>
<td>600 × 1200</td>
</tr>
</tbody>
</table>

* For a list of supported glossy papers, see Order paper on page 129.

Table 21-4  Margins

| Top, right and left margins   | 5 mm (0.2 in) |
| Bottom margin (trailing edge) | 5 mm (0.2 in) (roll) |
|                              | 17 mm (0.67 in) (sheet) |
Table 21-5  Mechanical accuracy

±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/A0 printing material in Best or Normal mode with HP Matte Film roll feed.

Table 21-6  Graphic languages supported

<table>
<thead>
<tr>
<th>HP Designjet</th>
<th>Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>T770</td>
<td>HP PCL3 GUI, HP-GL/2 and HP RTL</td>
</tr>
<tr>
<td>T770 HD</td>
<td>HP PCL3 GUI, HP-GL/2 and HP RTL, CALS</td>
</tr>
<tr>
<td>T770 PS</td>
<td>HP PCL3 GUI, HP-GL/2 and HP RTL, PDF, PostScript</td>
</tr>
<tr>
<td>T1200</td>
<td>HP PCL3 GUI, HP-GL/2 and HP RTL, CALS</td>
</tr>
<tr>
<td>T1200 PS</td>
<td>HP PCL3 GUI, HP-GL/2 and HP RTL, CALS, PDF, PostScript, TIFF, JPEG</td>
</tr>
</tbody>
</table>

Physical specifications

Table 21-7  Printer physical specifications

<table>
<thead>
<tr>
<th>HP Designjet T770 24-in series</th>
<th>HP Designjet T770 44-in series</th>
<th>HP Designjet T1200 series</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>60 kg (132 lb)</td>
<td>81.6 kg (180 lb)</td>
</tr>
<tr>
<td>Width</td>
<td>1262 mm (49.7 in)</td>
<td>1770 mm (69.7 in)</td>
</tr>
<tr>
<td>Depth</td>
<td>Minimum: 692 mm (27.2 in)</td>
<td>Minimum: 692 mm (27.2 in)</td>
</tr>
<tr>
<td></td>
<td>Maximum: 702 mm (27.6 in)</td>
<td>Maximum: 702 mm (27.6 in)</td>
</tr>
<tr>
<td>Height</td>
<td>1049 mm (41.3 in)</td>
<td>1049 mm (41.3 in)</td>
</tr>
</tbody>
</table>

The depth is measured without the upper spindle; wall spacers up; ink cover opened; roll covers and basket closed.

Memory specifications

Table 21-8  Memory specifications

<table>
<thead>
<tr>
<th>HP Designjet</th>
<th>Dedicated file-processing memory *</th>
<th>Hard disk</th>
</tr>
</thead>
<tbody>
<tr>
<td>T770</td>
<td>2 GB</td>
<td>–</td>
</tr>
<tr>
<td>T770 HD</td>
<td>8 GB</td>
<td>160 GB</td>
</tr>
<tr>
<td>T1200</td>
<td>32 GB</td>
<td>160 GB</td>
</tr>
<tr>
<td>T1200 PS</td>
<td>32 GB</td>
<td>160 GB</td>
</tr>
</tbody>
</table>

* 384 MB physical DRAM

Power specifications

Table 21-9  Printer power specifications

<table>
<thead>
<tr>
<th>Source</th>
<th>100–240 V ac ±10%, auto-ranging</th>
</tr>
</thead>
</table>
Table 21-9  Printer power specifications (continued)

<table>
<thead>
<tr>
<th></th>
<th>Frequency</th>
<th>Current</th>
<th>Consumption</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>50–60 Hz</td>
<td>&lt; 2 A</td>
<td>&lt; 200 W</td>
</tr>
</tbody>
</table>

Ecological specifications

This product complies with European Union WEEE and RoHS Directives. To determine the ENERGY STAR qualification status of these product models, please go to [http://www.hp.com/go/energystar/](http://www.hp.com/go/energystar/).

For the up-to-date ecological specifications of your printer, please go to [http://www.hp.com/](http://www.hp.com/) and search for “ecological specifications”.

Environmental specifications

Table 21-10  Printer environmental specifications

<table>
<thead>
<tr>
<th>Operating condition</th>
<th>Temperature range</th>
<th>Humidity range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating for optimal print-quality</td>
<td>22 to 26°C (72 to 79°F)</td>
<td>30 to 60%</td>
</tr>
<tr>
<td>Operating for standard printing</td>
<td>15 to 35°C (59 to 95°F)</td>
<td>20 to 80%</td>
</tr>
<tr>
<td>Printer without consumables</td>
<td>5 to 40°C (41 to 104°F)</td>
<td></td>
</tr>
<tr>
<td>Non-operating packed consumables and printer:</td>
<td>-40 to 60°C (-40 to 140°F)</td>
<td></td>
</tr>
</tbody>
</table>

Acoustic specifications

Printer acoustic specifications (declared according to ISO 9296).

Table 21-11  Printer acoustic specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle sound power level</td>
<td>4.4 B (A)</td>
</tr>
<tr>
<td>Operating sound power level</td>
<td>6.3 B (A)</td>
</tr>
<tr>
<td>Idle sound pressure at bystander position</td>
<td>29 dB (A)</td>
</tr>
<tr>
<td>Operating sound pressure at bystander position</td>
<td>46 dB (A)</td>
</tr>
</tbody>
</table>
AppleTalk
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now recommends TCP/IP networking instead.

Bonjour
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of the main hazards to the electronics products. Therefore, to prevent damage some precautions are needed when setting up the product, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the product (mainly metal parts) before handling ESD sensitive devices (such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.

HP RTL
Hewlett-Packard Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.
HP-GL/2
Hewlett-Packard Graphics Language 2: a language defined by HP to describe vector graphics.

I/O
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
A unique identifier that identifies a particular node on a TCP/IP network. It consists of four integers separated by dots.

Jetdirect
HP's brand name for its series of print servers that allow a printer to be connected directly to a local area network.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped, dried and pressed.

Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it on the paper, through a cluster of nozzles. In the HP Designjet T770 and T1200 series, each printhead prints two different colors.

Rendezvous
Apple Computer's original name for its networking software later known as Bonjour.

Spindle
A rod that supports a roll of paper while it is being used for printing.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers.
A
access control 24
accessories
order 133
account ID [T1200]
requiring 24
accounting 110
acoustic specifications 186
alerts
errors 108
turn on and off 23
warnings 108
Autodesk Design Review
print from 80

B
banding problems 145
basket
output problems 144
black and white 58
black point compensation 74
blurred lines 152
buzzer on/off 28

C
calibration
color 66
cannot load paper 38
clean the platen 155
clean the printer 124
cropped at bottom 158
cropped image 158
color
adjustment options 61
advantages 66
calibration 66
CMYK 66
emulation 72
fading 158
inaccurate 157
printer emulation 4
profile 66
RGB 66
color management
from drivers 68
from EWS [T1200] 73
from front panel 75
from PS drivers 71
options 68
process 66
communication ports 7
components of printer 5
color management
printer/computer
communications issues 173
configure 29
connect the printer
choose a method 12
Mac OS direct 17
Mac OS network 14
Windows direct 12
Windows network 12
contrast in front panel 29
crop lines [T1200] 59
Customer Care 180
cutter
on/off 45
disk erase, secure 126
draft for revision, print 78
draft printing 56
driver features
QuarkXpress 175
driver preferences 24
drying time
change 44
economic
on ink 62
on paper 48
Embedded Web Server
access 4
cannot access 28

E
ecological specifications 186
economize
on ink 62
on paper 48
environmental specifications 148
erase hard disk securely 126
easert messages, front panel 3
external hard disk [T1200] 134
form feed and
cut 44, 45, 143, 144
HP Utility software 174
ink cartridge information 113
internal prints 10
modify configuration 29
move paper 44
PANTONE emulation 76
paper mismatch action 21
print diagnostic image 160
print quality 51
printhead
information 116, 150, 153
rendering intent 76
replace ink cartridges 114
replace printheads 117
reprint 107
reprint last job 60
reset paper advance 146
resize 55
RGB source profile 75
roll protection 62
roll switching options 21
select active roll 21
select display contrast 29
select drying time 44
select graphics language 30
select I/O timeout 158
select language 27
select paper size 52
select paper type 138
select units 29
select wait time 62
sleep mode wait time 28
unload paper 38
view configuration 14
view connectivity
information 174
view loaded paper 42
view printer information 182
front view 5
functional specifications 137
G
graininess 153
graphic languages 185
gray shades 58
H
hard disk specification 185
hard disk, external [T1200] 134
HP Care Packs 181
HP Customer Care 180
HP Installation 181
HP Instant Support 181
HP Proactive Support 181
HP Start-Up Kit 180
HP Start-Up Kit CD 2
HP Support 2
HP Utility
access 4
cannot access 27
language 28
HP-GL/2 30
I
image diagnostics print 149
image problems
clipped at bottom 158
clipped image 158
missing objects 159
PDF problems 160
Visio 2003 175
ink
economical use of 62
usage 110
ink cartridge
about 113
cannot insert 116
insert 115
maintenance 124
order 129
remove 113
specification 184
status 8
Instant Support 181
internal prints 10
IP address 28
J
Jetdirect print server 134
job
create 50
submit [T1200] 50
job preview
Embedded Web Server
[T1200] 105
job queue
Embedded Web Server
[T1200] 104
job status 107
K
Knowledge Center 2
L
language 27
line length accuracy 153
line thickness 150
load paper
cannot load 38
general advice 32
paper not in driver 38
roll cannot load 136
roll into printer 34
roll onto spindle 33
sheet 39
sheet cannot load 137
loading paper problems 38
M
maintenance kits 126
margins
none [T1200] 53
specification 184
mechanical accuracy 185
memory error (AutoCAD) 175
memory specifications 185
memory upgrade [T770] 133
Microsoft Office
print from 97
misaligned colors 151
models, printer 4
move the printer 124
multiroll printer [T1200] 3
N
nesting [T1200]
turn on and off 22
Network settings 29
O
on hold for paper
enable/disable 140
message [T1200] 139
order
accessories 133
ink cartridges 129
paper 129
printheads 129
overlapping lines 55
overnight printing [T1200] 47
P
page size 51
PANTONE emulation 71
PANTONE swatch book 74
paper
advance 8
calibrate the paper
advance 145
cannot load 38
displaying information  21
download presets  43
economical use of  48
feed and cut  8
jammed  141
loading error messages  137
movement  43
not flat  154
output problems in basket  144
paper not in driver  38
presets  43
print on loaded paper  54, 139
printed on wrong paper  139
select type  54
size  51
sizes (max and min)  184
usage  110
view information  8
paper mismatch action   [T1200]  21
paper not in driver  38
paper suitability [T1200]  21
paper types  129
PDF clipped  160
PDF missing objects  160
physical specifications  185
platen cleaning  155
ports  7
PostScript upgrade [T770]  133
power
  on/off  26
power specifications  185
preferences, Windows driver  24
presentation, print  90
preview a print  13
print file [T1200]  50
print job
  create  50
  ink usage  110
  nesting [T1200]  22
  paper usage  110
  submit [T1200]  50
print preview  13
print quality
  select  51
print with shortcuts  53
print-quality problems
  banding  149
  black ink comes off  156
  blurred lines  152
  bottom of print  156
  discontinuous lines  152
edges darker than
  expected  156
edges stepped or not
  sharp  156
general  148
graininess  153
horizontal lines  149
inaccurate line lengths  153
ink marks  155
line thickness  150
misaligned colors  151
paper not flat  154
scratching  42
scuffing  42
stepped lines  150
vertical lines of different
colors  157
white spots  157
wizard  148
printer does not print  172
printer models  4
printer software
  Mac OS uninstall  18
  Windows uninstall  13
printer status  124
printer will not start  172
printer's main components  5
printer's main features  4
printhead
  about  116
  align  122
  cannot insert  121
  clean; purge  161
  insert  120
  order  129
  remove  117
  replace, reseat  164
  specification  184
  status  116
printhead cleaner
  specification  184
printhead drop detector
  clean  162
printing resolutions  184
Proactive Support  181
project, print  80
protect a roll [T1200]  47
Q
quality, high  51
QuarkXpress, unavailable driver
  features  175
R
rear view  6
rendering intent  74
reprint a job  107
reprint last printed job  60
rescale a print  52
roll paper
  load  34
  spindle load  33
  unload  38
roll protection [T1200]  47
roll switching options [T1200]  21
S
safety precautions  2
scale a print  52
scratched prints  42
scuffed prints  42
secure disk erase  126
security  24
sheet paper
  load  39
  unload  41
shortcuts  53
sleep mode wait time  26
slow printing  173
software  9
software update  126
specifications
  acoustic  186
  ecological  186
  environmental  148
  functional  137
  graphic languages  185
  hard disk  185
  ink supplies  184
  margins  184
  mechanical accuracy  185
  memory  185
  paper size  184
  physical  185
  power  185
  printing resolutions  184
spindle
  roll load  33
statistics
  ink cartridge  8
  printer usage  110
  stepped lines  150
store the printer  124
submit job [T1200]  50
support services
  HP Care Packs  181
  HP Customer Care  180
HP Instant Support 181
HP Proactive Support 181
HP Start-Up Kit 180
HP Support 2
Knowledge Center 2
printer installation 181
warranty extensions 181

T
telephone number 182
two rolls [T1200] 3

U
unattended printing [T1200] 47
unload paper
roll 38
sheet 41
usage information
turn on and off 23
using this guide 2

V
Visio 2003, no output 175

W
wall spacers 7
warranty extensions 181